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About This Book Appeon for PowerBuilder 2013

1 About This Book

1.1 Audience

This book iswritten for PowerBuilder devel opers using Appeon Developer.

1.2 How to use this book

There are sixteen chapters in this book.

Chapter 1: About This Book

A general description of this book.

Chapter 2: Introduction

An overview of Appeon Developer.

Chapter 3: Before you begin

Some important instructions that you MUST follow before using Appeon Developer.
Chapter 4: Configuring Appeon Developer

Instructions for configuring Appeon Developer.

Chapter 5: Using UFA Tool

Instructions for analyzing the unsupported features in a PowerBuilder application.
Chapter 6: Deploying PowerBuilder Applications

Instructions for deploying PowerBuilder applications to the Web or the Mobile.
Chapter 7: Debugging Appeon Web Applications

Instructions for using Appeon Debugger to debug an Appeon Web application.
Chapter 8: Running Appeon Applications

Instructions for running Appeon applications after deployment.

Chapter 9: Launching Appeon Workspace Emulator

Instructions for launching Appeon Workspace.

Chapter 10: Using Information Manager

Instructions for viewing reports and log files generated in the Appeon migration process.
Chapter 11: Packaging Applications

Instructions for using Appeon application package tool to generate a deployment package, a
native mobile project, or customization and package for Appeon Workspace.

Chapter 12: Undeploying Appeon Applications

Instructions on how to undeploy Appeon applications.
Chapter 13: Developing with Code Insight

Instructions on how to use the Appeon Code Insight feature.

Chapter 14: Launching Appeon Enterprise Manager

Appeon Developer User Guide Page 1



About This Book Appeon for PowerBuilder 2013

Instructions for launching Appeon Enterprise Manager from Appeon Developer.
Chapter 15: Converting screen size between pixels and PBUs

Instructions for using Appeon Size Calculator.

Chapter 16: Appeon for PowerBuilder Help

Instructions for launching the Appeon HTML help file.

Chapter 17: Extended Toolkit

Instructions for using the extended tools provided by Appeon: the DLL/OCX Files Package
tool, the Appeon Silent Installer, and the Appeon Developer Toolbar Register tool.

Chapter 18: Technical Support
Important information for technical support

1.3 Related documents

Appeon provides the following user documents to assist you in understanding Appeon for
PowerBuilder and its capabilities:

* Introduction to Appeon:

Guides you through all the documents included in Appeon for PowerBuilder.

* New Features Guide:

Introduces new features and changesin Appeon for PowerBuilder.

* Appeon Mobile Tutorias:
Gives instructions on deploying, running, and debugging A ppeon applications, distributing
native mobile apps, and configuring Appeon server clusters.

» Appeon Installation Guide:

Providesinstructions on how to install Appeon for PowerBuilder successfully.

» Development Guidelines for Appeon Mobile:
Introduces general guidelines on developing apps with Appeon Mobile.

» Migration Guidelines for Appeon Web:

A process-oriented guide that illustrates the complete diagram of the Appeon Web
migration procedure and various topics related to stepsin the procedure, and includes a
tutorial that walks the user through the entire process of deploying a small PowerBuilder
application to the Web.

» Features Help for Appeon:

Provides adetailed list of supported PowerBuilder features which can be converted to the
Web/Mabile with Appeon as well as which features are unsupported.

» Appeon Developer User Guide:

Appeon Developer User Guide Page 2
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Providesinstructions on how to use the Appeon Developer toolbar in Appeon for
PowerBuilder.

» Workarounds & API Guide:
Provides resolutions for issues, such as unsupported features, etc,. encountered when using
Appeon for PowerBuilder.

» Appeon Workspace User Guide:
Gives a general introduction on Appeon Workspace and provides detailed instructions on
how to use the app.

» Appeon Server Configuration Guide:
Providesinstructions on how to configure Appeon Server Monitor, establish connections
between Appeon Servers and database servers, and configure AEM for maintaining
Appeon Server and Appeon deployed applications.

» Web Server Configuration Guide:
Describes configuration instructions for Web Servers to work with a single Appeon Server
or an Appeon Server cluster.

 Troubleshooting:
Provides information on troubleshooting issues; covering topics, such as product
installation, application deployment, AEM, and Appeon application runtime i ssues.

* Appeon Performance Tuning Guide:
Providesinstructions on how to modify a PowerBuilder application to achieve better
performance from its corresponding Web/mobile application.

» Testing Appeon Web Applications with QTP:
Providesinstructions on how to test Appeon Web applications with QTP.

1.4 If you need help

If you have any questions about this product or need assistance during the installation
process, access the Technical Support Web site at http://www.appeon.com/support.

Appeon Developer User Guide Page 3
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2 Introduction

Appeon Developer, acomponent of Appeon for PowerBuilder, extends the capabilities of
PowerBuilder, allowing anew or existing PowerBuilder application to be converted into a
bona fide Web application or a native mobile application using only PowerBuilder skills.

Appeon Developer provides a set of tools that enable the entire PowerBuilder-to-Web or
PowerBuilder-to-Mobile process to take place within the PowerBuilder IDE. These tools
are accessed via atoolbar in the PowerBuilder IDE, which automatically loads each time
PowerBuilder is opened.

Figure 2.1: Appeon Developer toolbar embedded in the PowerBuilder IDE

@ PowerBuilder EI@
File Run Tools Window Help
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IEEEEIEEELETEY RIS

=

----- ‘%, (Mo Workspace)

Version 11.5 Build 1502

Ready

Appeon Developer converts a PowerBuilder application by parsing the PBLs (source code)
of PowerBuilder applications and generating a set of corresponding HTML, JavaScript and
XML files. When deployed by Appeon Server, these generated files form an exact Web-
based or mobile-OS-based replica of the source PowerBuilder application. Any user can
open a standard Microsoft Web browser and access the Web-based version of the original
PowerBuilder application over the Internet, an intranet, or an extranet; or access the native
mobile application deployed by Appeon using a mobile device, such as an iPhone, an iPad,
etc.

2.1 Appeon Developer toolbar in PowerBuilder

All the Appeon Developer tools conform to the US Government Section 508 Accessibility
Guidelines.

The following figure represents the user interface of the Appeon Developer toolbar.

Figure 2.2: Appeon Developer toolbar
T HSS @ ENEENXW

reet
Fre
FFF ﬁg? | Eg;’ s

The Appeon Developer toolbar has 15 buttons. The following table describes the
functionality of each button.
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Table 2.1: Appeon Developer toolbar functions

Button Name Function

ConfigWizard | Providesawizard for quick configuration of Appeon Developer
for Web or mobile conversion.

% Configure Sets configurations of Appeon Developer for Web or mobile
conversion.

&3 or 4+ |Analyze Analyzes application source code for unsupported features
before deployment. This analysis can cover the whole
application, at object level or within an inheritance hierarchy (It
displaysas #" in PowerBuilder 11.5).

Code Insight Develops PowerBuilder applications that are free of Appeon
unsupported features.

& Deploy Starts the complete process of deploying a PowerBuilder
application to the Web or Mobile.

iz Run Runs the deployed Web application (in Internet Explorer) or the
deployed mobile application (in Appeon Workspace Emulator).

<1ty Appeon Debugs Appeon applications.

Debugger

Information Manages logs and reports.

i Package Packages Appeon application files for installation.

b Undeploy Undeploys Web or mobile applications from Web Server(s) and
Appeon Server(s).

W AEM Launches Appeon Enterprise Manager (AEM).

EE Size Calculator | Convertsthe display size between Dots (Points) and PB Units.

g Appeon L aunches Appeon Workspace Emulator.

Workspace
Emulator

& Help Searches, browses, prints, copies, and pastes useful information
from the Appeon user guides.

8 Get Support Displays the product version and the support information. The
Check Update button in it allows you to check the Appeon
updates.

Apart from Code Insight and Information, only one Appeon Developer toolbar function can
be launched at any given time. This prevents an Appeon Developer process from interfering
with another.

2.2 Web and/or Mobile application development with Appeon
Developer
For either developing a new Web or native mobile application, or migrating an existing

PowerBuilder application onto the Web or to the Mobile, you need to perform three key tasks
in Appeon Developer: Analyze, Modify and Deploy Automatically.

Appeon Developer User Guide
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If you use Appeon for PowerBuilder for developing anew Web or native mobile application,
thefirst step isto write a new PowerBuilder application (refer to Web RAD with Appeon

for PowerBuilder in the Appeon Migration Guide). It is recommended that the new
PowerBuilder application conforms to Appeon coding styles, aslaid out in Appeon Features
Help, then you will expend less effort in the first two tasks: Analyze and Modify.

e Task 1: Analyze

Y ou need to analyze the application PBLs for unsupported PowerBuilder objects and
features, using the PowerBuilder IDE extended with Appeon Developer. General rules
of thumb regarding how the application should be structured are outlined in Basic and
Architectural Requirements in Appeon Features Help. The application must meet these
requirements before the analysis can begin.

The first step resultsin an analysis report highlighting unsupported PowerBuilder objects
and code within the application.

e Task 2: Modify

Next, work around or remove the unsupported PowerBuilder objects and code that prevent
the Web or mobile application from running, using standard PowerBuilder programming.
Appeon Features Help and Appeon Code Examples (an Appeon demo PowerBuilder
application) will guide you through this process by providing information regarding
supported PowerBuilder features as well as example code for implementing these features.

Then, perform afull build of the application in PowerBuilder, ensure that there are no
bugs in the PowerBuilder code and that the application functions correctly.

The second task resultsin a PowerBuilder application that is ready for automatic
conversion to the Web or to the Mobile.

» Task 3: Deploy automatically

At the push of a button, you can now automatically generate a precise replica of the
PowerBuilder application, that deploys to the n-Tier architecture and can be accessed
by standard Internet Explorer Web browsers (Appeon Web applications) or in Appeon
Workspace on various mobile devices (Appeon Mobile applications).

Then, automatically deploy the generated Web or mobile application filesto Appeon
Server. The third task results in abona fide Web application or a native mobile application
with the look and feel of the source PowerBuilder application.

For detailed information about the Web or mobile conversion, please refer to the Appeon
Migration Guide.

Appeon Developer User Guide Page 6



Before You Begin Appeon for PowerBuilder 2013

3 Before You Begin

3.1 Installing Appeon for PowerBuilder

Follow the Appeon Installation Guide carefully; make sure that both Appeon Developer and
Appeon Server have been installed.

Verify that Appeon Developer has been installed to the Developer PC.

Verify that Appeon Server has been installed to the application server, such as, SAP Sybase
EAServer, SAP NetWeaver Application Server, Oracle WebL ogic, IBM WebSphere,
TmaxSoft JEUS, JBoss, or Microsoft .NET Framework\I1S. Once Appeon Server has been
installed, the machine hosting Appeon Server is then referred to as Appeon Server.

If using a separate Web Server (e.g. Apache) instead of the application server built-in Web
server, verify that the Appeon Server Web Component has been installed to the Web Server.

Verify that al system requirements have been met for the Developer PC, Web Server,
Appeon Server, and the Database Server. Refer to the Appeon Installation Guide for details.

3.2 Configuring application database connectivity

Perform the following database configurations for all prospective PowerBuilder applications
that will be deployed with Appeon Developer:

1. Set up the database used by the PowerBuilder application to interface with Appeon Server
and the JDBC driver. Refer to the documentation from appropriate database vendors for
instructions.

2. Create the data source in Appeon Server. Appeon provides systematic instructions for
certified database systems. Refer to Setting up Appeon Server data sourcesin the Appeon
Server Configuration Guide for more information.

3. Map the transaction object in the target PowerBuilder application to the newly created
data source for the prospective Web or mobile application. Y ou can either dynamically
set up the mapping via Power Script following the instructionsin Dynamic transaction
object to data source mapping in the Appeon Server Configuration Guide or establish the
mapping statically in Appeon Developer or AEM.

3.3 Starting Appeon Server

Appeon Developer interacts with Appeon Server and Web server during Web or mobile
deployment. Web or mobile applications are deployed to one or more Appeon Servers and
one or more Web servers. Y ou should verify that the Appeon Server and Web server are
running before deployment. If you use the application server built-in Web server as the Web
server, you only need to start the application server/Appeon Server. For example, if you use
EAServer as the Appeon Server and EAServer HTTP Server as the Web server, you only
need to start the EA Server/Appeon Server. Otherwise, start both the Web server and Appeon
Server. Refer to the documents provided by the Web server vender for how to start the Web
server, and refer to the following instructions to start the Appeon Server.

Appeon Developer User Guide Page 7
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Table3.1: How to start Appeon Server
Operating Detailed I nstructions

System

NET

Windows

Select Start > All Programs > Appeon for Power Builder 2013
> Appeon Server for .NET > [IS Manager

WebL ogic

Windows

Select Windows Start > All Programs > Appeon for
Power Builder 2013 > Appeon Server for WebL ogic >
Instances > InstanceName > Start WebL ogic

UNIX/
Linux

Run the appeonserver.sh file in the $appeon/bin/ folder, for
example:

$ $BEA_HOME/user_projects/domains/mydomain/appeon/bin/
appeonserver.sh

WebSphere

Windows

Select Windows Start > All Programs > Appeon for
Power Builder 2013 > Appeon Server for WebSphere > Start
WebSphere

UNIX/
Linux

Run the appeonserver.sh file in the $appeon/bin/ folder, for
example:

$ $WebSphere/ A ppServer/appeon/bin/appeonserver.sh

JBoss

Windows

Select Start > All Programs > Appeon for Power Builder 2013
> Appeon Server for JBoss > | nstances > I nstanceName >
Start JBoss

UNIX/
Linux

Run the appeonserver.sh file in the $appeon/bin/ folder, for
example:

$ $jboss-5.1.0GA/appeon/bin/appeonserver.sh

JEUS

Windows

Select Start > All Programs > Appeon for Power Builder 2013
> Appeon Server for JEUS > Start JEUS

UNIX/
Linux

Run the appeonserver.sh file in the $appeon/bin/ folder, for
example:

$ $tmaxsoft/IJEU S6.0/appeon/bin/appeonserver.sh

EAServer

Windows

Select Windows Start > All Programs > Appeon for
Power Builder 2013 > Appeon Server for EAServer > Start
EAServer

UNIX/
Linux

Run the appeonserverstart.sh file in the $appeon/bin/ folder, for
example:

$ $IAGUA R/appeon/bin/appeonserverstart.sh

Y ou can run EA Server/Appeon Server in different modes, debug
and normal, using different Java runtime versions and different
JavaVMs. For details on how to specify the mode optionsin

the above syntax, refer to the EAServer System Administration
Guide.
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4 Configuring Appeon Developer

The settings configured in Appeon Developer are critical; they are used throughout the entire
PowerBuilder-to-Web or PowerBuilder-to-Mobile process. Appeon Developer settings
determine which PowerBuilder application will be converted to the Web or to the Mobile,
and the manner in which it will be deployed.

Before you attempt to use any other functionality on the toolbar, complete the following
tasks:

1. Set up an application profile for each of the PowerBuilder applications intended for
conversion. Each application profile tells Appeon Developer important information about
the application, such as which PBLs compose the PowerBuilder application, the database
type, etc.

During the application profile setup, set up a profile for the database type used by the
application. This enables Appeon Developer to generate the correct database syntax.

2. Set up at least one Appeon Server profile and one Web Server profile. This enables
Appeon Developer to utilize the Appeon Server and Web Server for deployment.

3. Set up at least one deployment profile, which links at least one Appeon Server and one
Web Server together. This tells Appeon Developer where to deploy the Web or the mobile
application.

Appeon provides a Config Wizard () to quickly configure an application. With your
specifications, the wizard creates the application profile, database type profile, Appeon
Server profile, Web server profile, data source profile, and transaction object mapping. After

creation, all these profiles can be modified in the Configure tool (28). Besides modifying
the above profile settings, the Configure tool provides you with advanced settings, such as
performance settings, parsing options, Web Services profiles, runtime settings, etc.

4.1 Using Appeon Developer Configuration Wizard

The settings in Appeon Developer Configuration Wizard are the same asthose in the
Configuretool, therefore, only basic descriptions will be provided in this section. For detailed
descriptions, refer to Section 4.2, “Using Configure Tool”.

Click the Config Wizard button (27) on the Appeon Developer toolbar to launch the Appeon
Developer Configuration Wizard.

Carefully read the notes and requirements on the Welcome page of the Appeon Devel oper
Configuration wizard. Click Next to proceed.
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Figure4.1: Welcome page

Appecn Developer Configuration Wizard @

Yelcome to the Appeon Developer Configuration
Welcome Wizard|

The Appeon Developer Configuration Wizard will guide
wou through all the steps required for deploying an

B Configure basic settings application to the Web or to the Mobile. Please verify
B Salact PRI D the following before configuration.

1. The databaze in uze by the application iz rwnning and connected

B Configure deployment settings sussesdll

W Select DB types 2. The application haz been compiled with the “Full Buld” cormmand in a

supparted PowerBuilder version.

B Declare transaction object(s)

3. The application runs normally in PowerB uilder.

B Select image files 4 Al PELs have been optimized in PowerBuilder uzing the ""Optimize command.

B Select IMNI files

5. Application Server is started.
B Deploy Bxternal Files

B Summary

< Back [ Mest = ][ Cancel Finigh

4.1.1 Configuring basic settings

The basic settings refer to the settings of an application that are essential for deployment,
including application profile name, web folder, project type, device type, mobile app name,
mobile app icon, and mobile app description. For more information about them, refer to
Section 4.2.1.2.1, “Basic Settings’ in Section 4.2, “Using Configure Tool”.
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Figure 4.2: Configure basic settings of an application

Appecn Developer Configuration Wizard @
Please configure the following options:
Welcome
Application Profile Mame:  appnams
Configure basic settings weh Folder: appname
B Select PBL files
Praoject Type: [ - ]
B Configure deployment settings
Device Type: T ablet hd
B Select DB types #F [ __ ]
B Declare transaction object(s) ‘ Mobile App Name: appname
M obile App loor:
B Select image files M obile App Description: -
B Select INI files
B Deploy External Files -
B Summary
[ < Back ][ Mext = J [ Cancel ] Finizh

Step 1: Specify the application profile name in the Application Profile Name text box.

The application profile name is used to identify the PowerBuilder application during the
entire PowerBuilder-to-Web or PowerBuilder-to-Mobile process.

Step 2: Specify the application URL in the Web Folder text box.

The specified text is also used as the name of the folder created under the Web root of the
Web server for storing the files when the application is deployed.

Step 3: Select a project type from the Project Type dropdown list box.

Select "Mobile" if you intend to deploy your PowerBuilder application to mobile devices,
select "Web" if you intend to deploy your PowerBuilder application to the Web; select
"Universal" if you intend to deploy your PowerBuilder application to both the Web and

Mobile.

Step 4: (For mobile apps) Select a device type from the Device Type dropdown list box.

Tablet, Smartphone, and Both are listed for choices. For applications that are designed
for tablets, select "Tablet"; for applications that are designed for smartphones, select
"Smartphone”; for applications that are designed for both devices, select "Both".

Step 5: (For mobile apps) Enter an app name in the M obile App Name text box.

The mobile app name specified will be displayed in the Appeon Workspace home screen
after the application is deployed to the Appeon Workspace.

Step 6: (For mobile apps) Specify an icon for your mobile applications by clicking the

Browse... button.

Appeon Developer User Guide
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The icon specified will be displayed on the Appeon Workspace home screen after your
application is deployed to Appeon Workspace.

Step 7: (For mobile apps) Enter a brief description in the M obile App Description text box.

The description will be displayed on the home screen of Appeon Workspace as the
application's description after deployment.

Step 8: Click Next.

4.1.2 Selecting PBL file(s)
Specify the version and the location of the PowerBuilder application source code.

Figure4.3: Select PBLS

Appecn Developer Configuration Wizard @

Select the PBL files used in your application:
Welcome

Configure basic settings PBT: E]

Select PEL files [ Eeep PET Updated

B Configure deployment settings

PELVersion. | PawerBuilder 115 -

B Select DB types

B Declare transaction object(s) PBL Fiie List

B Select image files

B Select INI files

B Deploy External Files i b

Add. . ] [ Remaove

N Summary

[ < Back ][ Mext = J[ Cancel Finizh

Y ou can add application PBLs using one of the following methods:
Method 1: Select the PBT file to automatically add the PBL files. Details are as follows:

» Click the browse (...) button to select the PBT file.
When aPBT fileis selected, all PBL files contained in the selected PBT are added to the
PBL FileList.
Thisisthe recommended method to add PBLs, asit reduces the likelihood of forgetting to
add arequired PBL.

Method 2: Y ou can also add PBL files without specifying the workspace and PBT filefirst.
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» Click Add... to add one or multiple PBL files. Thisisthe only method you can take
when using the Configure tool. Refer to Section 4.2.1.2.1, “Basic Settings” for detailed
instructions.

Note: Keep the Keep PBT Updated checkbox checked if you want Appeon to automatically
update the PBL s every time you deploy an application. This ensures that any newly added
PBLswill be deployed and yet avoid missing PBL s after deployment.

4.1.3 Configuring deployment settings

The deployment settings associate the Appeon Server(s) and Web server(s) as agroup used
for the application deployment.

Figure 4.4: Select the Appeon Server and Web server

Appecn Developer Configuration Wizard @

Please select the Appeon Server(s) and Web server(s)

Welcome that your application will be deployed to:

B Deploy External Files

Configure basic settings Deployment Profile Mame: | Local Deployment ']
Select PRL files Appean Servers
Configure deployment settings Celected  Mame &]
B Select DB types Local Appeon Server
B Declare transaction object(s) ‘
_ _ Wieh Servers
B Select image files S eliatedslbamE Edi...
B Select IMI files Lacal Web Server aad

Delete

N Summary

[ < Back ][ Mext = J[ Cancel Einigh

Step 1: Select an existing deployment profile.

To create or modify a deployment profile, you must use the Configure tool. For detailed
instructions, refer to Section 4.2.4.2, “ Deployment profile settings’.

Step 2: Select the check boxes to include the Appeon Server(s) and the Web server(s) in the
deployment profile.

All the Appeon Server profiles and Web server profiles you have created are listed. More
than one Appeon Server and one Web server can be selected.

If the required Appeon Server profiles or Web server profiles are not available, click the Add
button to create them. Refer to Section 4.2.3.2, “ Appeon Server profile settings” for detailed
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instructions on creating an Appeon Server profile and refer to Section 4.2.3.3, “Web Server
profile settings” for detailed instructions on creating a Web server profile.

Step 3: Click Next to proceed.

When the Next button is clicked, the wizard will test the connection to the Appeon Server
and the Web server. If the connection is successful, the deployment profile is saved with the
associated Appeon Server(s) and Web server(s).

4.1.4 Selecting DB Type(s)

The database type is required during the application deployment if the application connects to
one or more databases.

Select the database type(s) used by the application by selecting the check boxes from the
Used column of the database type.

Figure4.5: Database types

Appecn Developer Configuration Wizard @

Select the database type(s) used by your application:
Wefcome

Mate: *rou must zpecify the database type(z] that your application uzes, but it iz not

Configure basic settings necessan to specify the exact database(s) used in this particular application. This
- . zetting enables Appeon Developer to apply the comect type of database driver for
Select PBL files aenerating the comrect databaze syntax for PowerBuilder SAL statements in the
application.
Configure deployment settings PF
Select DF types i
Ilzed Supported D atabase Types Corfigured =

B Declare transaction object(s)

Sybasze ASE 12.x/15. Mo -
Spbase ASA 8/9/10/11/12 Yes 1
Subaze 0 i

B Select image files Oracle 10a/11a
B Select INI files Oracle 3
Oracle 8 i
| | DE-FF'OY E)(t&rﬂ ai F“EE [ Dnd nl w11 n P fatuinin W iatulnl -~ aalunln] [
[ Edit ] [ Test

N Summary

[ < Back ][ Mext = J[ Cancel ] Einigh

If the database type is not configured (The Configured column is indicated with "No"), you
should select it and click the Edit button to create a profile for it. For detailed instructions on
creating a database type profile, refer to Section 4.2.2, * Managing database type profiles’.

4.1.5 Declaring transaction object(s)

When the application is deployed to the Web or to the Mobile, Appeon Server handles
the database connection using data sources rather than transaction objects defined in
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the PowerBuilder application. Y ou must associate the transaction objects used by the
PowerBuilder application with proper data sources created in Appeon Server.

Y ou can create, modify or delete the mapping between transaction objects and data sources
either in Appeon Developer or AEM.

Figure 4.6: Specify transaction objects

Appecn Developer Configuration Wizard

Welcorme

Configure basic settings
Select PBL files

Configure deployment settings
Select DF types

Dedlare transaction objeds)

B Select image files
B Select NI files

B Deploy Bxternal Files

B Summary

Please specify the transaction object{s) used in the
application and the corresponding data source(s):

Tranzaction Object Data Source DB Type

Configure. . Add... Delete

[ < Back ][ Mest = ][ Cancel ][ Finizh

Click Add to create the mapping of the transaction object and the data source of an

application.
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Figure4.7: Add atransaction object

Add Transaction Object @
Tranzaction Object: sl
[Databaze Type: | Sybaze ASE 12.#/15.x b
Data Source:

IF pour Appeon Server iz the MET edition, vou can alzo select, edit, add, or delete the data
gource in the below Data Source group box,

Drata Source

Appeon Server -

Selected  Mame DB Host

Edit.. Add... Delete

] 4 ] | Cancel

Step 1: Input the transaction object name used by the application to the Transaction Object
text box.

Step 2: Select the database type from the Database Type dropdown list box.

Step 3: Specify the data source name in the Data Sour ce text box. The data source should
connect to the same database that the transaction object connects to.

Make sure that the data source existsin all Appeon Servers selected for this application
deployment. If the data source does not exist, you can create it by following instructionsin
Section 4.2.5, “Managing data source profiles’. After you create a data source, you can select
the Selected column to associate the data source with the transaction object.

Note: The data source tool will be available if Appeon Server isinstalled to Microsoft .NET
Framework\IIS, and will not be availableif Appeon Server isinstalled to EAServer 6.x,
WebL ogic, WebSphere, JBoss, NetWeaver Application Server or JEUS. Y ou should go to
the corresponding application server administration console to configure the data source for
EAServer 6.x, WebLogic, WebSphere, JBoss, NetWeaver Application Server, or JEUS. For
detailed instructions, refer to Database Connection Setup in the Appeon Server Configuration
Guide.
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4.1.6 Selecting image files

Click Browse to specify which folder contains the image files that will be used in the Web or
mobile application. Select Include Subfolder s to deploy the sub-folders under the specified
directory.

For detailed information about the image files, refer to Deploy Images.

Figure 4.8: Select imagefiles

Appeon Developer Configuration Wizard @

If your application uses image files, select the folder
where those imaqge files are stored and Appeon will
deploy the files to the Web or to the Mobile.

Welcorme

Configure basic settings Image Path:
C:AUzers\Public\Documentzs\&ppeonD eveloper 201 3appeondemo’.S alesdpplic

Select PBL files
Configure deployment settings [ Include Subfolders

Select DF lypes

Dedlare transaction object{s)

Select image files
B Select NI files

B Deploy External Files

B Summary

< Back ][ Mest = ][ Cancel ][ Finigh

4.1.7 Selecting INI files

If a PowerBuilder application uses an initialization (INI) file which contains user preferences,
specify the INI file so that Appeon can deploy the file for the application.

Click Add File... to add one or multiple INI filesor click Add Directory to add all INI files
in the selected directory.

For detailed information about the INI files, refer to Deploy INI Files.
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Figure4.9: Select INI files

Appecn Developer Configuration Wizard @

Please select the INI file(s) to be deployed with the

Welcome application if there are any. Click Next to proceed.

File List:
Configure basic settings "

| -

Selact PBL fites

Configure deployment settings

Select DE types

Pedlare transaction objeds)

Select image files

Select INT files —
B Deploy Bxternal Files ‘ -
fddFile.. | | AddDiectoy..
B Summary
< Back ][ Mest = ] [ Cancel ] [ Finigh

4.1.8 Selecting External files

If your application calls any custom user external files, such as DLL/OCX files, text files,
etc., you can specify them here and deploy them to the Web or the Mobile. Or you can use
the External File Packaging tool provided by Appeon to package the files and install them to
the client. For detailed instructions, refer to Section 17.1.1, “Packaging DLL/OCX files”.

Click Add File or Add Directory to add external filesto the table. Then select the Auto
Register column if the file needsto be automatically registered after it is downloaded to the
client. If you choose not to automatically register afile, you can register it manually after itis
downloaded.

For more information about the external files, refer to Deploy External Files.

Appeon Developer User Guide Page 18



Configuring Appeon Developer Appeon for PowerBuilder 2013

Figure 4.10: Select External files

Appecn Developer Configuration Wizard @

Please select the external file(s) to be deployed with the

Welcome application if there are any. Click Next to proceed.

Configure basic settings Auto Register  File Mame
Select PBL files

Configure deployment settings

Select DE types

Pedlare transaction objeds)

Select image files

Select INT files

Deploy External Files

fddFile.. | | AddDiectoy.. Delete

B Summary

< Back “ Mest = ][ Cancel ][ Finigh

4.1.9 Summary
Review the settings. Click Finish to complete the configuration.

If the Deploy the application now option is selected, the Appeon Deployment Wizard will
be launched for you to deploy the application. For detailed information, refer to Chapter 6,
Deploying PowerBuilder Applications.

After the configuration is complete, the application will be added to the Application Profiles
tab of the Configure tool where you can manage or change any settings of the application.
For detailed instructions, refer to Section 4.2, “Using Configure Tool”.
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Figure4.11: Summary page

Appecn Developer Configuration Wizard @

The following is the summary of settings for your
application deployment. To change any settings. click
Back.

Welcorme

Configure basic seftings W pplication Prafile Mame: -
appharne i
Select PBL files Application URL:
apphame =
Configure deployment settings Project Type: 1
tobile
Select DR types tobile &pp lcan: =
[Mone]
Declare transaction objeci{s) S e g Al N Tr: el tald
d [Mone]
Device Type:
T ablet
Select image files Mabile App Mame:
5 apphanme
Sefect INI files Deplayment Option: -
1 | n 3

Deploy External Files

Deplay the application now

Summarny

et = Cancel ][ Finizh J

4.2 Using Configure Tool

The Configure tool alows you to modify the settings of existing application profiles,
database type profiles, Appeon Server profiles, Web server profiles, deployment profiles and
data source profiles, and specify the advanced settings for an application profile, such asthe
performance settings, parsing options, Web service profiles, and runtime settings.

4.2.1 Managing application profiles

The Configure tool provides an Application Profilestab for you to modify the settings
specified in the Appeon Developer Configuration Wizard, and use the following advanced
functions:

» Specify the default application profile

» Select the file generation mode for an application
» Delete an application profile

» Boost the application runtime performance

» Specify parsing options

* Specify runtime settings

» Configure Web Service profiles
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4.2.1.1 Application Profiles tab page

When you click the Configur e button (28) on the Appeon Developer toolbar, the Appeon
Developer Configuration window appears with the Application Profiles tab selected by
default, as shown in the following figure.

Figure 4.12: Appeon Developer Configuration Window

95 Appeon Developer Configuration @

Application Profiles | DB Type Profiles I Server Profiles I Deployment Profiles I [rata Source Profiles

Application Profiles
Configure the PowerBuilder applications you intend to deploy ta the 'Web or to the Mobile,

Default Mame Project Tepe b ode PBL “Werzion Edit...
m zales Iniversal Rel PowerBuilder 1 T
codeexamples Wwieh Release PowerBuilder 1 -
act niversal Releaze PowerBuilder 17 m
zapteched riverzal Release PowerBuilder 1 =
arder niversal Releaze PowerBuilder 17 —
apphame b oibile Release PowerBuilder 1 =
Impart...
L T 3

(] ] I Cancel

4.2.1.1.1 Specifying the default application profile

To specify which application profile will be used as the default application profile, select the
Default radio button.

The PowerBuilder application defined in the default application profile is selected for
unsupported features analysis, PowerBuilder-to-Web or PowerBuilder-to-mobile conversion,
application packaging, and application undeployment.

4.2.1.1.2 Selecting an application file generation mode

To specify amode for Web or mobile file generation, click the Mode list box. If you change
the mode, you must perform afull deployment to make the new mode effective.

Table4.1: File generation mode

Description
Debug PS/JS | Generates unencrypted JavaScript files for debug | Web or mobile
use. application debugging

and tuning stage.
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Mode Description Usein the...

The PowerBuilder source code is provided
as comments in the JavaScript files for easy

reference.
Debug JS Generates unencrypted JavaScript files for debug | Web or mobile
use. application debugging

No PowerBUilder source code is provided in the | 2d tuning stage.

JavaScript files.
Release Generates encrypted JavaScript files. Production stage.

4.2.1.1.3 Deleting an application profile
Click the Delete button to delete a selected application profile.
Note: Y ou cannot delete the default application profile.

Deleting the application profile will automatically delete the temporary fold for the
application profile on the Developer machine. The folder has the same name as the
application profile and is created in the \Project folder under the root directory where Appeon
Developer isinstalled (e.g. C:\Program Files\A ppeon\Devel oper2013\).

4.2.1.1.4 Exporting/Importing an application profile

The Export and Import buttons are mainly to back up and restore the configuration of
application profile(s), for instance, if you want to transfer the configuration of application
profile(s) to another Appeon Developer.

 Click the Export button to export the selected application profile(s). In the pop-up dialog
box, type afile name, then the selected application profile(s) will be saved into the file as
XML file format.

To select multiple application profiles, you can use Shift+click or Ctrl+click, or drag the
mouse pointer to create a selection.

» Click the Import button to import application profile(s) from the XML filewhichis
generated by using the Export button.

If the application profile being imported has the same name as an existing application
profile, you will be asked to overwrite or ignore the existing application profile.

4.2.1.2 Application profile settings
The Application Profiles Configuration window provides seven tab pages for you to edit the
required application information:
Table 4.2: Application Profiles settings
To make changes

effective, you must...

Basic Settings | The application profile name, project Perform afull or
type, application URL, PBL version incremental deployment on
the application.
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To make changes

effective, you must...

and PBL location of an application. See
Section 4.2.1.2.1, “Basic Settings’.

DB Settings | The database types, transaction objects Perform afull or
and the corresponding data sources. See incremental deployment on
Section 4.2.1.2.2, “DB Settings’. the application.

Additional INI files, NET/COM components, image Perform afull or

Files filesand External files. See Section 4.2.1.2.3, |incremental deployment on
“Additional Files’. the application.

Misc Settings | Command line arguments, application Perform afull deployment
language, runtime performance, parsing on the application.
option, and log-writing mode. See
Section 4.2.1.2.4, “Misc Settings’.

Web Service | The WSDL file, service name and port for the | Perform afull or

Profiles Web service(s). See Section 4.2.1.2.5, “Web | incremental deployment on
Service Profiles’. the application.

Runtime Company name and application name Perform afull or

Settings displayed on the Web application downloading | incremental deployment on
page, and mobile application name, icon, the application.
and description displayed in the Appeon
Workspace and the target mobile device the
application apply for. See Section 4.2.1.2.6,
“Runtime Settings’.

Summary A summary view of the settings. Perform afull deployment
See the Section 4.2.1.2.7, “ Summary” section | " the application.
for more details.

4.2.1.2.1 Basic Settings

After you click Add or Edit on the Application Profiles tab, the Application Profile
Configuration window is displayed with the Basic Settings tab selected by default, as shown
in the following figure.

The Basic Settings tab allows you to modify the web folder, project typ, PBT, application
PBL version and PBL location.
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Figure 4.13: Basic Settings

®& Application Profile Configuration @
“Web Service Profiles Runtime Settings Surnrnary
Easzic Settings DB Settings Additional Files Mizc Settings
Application
Prafile Mane: sales

Web Folder: sales

Froject Tope: I niverzal i

Application PBLz
EET: | . | Eeep PET Updated

FBL *fersion: PowerBuilder 11.5 -

Select the PBT or PEL filez uzed in pour apphcation.

C:Ad gers\PublichD ocumentztd ppeon' D eveloper201 3\ appeondemohzalesapplicationdemotzales -
C:Ad zers'PublichD ocumentsi b ppeont Developer2(1 2 appeondemohzalezapplicationdemotzales_
C:AUzerz \PublichDocumentz\d ppeoniDeveloper201 3happeondemohzalezapplicationdemot.zales

4 1 3

Add... | | Bemove

[ ] ] | Cancel |

Application Profile Name - The application profile name is used to identify the
PowerBuilder application during the entire PowerBuilder-to-Web or PowerBuilder-to-
mobile process. It is also used in the appeondb database on Appeon Server to identify the
DataWindow syntax, profile, and registry information for an Appeon application.

The Profile Name cannot contain double-byte characters (such as Chinese, Korean, or
Japanese characters) or special characters (such as, \,/,:,*, 2, ", <, >, or |).

Web Folder - A URL of the Appeon Web or mobile application can contain a combination
of letters, underscores ("_"), and numbers. The specified folder is also used as the name

of the folder created under the Web Root of the Web Server for storing the Web or mobile
application files when the application is deployed.

Project Type - The Project Type determines whether your PowerBuilder application will be
configured for the Web migration process or the mobile migration process. This means the
application will be analyzed, deployed, run, packaged, and undeployed as a Web application
or as amobile application.

Avoid setting application URL s as existing folder names in the Web server Web root,
because: (1) If aWeb or mobile application uses an existing folder under the Web root as the

Appeon Developer User Guide Page 24



Configuring Appeon Developer Appeon for PowerBuilder 2013

application URL, alarge number of Web or mobile files belonging to the application will

be deployed to that folder, making it difficult to use the folder for its original purpose. (2)

If aWeb or mobile application uses afolder that is reserved for the Web server or Appeon
Server, some important files belonging to the Web server or Appeon Server may be replaced
or even removed when the application is undeployed. The following are folder names
reserved for the Web server or Appeon Server that should not be used as application URLS:
appeon, classes, docs, images, ir, wst, and WEB-INF.

The application URL for an application profile can be changed, and the Web or mobile files
stored at the Web Server can have different versions for the Client to access, but Appeon
only remembers the application URL in the last deployment, and performs the application
packaging and application undeployment based on the Web or mobile files generated in the
corresponding folder.

Application PBL files - Select the PBL version and add application PBL files using any of
the following methods:

 Click the browse ... button and choose to add an application Target file (*.pbt).

By adding PBLs using an application Target, all PBLsin the Target are automatically
added to the application PBLsist. Thisisthe recommended way to add PBLS, asit
reduces the likelihood of forgetting to add arequired PBL.

* Click the Add button and add PBL files without using an application Target.

Y ou can add one or multiple PBL files at the same time. To select multiple files, hold
down the Ctrl key and choose which files to add.

» Copy and paste (Ctrl+C and Ctrl+V) the path list of PBLs into the Application PBLsfield.

Note: If you do not want Appeon to automatically update the PBL s every time you open this
tab (the Basic Settings tab in the Application Profile Configuration window) or you deploy
your application, uncheck the Keep PBT Updated check box. It is kindly recommended that
you keep this option checked, or you need to manually add the new PBLs or revised PBLs (if
there is any) each time you perform a deployment.

4.2.1.2.2 DB Settings

The DB Settings tab allows you to specify the database types and the transaction objects
that the application uses, as shown in the following figure. When configuring the database
types, it is not necessary to specify the actual databases that the application uses, it can be
any database of the same type. However, when specifying the transaction objects, you must
specify the actual transaction objects that the application uses.

What the DB Typeis used for

PowerBuilder SQL statements must be converted into the correct database syntax before they
can be used to retrieve data from the database that the Web or mobile application connects to.
The DB Type settings enable Appeon Developer to apply the correct database driver type for
generating correct database syntax for PowerBuilder SQL statements.

Set the database types for the application
Select the database type(s) used by the application, as shown in the following figure.
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Figure 4.14: Database types

pt Application Profile Configuration @
YWeb Service Profiles | Runtime Settingz I Summary
B asic Settings DE Settings Additional Files | Misc Settings
Databaze Type

Select the Databasze Type uzed by thiz application. The selected databaze type must be configured.
Click. "Configure..." to configure a databaze type.

IJzed

Supported D atabasze Types Configured
Sybaze ASE 12x/15.x Mo

Svbagze 454 8/9011/412

Sybaze 10
[l Oracle 10a0/11g
[ Mracls S Bl il

m [ »

Tranzaction Object
Configure data zources for tranzaction objects used in the application.

Start tranzaction when executing stored procedures

Tranzaction Object Drata Source DB Type
zglca appeonzample Sybagze ASA 3/9/10...
Edit. | | add. || Delete

[ OF. ] [ Cancel

The following table describes each element on the DB Type tab.

Table 4.3: Database type settings

Column Description

Used Y ou can click the check boxesto select the database types used by the
application. More than one database type can be selected, but only the
configured database types are selectable.

Supported This column lists all the database types that are supported by A ppeon.

Database

Types

Configured | Thiscolumn isidentical to the Configured column in the Section 4.2.2

“Managing database type profiles’ tab. It indicates whether a profile has
been configured for the database type.

If this column of the desired database type is"No", you must click the
Configure button to configure a profile for it before you can useit.
Configuring a database type profile in thistab is the same as configuring
itin the DB Type Profiles tab. Once a database type profile is configured
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Column Description

successfully, the Configured column in both this tab and the DB Type
Profiles tab changes from "No" to "Yes".

Soecify the transaction object and the data source

Click Add or Edit to configure a transaction object and specify the corresponding data
source. Refer to Section 4.1.5, “ Declaring transaction object(s)” for detailed description.

Sart transaction when executing stored procedures

It is strongly recommended that you keep this option enabled. The only circumstance

you may consider disabling it is when there is commit statement executed inside a stored
procedure (SP) and there is no need to commit in the PB code; the reason is that by default
Appeon Server will start a transaction once an SP is executed, and the end user will be able
to see details of this transaction in the Active Transactions tab in AEM; when commit is
executed inside the SP, the transaction will end and disappear from the database end, but as
there is no commit in the PB code, this transaction will still appear as an active transaction in
AEM, which will mislead end usersto think thisis an uncommitted transaction. To avoid this
misunderstanding, you can disable this option, so Appeon Server will not start a transaction
when an SP is executed.

4.2.1.2.3 Additional Files

"Additional files' refer to the files that are outside the application source code, but are
necessary for running the PowerBuilder application, including INI files, .NET/COM
components, image files, and external files, such as DLL/OCX files, text files, etc.
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Figure 4.15: Additional Filestab

®& Application Profile Configuration @
Web Service Profiles Runtime Settings Summary
Bazic Settings DB Settings Additional Files Misz Settings
Deploy M1 Files

If wour application storez configuration information in IM| files, Appeon can perserve the zame behawiar
on the Yweb and on the Mobile. Select the IMI files used within your application.

Add..

Hemowve

Deploy MET/COM components

If wour application uzes MET/COM componentz, select the files and Appeaon will deploy therm to the
SEIYEL

&dd...

Rermove

Deploy Image Files
[f wour application uzes image files, zelect the folder where thoze image files are stored and Appean wil
deploy the files to the YWeb or to the Mobile.

C: A zerzbPublichDocuments'bppeontDeveloper211 Zhappeondemotsalezapplicatior Erowse...

Ihiziude Subfolders

Deploy External Files

[f wour application uzes external non-system files, such az DLL, OCx, TET ete, select

- ) O ptiar...
the files and Appean will deploy them to the zerer. 1=

] ] | Cancel

Deploy INI Files

If a PowerBuilder application uses an initialization (INI) file which contains user preferences,
specify the INI file in this tab so that Appeon can deploy the file for the application.

Click Add to add the INI file(s) into the Deploy INI Fileslist box.
How INI files are supported in Appeon

During deployment, the specified INI file(s) are converted to XML file(s) and deployed to
Appeon Server. The XML file(s) act as mock INI file(s). When a Client runs the deployed
application for the first time, a copy of the XML fileis created in Appeon Server and keeps
the Client's profile information.

For a Client to use the correct profile information in its subsequent visits to the application,
the Client browser must be cookie-enabled. Otherwise, each time the Client visits the
application, a new copy of the XML fileis created in Appeon Server, and the new copy only
contains the information of the original INI file.

Y ou can delete the XML files that are unused for a period using Appeon Enterprise Manager
(AEM). For more information on how to maintain XML filesin Appeon Server, refer to Auto
Cleanup in the Appeon Server Configuration Guide.
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Deploy .NET/COM components

If a PowerBuilder application uses .NET/COM components which contains executable files
(.exe), and COM/COM+ components, specify the NET/COM componentsfilein thistab so
that Appeon can deploy the file for the application.

Click Add to add the .NET/COM components file(s) into the Deploy .NET/COM
components list box.

Deploy Images

Click Browse to specify which folder contains the image files that will be used in the Web
or mobile application. If you do not specify the path of the image files, the path to the
application PBL fileswill be displayed as the default path of the image files.

The image files can be in any format supported by PowerBuilder, apart from:
* unsupported run-length encoded (RLE), and
* unsupported Windows metafile (WMF)

All the image files in the specified folder will be deployed to the %Deployment Path%o/
images folder in the Web Server. %Deployment Path% stands for the folder storing the Web
application files or the mobile application files. The image files may fail to be displayed on
the Web or in Appeon Workspace, or on mobile devicesif the file names are stored in the
database or dynamically generated. To resolve this, you can copy the image files directly to
the %Deployment Path%/images folder, but make sure that the file names are al lowercase;
otherwise, the Web or mobile application may fail to load them.

Deploy External Files

If your application calls any custom user DLL/OCX files (for Web applications only), which
are also called external non-system DLL/OCX filesin thistab; or if your application calls any
other external files, such astext files, you can specify them here and deploy them to the Web
server. Deploying DLL/OCX filesis used as an example in this guide.

If there are many large-size DLL/OCX filesin your application and they could be slow

to download from the Web server at runtime, you may prefer to usethe DLL/OCX File
Packaging tool provided by Appeon to package the files into one setup program (see
Chapter 17, Extended Toolkit for detailed instructions), then distribute the setup program to
the users, and have the usersinstall the files to each Client.

Click Option... in the Deploy External Files group box to open the Deploy External Files
dialog box (as shown in the following figure) and select the required external filesto be
deployed.

Appeon Developer User Guide Page 29



Configuring Appeon Developer Appeon for PowerBuilder 2013

Figure 4.16: External Files Automatically Deploy and Download

®5 Deploy External Files @
External Files
Register  File Hame File Path &dd
Delete
Select All
Unzelect All
| ] | | Cancel |

The following table introduces the elements in the Deploy Exter nal Files dialog box.

Table 4.4: Deploy External Files dialog box

Column Description

Register Allows you to select whether the file will be automatically registered after it is
downloaded to the Client at runtime.

Click Select All to select all files and Unselect All to de-select all of them.

If you choose not to automatically register afile, you can register it manually
after it is downloaded.

File Name |Liststhe added files. Click the header of this column to display thefilesin
alphabetical order.

File Path Displays the file location.

The following table describes how to add and remove files in the Deploy External Files
dialog box.

Table 4.5: Deploy External Files dialog box

ToDo This Do This

To add files Click the Add button. A standard File Selection dialog box is
displayed. And then select the files from your local machine. The files
can be stored in any location.

Toremovefiles | Select afile or multiplefiles using Ctrl or Shift keys, and click the
Delete button to remove the selected files from the list.

To savethe Click OK.
settings

Appeon will copy the filesto atemporary folder and then deploy them
to the Web Server during deployment.
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How the deployed DLL/OCX files work on Web

To successfully call the deployed DLL/OCX filesin the Web application, you need to make
sure that the DLL/OCX files are successfully downloaded and installed to the Client during
the initial run of the deployed Web application.

Appeon Enterprise Manager (AEM) provides options for manually or automatically
downloading and installing the DLL/OCX files, and for specifying the installation location
(by default the files are saved to the %0SystemRoot%\system32\A ppeonPlugin folder on the
client machine. %SystemRoot% indicates the folder where Windows isinstalled. For detailed
instructions, refer to the Appeon Server Configuration Guide.

4.2.1.2.4 Misc Settings

The Misc Settings tab page enables you to modify settings for command line arguments,
application languages (It is automatically disabled when you are using an English version of
Appeon for Powerbuilder.), and log-writing modes, and allows you to configure the runtime
performance and parsing options.

Figure4.17: Misc settings

#8 Application Profile Configuration @
Wieb Service Profiles Runtime Settingz Summary
Basic Settings DB Settings Additional Files Mizc Settings

Conmand Line Arguments

Configure how command line arguments used in the PowerBuilder - -
application will be handled on the Web or Mobile. Command Line Settings...

Language Options

Configure optionz for the application language. :
Language Options...

Perfarmance

Configure additional settings to hweak the application's min-tine :
perfarmance. Performance Settings ...

Parzing Options
o | Allow Deployment ‘wizard to rename the identifiers unsupported by JavaScript or <L

Appeon Developer Logz

Set the log-writing rmode for Deploy Log and Analvsiz Log. You may
view/manage theze logz in the Infarmation Manager.

Off mode @ Summary mode Debug mode

[k, | | Cancel

Command Line Arguments
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If an application needs to use command line arguments, enable the command line argument
option, as shown in the following figure.

Click Command L ine Settings on the Misc Settings tab. The Command Line Settings dialog
box is displayed, as shown in the following figure.
Figure 4.18: Command Line Settings dialog box

®8 Command Line Settings @

Bequire a commarnd line argument for the applicatiore

Yau can pazs a command ling argurment ta an Appeon application by appending the string ta the
application URL, for example, http:/Aw'ebdppld B LAndes. htm Pérgh alie.

Launch A&pplication from Developer Shortcut

Show the arqurnent input/confirmation dialog

[ ] ]| Cancel |

* Require a command line argument for the application option: Enables the command line
argument option.

With this check box selected, the following two options will be enabled. Note that they are
effective only if you run the application from the Appeon Developer toolbar.

» Show argument input/confirmation dialog option: A dialog box is displayed after you
launch an application from the Appeon Developer toolbar but before the application
starts. This dialog box enables you to specify the arguments for the application.

» Specify the default command arguments field: The specified default arguments are
directly attached to the application URL when the application is run from the Appeon
Developer toolbar.

* If both options are selected: A dialog box pops up with the default argumentsfilled in,
as shown in the following figure. Y ou can either change the default arguments or leave
them alone.

Figure 4.19: Command line argument dialog box
[ Regquest Parameter @

Fleasze specify the command line argument to be pazzed to the application.

Click the Cancel button if you do not want to pazs command line argumett.

] ] | Cancel
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To run an application with arguments from Clients, type the application URL with

the arguments. The format of an application URL with argumentsis: http://AppURL/
index.htm?ArgValue. ArgValue indicates the arguments that will be passed to the application.
The arguments must be separated by commas if there are more than one argument.

Application Language

Step 1: Click Language Options (only available when you are using a version of Appeon
for PowerBuilder other than English) on the Misc Settings tab. The Language Settings dialog
box is displayed, as shown in the following figure.

Figure 4.20: Application language settings
hﬁ Language settings @

Language
Fleaze specify the language for system prompts and meszages.

Swztem Prompt Language: Englizh - |

[ ] ]l Cancel |

Step 2: Select alanguage from the System Prompt L anguage dropdown list box.

System prompts are error messages, informational messages, warnings, notices, and prompts
that are displayed when you run Appeon applications.

Step 3: Click OK to save the settings.
Performance Settings

Appeon recommends that you take advantage of the performance settings to boost the
application's runtime performance. To achieve the best performance, perform the following
steps:

Step 1: Click the Perfor mance Settings on the Misc Settings tab. The Performance Settings
dialog box is displayed, as shown in the following figure.
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Figure 4.21: Perfor mance settings

®E Performance Settings

Perfarmance Boosters

A0 Web file compressior:

Merge files

Perfarmance Analyzer [For Web only]

Data iz not encrypted duning the tranzmizsion if thiz ophion iz enabled. Strongly recommend
to dizable it when transfer applications to the live or production enviranment.

Perfarmance Analyzer compliance

Appeon Activesd Download [Faor Web anly]

Download ActiveX files in a zingle thread

==

-

ok J]

Cancel

Step 2: Select the performance features based on your needs.

The following table describes how to use the performance features.

Table 4.6: Performance features

Setting Description When To Use
10X Web File| Compresses files when they are transferred over the Always
Compression | network.
Mergefiles | Mergesthe small files during the application deployment. | In the
The small fileswill be downloaded to the client in onefile | production
package at one call, instead of being downloaded one by stage.
one at separate calls.
Performance | Enables the application to be deployed in a method Inthe
Anayzer compliant with the Performance Analyzer tool. devel opment
(i‘om\e{/lsgce The application deployed with this option can run with stage.
( Orl. e the Performance Analyzer tool at runtime to diagnose
apF ICALONS | the performance issues. For more about the Performance
only) Analyzer tool, see Appeon Performance Analyzer in
Appeon Performance Tuning Guide.
Note: asthe datais not encrypted during transmission at
runtime, therefore, this option is recommended to use only
at the test or development stage.
Download Downloads the two ActiveX filesin the same thread at Always
ActiveX runtime.
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Setting Description When To Use
filesina Using the same thread to download the two ActiveX
singlethread |files can speed up the download under particular network
(for Web conditions.

applications
only)

Parsing options

Unsupported identifiers refer to identifiers that are supported in PowerBuilder but
unsupported in Appeon, due to the different naming convention between PowerScript and
JavaScript/XML. For detailed explanation of such unsupported identifiers, refer to Identifiers
in the Appeon Features Help.

With this automatic-renaming option enabled, when the Appeon Deployment Wizard deploys
an application, it automatically detects unsupported identifiersin the application and renames
these identifiers to supported ones in the files it generates for the application, while keeping
the application source code unchanged. After the deployment, you can get the list of all

the identifiers that are renamed in the deployment log in Chapter 10, Using Information

Manager.

The automatic-renaming feature will not work if the option is disabled. In this case, you must
rename the unsupported identifiers by yourself, following the guidance of the UFA report and
Appeon Features Help.
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Figure 4.22: Parsing options

®& Application Profile Configuration @
Web Service Profiles Runtime Settingz Summary
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Language Options

Configure optionz for the application language. :
Language Options...
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Appeon Developer Logz

Set the lag-writing made for Deploy Log and Analvsiz Log. Yaou may
view/manage theze logz in the Infarmation Manager.

Off mode @ Summary mode Debug mode

k., | | Cancel

Appeon Developer log-writing mode

The log-writing mode determines the content of the log files generated by Appeon Developer,
including the deployment logs and feature analysis logs. Select the desired mode from the
Appeon Developer Logs box, as shown in the following figure.
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Figure 4.23: Log-writing mode

Command Line Arguments

Configure how command line arguments uzed in the PowerBuilder
application will be handled on the eb or kMaobile,

Language Options
Configure optiong for the application language.
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Web Service Praofiles Runtime Settings Surnmnary
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Perfarmance Settings ...

@ Summary mode Debug mode

| k. || Cancel |

The logging options enable you to select the level of information contained in the logs
according to your needs:

Table4.7: Log writing options

Mode Description

Off mode Generates no log files.
This mode offers the fastest performance since nothing is written to alog file.
Summary Generates log files with basic execution information.
”E)oerde | Thisisuseful for tracking errors that have occurred, but inadequate for
(Default) | jetailed troubleshooting,
Use this mode once the application is stable.
Debug mode | Generates log files with detailed execution information for troubleshooting
obscure and esoteric iSsues.
Thisisuseful for technical support, but performance speed will slow down
when using this mode.
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You can view or delete these log files. For detailed instructions, refer to Chapter 10, Using
| nformation Manager.

4.2.1.2.5 Web Service Profiles

A Web service profile contains the settings for the Web service(s) to be invoked in the
Appeon deployed application, including the WSDL file, service name and port to be used by
the Web service.

After you specify the PBL files of the application in the Basic Settings tab, the Web
service proxy objects, WSDL files, service, and port, which are used in the application, are
automatically added to the Web Service Profiles tab, as shown in the following figure.

A valid WSDL file must meet the following requirements:
* The WSDL file must be a.wsdl or .asmx file.

» The WSDL file must reside on the local computer. Appeon cannot access the WSDL filein
aremote machine.

* WSDL files used in the same application cannot have the same name, even if they residein
different locations.

Figure 4.24: Web Server Profilestab

®5 Application Profile Configuration @
| B asic Settings I DB Settings I Additional Files I kizc Settings
‘w'eb Service Profiles Runtime Settlingz I Summary

“Wieb Service Configuration

TheWeb zervice proxy object acceszes the WSDL file for obtaining the service and port infarmation of

the ‘web zervice. Pleaze specify the comrect WSOL fle, service and port for each "Web service prosy

ahject.

dzed  Prowy Object WSOL File Service Puart
Select Al Dezelect Al Irvert Selection Configure...
] ] l Cancel
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Choose which proxy object(s) will be invoked in the deployed application by selecting

the Used column of the object. Click Select All to select all objects; click Deselect All to
deselect all objects; or click Invert Selection to select all objects which were not selected and
deselect the previously selected objects.

If the WSDL file, service and port are not automatically specified for a proxy object, follow
the steps below to select them:

Step 1: Select the proxy object and click Configure. The Configure dialog appears, as shown
in the following figure.

Figure 4.25: Configure dialog box

pet] Configure - achcheckverifysoap @
Prowy Object: achcheckyverifyzoap
WSDL File: |

| Browsze

Semvice: -

Part: -

[ k. ] | Cancel |

Step 2: Click Browse to select aWSDL file on the local computer, and then select the service
and port.

A WSDL file may contain multiple services and each service may contain multiple ports.
Step 3: Click OK to save the configuration and return to the Web Service Profiles tab.

4.2.1.2.6 Runtime Settings
The Runtime Settings tab specifies:

1) the company name and the application name that will be displayed on the Appeon
Download Center when the Web application starts;

2) the mobile application name, icon, and application description that will be displayed in
Appeon Workspace.

3) the device type on which the mobile application will run.

Y ou can use any image with any size as the mobile application icon. For better display
quality, we kindly recommend you to use the icons with 86 x 86 pixels for devices with
relatively low resolutions, such asiPad 2, and 172 x 172 pixels for devices with high
resolution, such asiPad 4. Icons smaller than the above recommended will be automatically
stretched to the proper size for the corresponding devices; and icons larger than the above
recommended will be automatically compressed to the proper size for the corresponding
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devices. Therefore, for convenience, you can always use the one with 172 x 172 pixels or
larger for any application. The supported formats are PNG (recommended), GIF, JPG, BMP,
and ICO.

Figure 4.26: Runtime Settings dialog box

pt] Application Profile Configuration @
B aszic Settings DB Settings Additional Filez Mizc Setings
weh Service Profiles Runtime Sethings Sunmnmary

“Web App Settings
'ou can cugtomize the company and application names displayed when application files are being

downloaded.
Compary Mame:
Application Marme; Appean 'web Application

Mobile App Settings
You can zpecify the application name, icon and description dizplayed in the Appeon \Work zpace.

Device Type: B oth - |

Mabile &pp M ame: Sales App Demo

Mobile &pp | con; C:Azers' PublichD ocumentshdppeont Developer201 3appeor W|

obile App Description; A sales app that tracks customers, orders, and praduct infarmation, ’
] ] | Cancel

4.2.1.2.7 Summary

The Summary tab offers a summary view of all configurations of an application profile. It
lists the configurations in atreeview structure, and allows you to review and modify their
values directly.

Use the following two methods to input or modify the configuration (property values):

 For properties that you can input or select values by using atext field, radio buttons, or
dropdown list, such as Mode, Application URL, PBL version, etc., you can directly double
click their Property Values column and then input, modify or select values.

 For properties that you can add/del ete multiple items by using a dialog box, such as
application PBLs, INI files, etc., you can right click the property name in the Application
column and then select Add or Delete All from the popup menu.
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The configuration changes you make in this Summary tab page will be immediately
synchronized to the other tab pages, but only after you click the OK button, the changes will
be saved.

Figure4.27: Summary tab
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+- Transacticn Object
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- IMI Files

- MET/COM Components
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4.2.2 Managing database type profiles

Database type profiles configuration is the easiest way to manage the database types that
Appeon Deployment Wizard supports for application deployments. Y ou can configure
database type profilesin the DB Type Profilestab, and apply a database type profile for
an application deployment by selecting the profile in the Appeon Developer Configuration
Wizard or in the DB Settings tab of the application profile settings.

Database type profilesin Appeon Developer are different from database profilesin
PowerBuilder:

* You only need to configure one database type profile for a given database type. For
example, if application A connectsto ASA database d1 and application B connectsto ASA
database d2, you can use the database type profile Sybase ASA 7/8/9/10/11/12 for both
applications, athough the connection information in the profile Sybase ASA 7/8/9/10/11/12
sets up connection to ASA database d1.
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» Database type profiles are not used for setting up connections with application databases.
Instead, they are mainly used by Appeon Deployment Wizard to call the relevant database
driver for converting PowerBuilder SQL statements.

To modify a database type profile, take the following steps:

Step 1: Click the Configur e button on the Appeon Developer toolbar, and select the DB
Type Profiles tab on the Application Developer Configuration page as shown in the
following figure.

The Database Type column lists all the database types that are supported by Appeon; and the
Configured column indicates whether a database type profile has been configured.

Figure 4.28: DB Type Profiles

95 Appeon Developer Configuration @

| Application F'ru:ufiles| DE Type Profiles | Server Profiles | Deployment Profiles | Data Source Profiles
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statementz. Configure the profiles below, then azsociate profiles with individual application in the Application Profiles |

DB Settings tab.

Supported Database Types Configured i
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Subaze ASA 8/9/1011412 Tes

Sybaze |0 Mo E
Oracle 100/11g Mo

Oracle 9i Mo

Oracle & Mo

MSS0LServer 2000/2006/2008 Mo

IBEM DBZ2UDE 895 Mo

IEM Infarmix 9.x/ 100 Mo -

[ ]9 ][ Cancel ]

Step 2: Select a database type profile (for example, Sybase ASE 12.x/15.x), and click the
Configur e button to configure the database type profile, as shown in the following figure.
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Figure 4.29: Database Type configuration

pt s Database Type Profile Configuration @

For each databaze wpe used in your application(s), you must provide an ODBC or Mative Interface connection to a
databaze af that type in order for Appeon Developer to connect to the data source during deplovment,

You need only provide one connection to each twpe of database uzed in your application.

Databaze Settings

Databaze Tupe: Sybaze ASA 8/9/10/112
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ODBC Interface M ative Interface
Data Source: |.ﬁ.ppEDnSample - |
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DDBC Administratar. .

| Test Connection | [ ] 4 ] | Cancel

Step 3: Specify the information needed for setting up the database type profile.

Outer Join Syntax: Specify how Appeon format the SQL syntax for outer joins, you

can select corresponding format from the drop-down list in the Database Settings frame.
Regardless of the settings in PowerBuilder, it is recommended to use ANSI as the outer join
syntax format in Appeon.

ODBC Interface: Select thisoption if you use an ODBC interface. Specify the ODBC data
source, User ID, and Password.

Table 4.8. ODBC interface settings

Setting Instructions

Data Source | All the data sources configured in Windows ODBC Administrator are
listed. Select a proper data source of the configured database type from the
dropdown list. It is not necessary to specify the actual databases that the
application uses.

Click ODBC Administrator to configure an ODBC data source if it is not
available.

User ID Type in arecognized (set) user name to login to the database. If no user name
has been set, leave thisfield blank.

Password | Typein the password used to log in to the database. If no password has been
set, leave thisfield blank.

Native Interface: Select this option if you use a native database interface. Specify the server
name/IP, User 1D, Password, and the database name.
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Note: Not al the listed database types are supported by Appeon for the native database
interface. If Sybase 1Q, Sybase ASA 7/8/9/10/11/12 or IBM DB2 is your database type, the
Native Interface option is disabled.

Table 4.9: Native database interface settings

Setting Instructions

Server Enter the machine name or |P address of the server where the target database
resides.
User ID Type in arecognized (set) user name to login to the database. If no user name

has been set, |leave thisfield blank.

Password | Typein the password used to login to the database. If no password has been
set, leave thisfield blank.

Database Specify the name of the database that will be used by the application.
Release (ASE only) Specify the version number of ASE database.

Step 4: Specify the "Enclose table and column namesin double quotes’ option. It
determines whether Appeon Developer encloses the names of tables, columns, indexes, and
constraints in double quotes when it generates the database syntax during deployment.

Notes:

1) When this option is selected, verify that the quoted_identifier setting is set to ON in the
database server.

2) Clear the check box of this option when the updated table name of DataWindow contains
the owner name.

Step 5: Click Test Connection to test the connection to the database.

4.2.3 Managing server profiles

A server profile isaset of parameters for Appeon Developer to connect to, and deploy
applications to, a particular Appeon Server or Web server. Creating and using server profiles
isthe easiest way to manage your application deployments because you can:

» Select one or more Appeon Server profiles and Web Server profiles to set up a deployment
profile.

» Easily add, edit, and remove server profiles.

» Test connections in server profiles. If the connection is successful, it means that the
application can be deployed to the server configured in the server profile.

» Manage which applications are accessible from the Appeon Devel oper shortcut Run
button. The shortcut lists the applications that are deployed to the default server profiles.

4.2.3.1 Server Profiles tab page

There are two main parts on the Server Profilestab page, as shown in the following figure.
The upper part isfor management of Appeon Server profiles, while the lower part isfor
management of Web server profiles.
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Figure 4.30: Server Profiles

95 Appeon Developer Configuration @

| Application Profiles I DB Type F'ru:ufiles| Server Profiles | Deployment Profiles | Data Source Profiles

Appeon Server
Configure the Appeon Servers used in your arganization.

[

Default Frofile Mame Server Type Edi...

“ Local Appecn Server MET

&dd...

Delete

Wwieb Server

Configure your YWeb Servers for wour Web or bMobile applications.

|

Default Frofile Mame Server Type Edit...

@ Local web 5 Microsaft 15
g ocal wieb Server ICrogol Add...

Delete

]

K ][ Cancel ]

4.2.3.1.1 Default server profiles

Y ou can select an Appeon Server profile or aWeb Server profile asthe DEFAULT server
profile on the Server Profiles tab page. Appeon Developer's Run shortcut reads the default
server profiles and lists the applications that are deployed to default server profiles, enabling
you to quickly access them. Applications that are deployed to non-default server profiles
are not available in the shortcut. For details about the shortcut, refer to Chapter 8, Running
Appeon Applications.

4.2.3.1.2 Edit, add or delete server profiles

Two sets of Edit, Add, and Delete buttons are available on the Server Profiles tab page for
you to modify, create, or remove Appeon Server or Web Server profiles. Section 4.2.3.2,
“Appeon Server profile settings’ and Section 4.2.3.3, “Web Server profile settings’ provide
instructions on how to configure the properties for an Appeon Server or Web Server profile
when you modify or create a new server profile.

4.2.3.2 Appeon Server profile settings

Before you edit or add an Appeon Server profile, make sure that the Appeon Server specified
in the profile is running, and that the Appeon Developer computer can successfully connect
to the Appeon Server computer.

If you want to deploy the application to an Appeon Server cluster, you must create profiles
for each participating Appeon Server and deploy the application to all Appeon Serversin the
cluster.
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The following figure shows the Appeon Server Profile Configuration window that displays
when you click the Edit or Add button in the Appeon Server group box of the Server
Profiles tab page.

Figure 4.31: Appeon Server Profile

®E Appeon Server Profile Configuration @
Profile Settings Appeon Server Settings
Brofile M ame: Server Type: JZEE @ MET
Server: lozalhost

Server Port [hitp]: 20

AEM Settings Deployment Security S ettings
YWhen using HTTPS, please make sure vou have Deployment Security:  Dizabled Get State
configured a listener for the SSL connection to thiz —
Appeon Server.

Ilzername and Password should be configured in AEM.
AEM  http/? localhost: B0AAEM

Connection Method: @ HITF HTTFS

Test Settings

After entering the Appeon Server settings, we recammend you test the settings by clicking the button below.

T est Appeoh Server Settings...

[ Ok ]| Cancel |

The following table lists detailed instructions on how to specify the properties for an Appeon
Server profile.

Table 4.10: Appeon Server profile properties

Property Instructions

Profile ProfileName | Assign a name to the Appeon Server profile.
Settings Y ou should use names that are easy to remember and
identify (for example "Appeon Server for Test" or "Remote
Appeon Server").
Appeon Server Type Select J2EE if Appeon Server isinstalled to EAServer,
Server JBoss, JEUS, WebL ogic, or WebSphere; select .NET if
Settings Appeon Server isinstaled to Microsoft .NET Framework.
Server Enter the | P address or the machine name of Appeon
Server.
Server Port Enter the HTTP port number used by Appeon Server.
(http) Note: Do not enter an HTTPS port here, Appeon Devel oper

must use an HTTP port to connect with Appeon Server,
though the Appeon deployed application can be connected
with an HTTPS port.
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Property Instructions

AEM AEM URL The URL for Appeon Enterprise Manager (AEM) will be
Settings automatically generated after you specify the Server and
Server Port. The URL will bein the following format:
http://server:port/AEM, (for example, http://localhost: 9988/
AEM).

Note:

1) If you use EA Server as Appeon Server, the Appeon
installation program creates an HTTP listener (localhost:
9988) for Appeon Server. If the Appeon Server configured
isalocal computer, the following URL should always
work: http://localhost:9988/AEM.

2) Do not use a"localhost" listener in a production
environment.

Connection Select HTTP or HTTPS to connect to AEM.

method If the Web server is configured as an SSL Web Server,
check the HTTPS (secure) option. Otherwise, check the
HTTP (insecure) option.

Deployment | Deployment The Get State button can get the state of the Deployment
Security Security Security settingsin AEM. If Deployment Security is set
Settings to ON, the state will be "Enabled" and you must specify
the deployment user name and password. By defaullt,
the Deployment Security in AEM is OFF, so the stateis
"Disabled".

Username Enter the username used to deploy the application.

The username and password for the deployment security
feature are configured in Appeon Enterprise Manager
(AEM).

The username can be left blank if the deployment security
feature is turned off in AEM.

Password Enter the password used to deploy the application.

The username and password for the deployment security
feature are configured in AEM.

The password can be left blank if the deployment security
featureisturned off in AEM.

After profile configuration, perform the following steps to make sure the Appeon Server
profile can be successfully used for application deployments:

» Check whether the deployment security settings are configured correctly. The username
and password in the deployment security settings must be the same as those configured in
AEM. Make sure you get the correct deployment username and password from the AEM
administrator.
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o Test Appeon Server settings by clicking the Test Appeon Server Settings button. Do
NOT proceed to the next step until the testing succeeds.

4.2.3.3 Web Server profile settings

Before you edit or add a Web Server profile, make sure the Web Server specified in the

profileis running and that the Appeon Developer computer can successfully connect to the
Web Server computer.

The following figure shows the Web Server Profile Configuration window that displays when
you click the Edit or Add button in the Web Server group box of the Server Profiles tab
page.

Figure 4.32: Web Server profile configuration window

-

®5 Web Server Profile Configuration @
Prafile 5 ettings Web Server Settings
Profile M amme: Local Wweb Server Server Type: Microsoft 115 - |
Eile Trarsfer Tvpe: | Local Server - HTTP Server: localhost
HITF Part: a0
Local Server Settingz FTP File Tranzfer Settingz
Wweb Boot Path: C:hinetpubt sewroot 2

[E.q.. for EAServer Web Server, thiz should be the
full path to ZJAGUAR % html.)

| Browse. ..
File Compreszion Settings for ' ard ar Test Settings
Appeon Compression After entening the ‘wWeb Server zettings, we
recommend that you test the settings by clicking the
JOK Compression [Fath): button below,
Browsze. . | Test \Web Server Settings... |

[ ] ]| Cancel |

The following table lists detailed instructions for how to specify the properties for a Web
Server profile.

Table4.11: Instructionsfor creating a Web Server profile

Property Instructions

Profile Profile Name | Assign aname to the Web Server profile.

Settings Y ou should use names that are easy to remember and

identify such as"Web Server for Test" or "Production Web

Server".
File Transfer Use Loca Server if the Web Server is on the local
Type machine.
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Property

Instructions
Use Remote Server if the Web Server locates remotely.

Web Server
Settings

Server Type

Select the Web server type.

Appeon supports the following Web Server types: Apache,
EAServer, 1S, JBoss, WebL ogic, WebSphere, NetWeaver
Application Server, and JEUS.

HTTP Server

Enter the |P address or the machine name of Web Server.

HTTP Port

Enter the Web Server port number.

Note: Do not enter an HTTPS port here, even though the
Web server is configured as an SSL Web server, because
Appeon Developer must use an HTTP port to connect
with Web server. However, you can access the deployed
application with the HTTPS port.

Local Server
Settings

Web Root Path

Enter the home directory of the Web server (for example:
for Apache, the home directory is <apache root>\htdocs

for EAServer, the home directory is C:\Program Files
\Sybase\EA Server6\html;

for I1S, the home directory is C:\Inetpub\wwwroot;

for JBoss 5, the home directory is <jbossb root>\server
\<instance name>\deploy;

for JBoss 7, the home directory is <jboss7 root>\standal one
\deployments;

for WebL ogic 8, the home directory is C:\bealuser _projects
\domains\appeon_domain\applications,

for WebL ogic 9/10, the home directory is C:\bea
\user_projects\domains\appeon_domai n\autodeploy;

for WebSphere, the home directory is C:\IBM
\WebSphere6\AppServer\installableApps,

for JEUS, the home directory is <jeus root>\webhome
\app_home).

Click the Browse button to select the home directory of the
Web server.

Note: For NetWeaver Application Servers, specify any
path and then deploy the War file in the NetWeaver's
administrative console.

FTPFile
Transfer
Settings

FTP Port

Enter the FTP server port number. Thetypical FTP port is
port 21.

If you use aremote Web Server, Appeon Developer will
upload the filesto Web Server using FTP protocol. Note
that Appeon Developer works as a passive FTP client when
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Property

Instructions

uploading files. So you need to make sure that you are
using passive FTP and the FTP data port and command
port are configured properly in the firewall.

FTP Username

Enter the username for FTP login.

If the FTP server offers anonymous access then the
username should be anonymous.

FTP Password

Enter the password for FTP login.

If no password is set for the FTP server or the FTP
Username is anonymous, leave thisfield blank.

File
Compression
Settings for
War/Jar

Appeon
Compression

Select to use the Appeon compression method to compress
the application filesinto WAR or JAR packages when
deployed to JBoss, WebSphere, JEUS, or WebL ogic Web
server.

JDK
Compression

Select to use the IDK compression method to compress
the application filesinto WAR or JAR packages when
deployed to JBoss, WebSphere, JEUS, or WebL ogic Web
server.

Click Browse to specify the location of JDK 1.4 or above,
for example, C:\j2sdk1.4.2_04\.

To ensure the most compatibility, JDK compression is
recommended for J2EE servers such as JBoss, WebSphere,
JEUS, and WebL ogic.

After the profile configuration, perform the following steps to make sure the Web Server
profile can be successfully used for application deployments:

» Test Web Server settings by clicking the Test Web Server Settings button. Do NOT
proceed to the next step until the testing succeeds.

If the Web Server is aremote server, refer to Section 4.2.3.3.1, “Two requirements for FTP
settings” to make sure the configuration for the Web Server profile is successful.

If the Web Server isan SSL Web server, refer to Section 4.2.3.3.2, “1f the Web Server
isan SSL Web Server” to make sure the configuration for the Web Server profileis

successful.

4.2.3.3.1 Two requirements for FTP settings

If you configure a Web Server profile for aremote Web Server, make sure the FTP settingsin
the Web Server profile meet the following two requirements:

* The user name and password for accessing the FTP server should have permission to read
and write filesto the FTP server of the Web Server.

» The FTP home directory should be mapped to the Web root of the Web Server.
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The following steps use the Microsoft 11S FTP service as an example to show you how to
fulfill the requirements. Y ou should find that the settings for other FTP types are similar to

the settings for Microsoft IS FTP.

Step 1: On the FTP server (Web Server), open the Internet Services Manager in
Administrative Tools, as shown in the following figure.

Figure 4.33: FTP configuration

1 Internet Infarmation Services (05) 6.0 bdanager = | =[S
¥3 File Action  Wiew Window  Help - [=
&5 | @ Ec= HE 2|

€4 Internet Information Service Description Identifier State IP address Pc

4 0 TESTOZ9TWISTA (local cc giDefault FTP Site

1

Running

* Al Unassigne., 21

4 | FTP Sites
% Default FTP Site

L

Step 2: Right click on Default FTP Site and select Propertiesin the popup menu. The
Default FTP Site Properties window is displayed.

Step 3: Go to the Home Directory tab and verify that:

» TheLoca Path isthefull path to the Web Server document root.

If the Web Server isan Appeon Server Web Server running on Windows, the local

path isthe full path to EAServer document root: %JAGUAR%Y\ntmI\ (As shown in the
following figure), if the Web Server isan I1S server, the local path is C:\I netpub\wwwroot.
%JAGUAR% isthe EAServer installation directory (for example: C:\Program Files

\Sybase\EA Server\).

» The Write property of the FTP Site Directory is enabled.
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Figure4.34: FTP site properties

F

| FTP Site I Security Socounts | Messages | Home Direckory | Directory Security |

Default FTP Site Properties @

The content Far this resaurce should come Fram:

@ A direckory located on this compuker

A directory located on another computer
FTP site directory

Local path: gram Files!SybaselEAServerihtml Erowse. .,

Read
Write
Log visiks

Directory listing stvle

[ (0] 4 H Cancel H Apply H

Help

Step 4: Go to the Directory Security tab and verify that the Granted Access option is checked,

as shown in the following figure.
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Figure 4.35: Directory security

Default FTP Site Properties (-7 | [
FTP Site | Security Accounts | Messages | Home Directory DIFEE'I':'W5EE'-IFI'I':-“

TCP/IP address access restrickions

By default, all computers will be; d Granted access

Except those lisked below: @ Denied access

Arccess IF address [Subnet mazk]
add...
Femove
Edit...
(] 4 ] | Cancel | | Apply | | Help

4.2.3.3.2 If the Web Server is an SSL Web Server

If the Web Server isan SSL or secure Web Server, you can configure the Web Server profile
following the configuration instructions for non-SSL Web Servers, except for the following
two points:

1. You need to configure an HTTPS listener and port number for the Web Server.

2. You must specify an HTTP (not HTTPS) listener and its port number in the HTTP server
settings of the Web Server profile, because Appeon Developer must use the HTTP
protocol when deploying the Appeon application files to the server. After the application
is deployed to the Web server, you can input "https" instead of "http" and the HTTPS port
in the URL to access the application, (for example, https://192.0.0.80:8181/appeondemo/).

4.2.4 Managing deployment profiles

A deployment profile associates specified Web Server(s) and Appeon Server(s) as a group
used for Web or mobile deployment. Y ou may create several deployment profiles (e.g. local
deployment, test deployment, production deployment, and so on), and set the most commonly
used profile as the default profile.

A deployment profile is based on server profiles. Before configuring the deployment profiles,
make sure you have set up one server profile for each of the Appeon Servers and Web
Serversto be used for the Web or mobile conversion. Y ou can add as many deployment
profiles as you need, but there can be only one default deployment profile.
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4.2.4.1 Deployment Profiles tab page

On the Deployment Profile tab, you can edit, add, or delete deployment profiles and specify a
default deployment profile.

Figure 4.36: Deployment Profile tab page

95 Appeon Developer Configuration @

| Application Profiles I DB Type Profiles I Server F'ru:ufiles| Deployment Profiles | Data Source Praofiles

Deplovment Profiles

Configure the deployment profiles for your applications. & deplovment profile iz a collection of Appeon Servers and
Wieb Servers that pou will deploy 'w/eb or Mobile applications to.

Default  Profile Mame Deplopment Type Mumber of Servers Edi...

m Local Deployrnent MET

IJ}|:
[l
[N

Delete

[ OF. ][ Cancel ]

The following table describes the tasks you can perform on the Deployment Profile tab.

Table 4.12: Instructionsto use the Deployment Profile tab
Usethisbutton To

Default radio Specify the default deployment profile used for Web or mobile
button deployment.
Edit button Modify an existing deployment profile. Thiswill open the Deployment

Profile Configuration dialog box.

Add button Create a new deployment profile. Thiswill open the Deployment
Profile Configuration dialog box.

Delete button Remove a deployment profile.

4.2.4.2 Deployment profile settings

In the Deployment Profile Configuration dialog box, set up the necessary configuration, as
shown in the following figure.
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Figure 4.37: Deployment Profile

ot Deployment Profile Configuration @
Erofile M arne:
Appeon Server Wb Semver
Deploy to one ar mare Appeon Servers. Deploy to one or more “Web Servers.
[w]Local Appecn Server [w]Local Web Server

[ Ok ” Cancel |

The following table describes the settings on the Deployment Profile Configuration dialog

box.

Table 4.13: Deployment Profile settings

Inthisfield Youcan

Profile Name

Type the deployment profile name.

Y ou can use names that are easy to remember and identify such as Test
Deployment, Remote Deployment.

Appeon Select a check box to include the Appeon Server in the deployment profile.

Server All the Appeon Server profiles you have created are listed. More than one
Appeon Server can be selected.

Web Server | Select a check box to include the Web Server in the deployment profile.

All the Web Server profiles are listed. More than one Web Server can be
selected.

Note: If the server type of Appeon Server profileis.NET, then the server
type of Web Server profile must be Microsoft I1S.

Click OK to save the new settings and return to the Deployment Profiles tab.
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4.2.5 Managing data source profiles

Note: This Data Source Profiles tool works for Microsoft .NET Framework\IIS, but does not
work for EAServer 6.x, JBoss, JEUS, WebL ogic, NetWeaver, and WebSphere.

To create data source for EAServer 6.x, JBoss, JEUS, WebL ogic, NetWeaver, and
WebSphere, refer to Database Connection Setup in the Appeon Server Configuration Guide.

Appeon applications use JDBC data sources created in Appeon Server to connect to the
database. The Data Source Profile tab allows you to maintain a storage of data sources which
you can specify to use for Appeon applications. Its function is the same as the one provided
in AEM, and changes made on the tab or AEM are automatically synchronized.

Figure 4.38: Data sour ce profile

95 Appeon Developer Configuration @

| Application Profiles I DB Type Profiles I Server Profiles | Deployment Profiles | ['ata Source Profiles

[ata Source

Configure the data zource anly if your Appeon Server iz installed on 15, Data sources in the selected Appeon
Servers will be automatically displaged.

Appeon Server: -
Marme DB Host Edit...
Add...
Delete
[ QK ] I Cancel

Follow the instructions below to create a data source on the Data Source Profile tab:

Step 1: Select an Appeon Server from the Appeon Server list box. Only the configured
Appeon Server profiles are listed.

The data sources existing on the application server will be displayed.
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Figure 4.39: Data sour ces existing on the application server

95 Appeon Developer Configuration

Data Source

Servers will be automatically displaged.

| Application Profiles I DB Type Profiles I Server Profiles I Deployment Profiles | Data Source Profiles

Appeon Server: Local Appeon Server

)

-

(el

Configure the data zource anly if your Appeon Server iz installed on 15, Data sources in the selected Appeon

M ame

appeonzample
appeonzample?
youhoops
SAPTechEd2012

OB Host

AppeonS ampleF orS erver
AppeonSample2Fors erer
“YouHoopsForServer
SAPTechE d201 2ForServer

IJ} |:
[l
[N

Edit...

]9

][ Cancel ]

Step 2: Click the Add button to create a data source in the application server. The Add dialog

box is displayed.
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Figure 4.40: Add a data source

ﬁ Add Data Source @
M ame: Unnarmed]
Database
Driver: | Infarmix M ative Driver s
[BM Informix Server:
Fart: 1433
D atabaze Mame:
Uzer Mame:
Pazzword:
Character Set: ASCI
Seszion Mode: DEFALLT
HMawimum Connection Pool Size: 100
Minirmurn Connection Pool Size: 10
0
Command Timeout [zeconds]: a0
Connection Lifetime [seconds]: 0
Other Optionz:
Dynamic Database Connection | Pooling
| [ ok ] | Cancel |

The following table provides instructions for how to specify the data source settings.

Table 4.14: Instructionsto specify data sour ce settings

Settings Instructions

Name Type the name of the data source.
The data source name can contain a combination of letters, underscores
("_"), dot ("."), and numbers. Do not use double-byte characters (such
as Chinese, Korean or Japanese characters) or leave aleading or trailing
space.

Driver Select the driver type for the data source.

Host Type the database host.

Port Type the database port.
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Settings Instructions

Database Name | Type the database name.

ODBC Data Type the data source name only when the driver typeis ODBC-JDBC

Source Bridge.

User Name Type the database login username. The username is set on the database
server.

Password Type the database login password. The password is set on the database
server.

Maximum Specify the maximum number of connections Appeon Server opens and

Connection pools on startup.

Pool Size

Minimum Specify the minimum number of connections Appeon Server opens and

Connection pools on startup.

Pool Size

Connection Specify the timeout period for the connection.

Timeout

Command Specify the timeout period for the commands.

Timeout

Connection Specify the lifetime period for the pooled connection.

Lifetime To be specific, you can specify the timeout period from the time a
connection is created to the time when the connection returns to the pool.
If the actual lifetime of a connection exceeds that specified in Connection
Lifetime, the connection will be terminated. It is recommended to be
used in cluster configuration when forcing the load balancing between a
running server and a server just brought online.
If the valueis set to O, the pooled connection allows the maximum
connection timeout.

Other Options | Specify the connection_authentication property for ASA database.
The value should be "authentic_code=####". "authentic_code" is the key
word, text after "=" should be the authorization code.
Appeon Server will automatically set the connection_authentication
property when connecting with the ASA database.
This setting is effective to ASA database only.

Dynamic Select whether to enable dynamic database connection.

gatabast? When itison, the LoglD and L ogPass of the Transaction object will

onnection be used to connect to the database; when it is off, the user name and

password specified in the data source will be used to connect to the
database.

Pooling Select whether to use the connection pool.

Refer to Setting up Appeon Server data sources in the Appeon Server Configuration Guide
for how to specify the settings for different JIDBC drivers and database types.
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5 Using UFA Tool

Unsupported Features Analysis (UFA) tool helps you analyze an application for unsupported

features.

The following table gives brief descriptions of the unsupported features report.

Table5.1: UFA Report

UFA Report

Purpose of the report

Enables you to work around or remove unsupported features
in order to make the PowerBuilder application suitable for
Appeon Web or mobile migration.

What is reported

Most of the unsupported PowerBuilder coding features
including keyword, event, data type, system function, control
(itself and its property, function, event), object (itself and its
property, function, event).

IMPORTANT: There are till some unsupported features
that cannot be reported. These undetected features, though
only asmall number, may make up the largest proportion
of your workload depending on how they are used, so

we strongly recommend you carefully check thelistin
Section 5.1.4, “Undetected Unsupported Features’.

How to generate the report Use the Unsupported Features Analysistool, or perform the
first two tasks in Appeon Deployment Wizard.
Features These features apply for the report:

Automatic incremental analysis. After the first analysis,
the subsequent analysisis automatically incremental to
save time, but the report generated still contains all the
information asif it were afull analysis.

Analysis at application, PBL or object level. Y ou can choose
to generate UFA Report for an application, PBL(S) in the
application, or object(s) in the application.

This chapter describes:

» How to use the UFA tool to analyze an application and generate the UFA Report.

» Undetected unsupported features. There are a small number of unsupported features that
the UFA Report cannot detect.

» How to use the UFA tool to work around unsupported features effectively.

* How to use the UFA tool to manipulate the UFA Report. For example, you can adjust the
view of the UFA Report so it suits your preferences.

Appeon Developer User Guide

Page 60



Using UFA Tool Appeon for PowerBuilder 2013

5.1 Analyzing an application

5.1.1 Tasks required before you perform feature analysis
Step 1: Make sure that the computer is powerful enough to support feature analysis.

Unsupported Features Analysisis CPU and memory intensive. A faster CPU can speed up
the process. Additional memory is useful for ensuring that RAM will not be exhausted when
analyzing alarge application. Regarding system requirements for the Developer machine,
refer to System Requirements section in the Appeon Installation Guide.

Step 2: Close any unnecessary running programs or Windows services in order to have the
maximum amount of memory available for Features Analysis.

Step 3: Perform an incremental build or object regeneration for the PowerBuilder application.
Right-click on the application target and select a build option (for example, I ncremental
Build) as shown in the following figure.

Figure5.1: Incremental Build
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Remove Target
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Deploy
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Debug
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Properties..
4 L] r Version 11.5 Build 1502

Ready

The following table shows you which type of build options you should select for the
application.

Table 5.2: Recommended build options

Build Option What It Does Recommended For
Regenerate | Refreshes the timestamp for a| Object-level Features Analysis. If the object
PowerBuilder object. is regenerated, the object will be analyzed

even if no change has madeto it.
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Build Option What It Does Recommended For

Incremental | Refreshes the objects that Application-level Features Analysis.
have been changed.

Full Refreshes al objects. Not recommended.

Step 4: Perform PBL optimization for the PowerBuilder application.
The purpose of PBL optimization is to remove gaps from libraries and defragment the storage

of objectsto get rid of potentia problemsin PBL files.
5.1.2 Accessing the UFA tool

Click the Analyze button (#3) in the Appeon Developer toolbar to launch the UFA tool. The
Unsupported Feature Analysis Report window (UFA Report window) will be displayed.

Figure5.2: UFA Report Window

2 Unsupported Feature Analysis Report - sales_application_derno E@
File Edit Miew Tools Help
DS &0 @Ee I i

| | - | UFA Summary

R ¥l ursupported items in the application [sales_applical Unsupparted objsct Q

Unzupported powerscript 1]
Unsupported embedded S4L 0
Other a

UFA Report window provides a variety of menus to help you manage unsupported features.
The following table gives a brief description of these menus. Some of them are also listed as
shortcut menus on the toolbar.

Table5.3: UFA Report Window
Menu Description

File Generates a UFA report. See Section 5.1.3, “Performing feature analysis’.
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Menu

Description
Opens or saves a UFA report. See Section 5.2.2.1, “Opening or saving a UFA
Report”.

Edit

Opens and modifies the unsupported source code in the PowerBuilder painter.
See Section 5.2.1, “Modifying unsupported features’.

Searches for the unsupported features. See Section 5.2.2.3, “ Searching for UFA
Report items”.

Filters the unsupported features according to objects, unsupported feature types
or priorities. See Section 5.2.2.4, “Filtering UFA Report items’.

Expands or collapses treeview.

Displays the report in the specified level. See Section 5.2.2.5, “ Specifying report
display level”.

View

Selects a display mode of the objects in the Unsupported Feature List treeview.
See Section 5.2.2.2, “ Selecting report view mode”.

Tools

Accesses the workaround for the selected unsupported feature.

Defines the priority settings of UFA Report items. See Section 5.2.2.6, “Defining
the priority settings of unsupported features’.

Customizes the general settings of the UFA Report. See Section 5.2.2.7,
“Customizing the general settings of the UFA Report”.

Help

Provides the version number of the UFA tool.

5.1.3 Performing feature analysis

There are two ways to perform afeature analysis of an application:

» Usethe Unsupported Features Analysis tool. This option enables you to do afeature
analysis of the whole application, or PBL(S) in the application, or objectsin the
application.

» Usethefirst two tasksin Appeon Deployment Wizard. When you use Appeon Deployment
Wizard to deploy an application, the first task the wizard performsis afeature analysis of
the whol e application.

This section mainly gives instructions on the first option (using the Unsupported Features
Analysistool). For more information about the second option, refer to Section 6.2
“Deployment process’.

Step 1: Select the File > New Report menu in the UFA Report window. The New UFA
Report dialog box appears, as shown in the following figure.
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Figure5.3: New UFA Report dialog box
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The following table gives a brief description of the elements in the New UFA Report dialog

box.

Table 5.4: New UFA Report window

Element Description

Application profile

Provides alist of application profilesfor you to select and analyze.

dropdown list Only application profiles configured in the Appeon Developer
Configuration window will be listed.
Search field Searches for PBLS or objects that contains the text you enter.

Treeview of objects

Givesthe treeviews of PBLs and objects for the application selected
in the application dropdown list and allows you to select the whole
application or only some objects to analyze.

Display Full Path Gives you options to display or hide the full path of the PBLs and
option objectsin the treeview.
Refresh button Refreshes the PBL and object list in the treeview.

Step 2: Select the application that you want to analyze from the Application profile

dropdown list.

The default target to analyze is the default application profile in the Appeon Developer
Configuration window.
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Step 3: Check the PBLs and/or objects in the treeview for which you want to generate the
UFA Report.

Thetreeview lists all the PBLs and objects contained in the selected target. By default, all
objects are selected.

Step 4: Click the OK button to start the feature analysis.
The feature analysis of the selected objects begins, as shown in the following figure.

Figure 5.4: Unsupported Features Analysis Process dialog
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Step 5: Click Close when the analysisis completed. The UFA Report isloaded into the UFA
Report Window.

5.1.4 Undetected Unsupported Features

Appeon Unsupported Features Analysisis capable of highlighting the majority of
unsupported features contained in the PowerBuilder application. There are still a small
number of features that the Unsupported Features Analysis will not detect, so they will not be
listed in the UFA Report.

An application containing unsupported features can still be converted to the Web or to the
Mobile and may work correctly, depending on the type and number of unsupported features.
If the deployed application does not work correctly and the UFA Report does not indicate any
unsupported features that are likely to cause such problems, the problems may be caused by
unsupported features that have not been detected. In this caseg, it is strongly recommended
that you carefully read the undetected features listed below and examine your application to
determine if it contains any of these features.

Table5.5: Undetected features

Naming conventions » Duplicate object names. No two objects should have the same
name in an application, whether they are of the same type or
not. The Unsupported Features Analysis cannot detect whether
object names are duplicated in an application.
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» More than one application object. Having more than one
application object in an application is unsupported. The
Unsupported Features Analysis cannot detect whether more
than one application object is present.

» Applications named as objects or controls. Application names
that have the same name as PowerBuilder control/object
types are not supported. The Unsupported Features Analysis
cannot detect whether this unsupported issue is present in an
application.

Null values

» Unsupported operation

» Expressions with Null values

ASCII characters

Unsupported special ASCII characters:

* Vertical tab (~v)

Non-visual User Object

A NonVisual Object object assigned to an autoinstantiated NVO
or an autoinstantiated NV O assigned to a NonVisual Object
object.

Variables and constants

* Instance variables have identical names as global variables.
 longlong variable

e PUBLIC, PROTECTED, PRIVATE qualifier in the variable
declaration

Forced conversion

Forced conversion between types

Window

Multiple MDI windows in an application.

Overloading,
overriding functions

» Dynamic caling for overloaded functions

» Dynamic calling for overriding functions

Using thereturn value
of some supported
functions

The return value of the Open or OpenSheet functions

User functions

Remote procedure call (RPC)

Operators

The operator ‘" with embedded SQL statements.

Stored procedure

» Stored procedures declared in the conditional statement

DB2 stored procedures

» Stored procedures placed inside an Oracle package

Oracle stored procedures with Appeon unsupported features

Cursor declare
requirement

» Cursor declared in the conditional statement;
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If acursor isdeclared for retrieving rows from table X, the
table X (insert, delete, update) is modified during the cursor
declare-close period.

Cursor statements

The following two syntax:

1. UPDATE TableName SetStatement WHERE CURRENT
OF CursorName;

2. DELETE FROM TableName WHERE CURRENT OF
CursorName.

DataWindow data

Unsupported features in the DataWindow dot notations. Y ou

expressions must make sure the specifications about dot notations are
satisfied in the application. Otherwise, it will cause errors.
» Thereturn values of the DataWindow dot notations are
assigned to user objects.
DatawW i_ndow _ lastpos lastposw mode pageAcross
expression function pageCountAcross | profileint profilestring | stdev
var varp

Partly supported
features

Some partly supported features (such as DatawWindow Modify
and Describe functions).

User interface
interactions

Unsupported features in the Ul such as shortcut key.

Enumerated data type

Default values of enumerate type variable

Data source

The data sources of dynamically created DataWindows are stored
procedures with input parameters.

Dynamic calls

Dynamically call the method of a menu object.

Dynamically call the method that contains reference
arguments.

Others

PBX

PSR, for example: dw.dataobject="*.ps’
Unsupported DBParm parameters
Encoding parameter of the Blob functions

filename & importtype arguments of ImportFile, ImportString,
& ImportClipboard (filename can only be atext file (TXT))

Property defined in the string variable

Structure member has comment property
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System events For acomplete list of undetected system events, refer to
Undetected Features in Appeon Features Help.

5.2 Working with UFA Report
This section describes:

» How to modify unsupported features. Y ou can use the UFA Report to effectively remove
unsupported features in the application.

» How to manipulate the UFA Report in the UFA Report Window. Y ou can adjust the view
of the UFA Report so it suits your preferences.

5.2.1 Modifying unsupported features

When the UFA Report isloaded, you can view al the unsupported features in the left
treeview and modify them one by one.

Step 1: Expand the unsupported feature list treeview and select the unsupported item.

The detailed analysis of the selected method will be displayed on the right of the window, as
shown in the following figure.

Figure5.5: Unsupported feature details
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The right text box shows a detailed code diagnosis on the unsupported code in seven aspects:
the Unsupported Code, Line Number, L ocation, Unsupported Item, Type, Reason, and
Priority.

Step 2: View the workaround for the unsupported item by right-clicking the unsupported item
in the unsupported feature list treeview and selecting Wor kar ounds solutions.

» Go To Workarounds Online: Opens the online Workarounds & API Guide at URL: http://
Www.appeon.com/support/documents/workarounds/2013/.

» Go To Loca Workarounds: Opens the local Workarounds & API Guide installed with
Appeon Help, as shown in the following figure.

Figure5.6: Local Workarounds Guide
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inherited fram Pipeline objects are unsuppoarted in the NVO
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Step 3: Modify the unsupported source code in the PowerBuilder painter according to the
Workarounds & API Guide.

Right click the unsupported item in the unsupported feature list treeview, and select Edit or
Edit Sour ce to open the source code in the PowerBuilder Script view.

 Edit: Displays the source code of the event or function, which contains the unsupported
feature. This button is available only if the unsupported code residesin an event or
function and it is not DataWindow-rel ated.

 Edit Source: Displays all source code of the object, which contains the unsupported
feature. This button is always available.

The PowerBuilder Script view automatically opens, as shown in the following figure.
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Figure5.7: Unsupported codein the Power Builder painter
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5.2.2 Manipulating the UFA Report

5.2.2.1 Opening or saving a UFA Report
Y ou can open or save a UFA Report using the File menu in the UFA Report window.

» To open an existing UFA Report, select the File > Open Report menu. The Open UFA
Report dialog box is displayed. If thereisno UFA report available, select New Analysis
and click OK to analyze an application.

Figure 5.8: Open UFA Report
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» To save aUFA Report, select the File > Save menu.
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» TosaveaUFA Report with anew name, select the File > Save As menu.

5.2.2.2 Selecting report view mode

Y ou can view the UFA Report in four different modes. Go to the View menu in the UFA
Report window and select the desired mode:

» Category: Enables you to view the unsupported features in the following categories:
Unsupported Objects, Unsupported PowerScript, Unsupported Embedded SQL and Others.

» Hierarchy: Enables you to view the unsupported featuresin hierarchical order: PBL,
Object, Control, Method (Event/Function).

* Priority: Enables you to view the unsupported features in priorities (you can go to the
Tools > Define Priority menu to define the priorities of the PowerBuilder features): Have
to modify, Suggest to modify, Can be ignored.

e Summary: Enables you to view summary information of each unsupported feature.

Y ou can set the default view mode in the Tools > Options menu. For detailed descriptions,
refer to Section 5.2.2.7, “ Customizing the general settings of the UFA Report”.

5.2.2.3 Searching for UFA Report items

To do aquick search, you can directly enter the text that you want to search in the search
field of the UFA Report window. Or follow steps below to use the standard Find Text dialog
box:

Step 1: Select the Edit > Find menu. Or right click in the unsupported feature list treeview
and select Find.

Step 2: Inthe Find Text box, enter the text that you want to search.
Step 3: Select any other options that you want.
Step 4: Click Find Next.

Figure5.9: Find Text
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5.2.2.4 Filtering UFA Report items

Filtering helps you restrict the number of the unsupported features displayed in the UFA
Report and quickly find the target unsupported features, especially when there are alarge
number of unsupported features in the application.
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Y ou can filter the unsupported features by the objects they reside in, or by the feature types,
or by the priorities.

5.2.2.4.1 Filtering by objects

Step 1: Select the Edit > Filter by Object menu. Or right click in the unsupported feature list
treeview and select Filter by Object.

The Filter by Object dialog box is displayed, as shown in the following figure.

Figure5.10: Filter by object
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Step 2: Make sure that the unsupported objects you want to display in the report are on the
right list box, whereas the unsupported objects you want to hide are on the left listbox. Click
OK.

To quickly select all objects of the same type, right click the list and select an object type.

The UFA Report hides the unsupported objects that are on the left listbox in the Filter by
Object window.

5.2.2.4.2 Filtering by categories

Step 1: Select the Edit > Filter by Category menu. Or right click in the unsupported feature
list treeview and select Filter by Category.

The Filter by Category dialog box is displayed, as shown in the following figure.
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Figure5.11: Filter by Category

Filter by Categqory 5]

Cateqory Lizt: Eilter Categon(=]:

External wisual uzerobject o~

External clazs userobject

Select » System object or contral

Duplicate objects

Select All > D control

O Stule

E sternal funchion

Property

b ethiod

Ewvent

Function

Shared wvarable

Drata type

GOTO

Function argument

Global symbol

Label

I ¢ Deselect I Function retumed value
Wariable name

|dentifier not found

Function nat faund

4 i} 2

m

I << Deselect All I

Step 2: Make sure the categories of the unsupported features you want to display in the report
are on the right listbox, whereas the categories of the unsupported features you want to hide
are on the left listbox. Click OK.

The UFA Report hides unsupported features that belong to the categories that are on the left
in the Filter by Category window.

5.2.2.4.3 Filtering by priorities

Step 1: Select the Edit > Filter by Priority menu. Or right click in the unsupported feature
list treeview and select Filter by Priority.

The Filter by Priorities dialog box is displayed, as shown in the following figure.
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Figure5.12: Filter by Priority
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Step 2: Uncheck the priorities of the unsupported features which you want to hide. For
example, if you want to hide the features that can be ignored, uncheck the Can beignored
option.

Step 3: Click OK.
The UFA Report only displays unsupported features of the specified priorities.

5.2.2.5 Specifying report display level

Y ou can quickly expand or collapse a node of the unsupported feature list treeview by
selecting Expand Sub-node or Collapse Sub-node from the Edit menu or from the popup
menu on any node.

Y ou can also specify the display level using the following steps:

Step 1: Select the Edit > Display L evel menu.

Step 2: In the Display L evel box, enter the number of the level at which the unsupported
feature list treeview will display.

Figure5.13: Display Level
Display Lewel ==

Select hierarchical level of the tree view display.

Levels; || | - |

Step 3: Click OK.
The UFA Report only displays unsupported features of the specified level.
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5.2.2.6 Defining the priority settings of unsupported features

By default, Appeon divides all unsupported features into three priority levels:

» Haveto modify: The features flagged with Have to modify are important in the

application and will cause significant functionality lossif they are not modified or worked

around.

» Suggest to modify: The features flagged with Suggest to modify will not necessarily cause
functionality lossif they are not modified or worked around. Y ou can decide whether to
modify them according to their functionalitiesin the application.

» Can beignored: The features flagged with Can beignored are small or trivia features
which will not compromise application functionality even if they are not modified or

worked around.

To customize or change priority levels for unsupported features, take the following steps:

Step 1: Select the Tools > Define Priority menu. The Define Priority window is displayed,

as shown in the following figure.

Figure5.14: Define Priority dialog box
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Step 2: Add, modify or delete the system default prioritiesin the left Priority L evel box.

Step 3: Change priority levels of unsupported feature types by selecting a priority level in the

Priority Name column.

Step 4: Click Save to save the priority settings.
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Click Reset to Default to restore the system default priority settings.

5.2.2.7 Customizing the general settings of the UFA Report

Y ou can define your preference settings of the UFA Report window. These settings include
default report view mode, display formats of PBLS, feature count, unsupported source code
edition, and filtering. The new settings will be saved as the default settings.

Select the Tools > Options menu in the UFA Report window. The General Settings
window is displayed, as shown in the following figure.

Figure5.15; General Settingsdialog box
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» Default Report View group box: Select the default view mode of the UFA Report. For
detailed description of each view mode, refer to Section 5.2.2.2, “ Selecting report view
mode”.

» Display Full Path of PBL Files: Displays the full path and the file name of the PBLsin the
UFA Report.

» Display Unsupported Feature Count: Displays the total number of the unsupported
featuresin the UFA Report.

» Auto start PowerBuilder and load target application: Enables PowerBuilder to
automatically start and load the target application when you click the Edit or Edit Source
button in the UFA Report window.

* Filter Previous Results: Allowsyou to filter only the results of a previous filter. It narrows
afilter that resulted in too many data the first time. If you want to search al data of the
report, leave this option as unsel ected.
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6 Deploying PowerBuilder Applications

Appeon Deployment Wizard deploys PowerBuilder applications to be Web or mobile
applications. The deployment should take place only after the application has undergone
careful analysis and isin compliance with the Basic and Architectural Requirements defined
in Appeon Features Help.

The Appeon Deployment Wizard handles the deployment in five steps:
1. Exports the PowerBuilder application source code.

2. Analyzesthe PowerBuilder application to verify that it does not contain unsupported
features.

3. Parsesthe PowerBuilder source code (PBL files) into Web or mobile application files that
are stored on the local machine.

4. Uploads the DatawWindow syntax to Appeon Server.
5. Transferslocal application filesto the Web Server by either file copy or FTP.

Notes:

1) Deploying to an SSL Web Server is no different than deploying to a standard Web
Server. You only need to make sure that the SSL Web Server is set up correctly and isfully
functional. For detailed instructions on configuring a Web Server as an SSL Web Server,
refer to the corresponding documents provided by the Web server vendor.

2) If you want to re-deploy an application which is now running online or on a mobile device:

* You can incrementally deploy the application while keeping the application running online
or on amobile device, if non-database related source code and image files are changed.

* You must shut down the running deployed application and then full or incrementally
deploy the application if the INI files or database-related source code are changed.
Otherwise, the application may have runtime problems such as database connection failure
or missing tables or fields.

6.1 Deployment performance

The deployment process can be very CPU and memory intensive, so we recommend that
you use a developer computer that conforms to the recommended specifications outlined in
System Requirements section of the Appeon Installation Guide for a Developer PC to run
Appeon Developer.

Be sure to close any unnecessary programs and Windows services in order to have an optimal
amount of memory available for the deployment process.

6.1.1 Speed of Deployment Process

The table below benchmarks the time taken or speed to compile various applicationsin
PowerBuilder and deploy to the Web or mobile with Appeon. In general, the results indicate
that the speed of the Appeon deployment processis similar to the speed of the PowerBuilder
compilation/build process.
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Table 6.1: Appeon Application Deployment Time Benchmarks
PB EXE w/ PBDs PB EXE w/DLLs Appeon

Sales Application 20 seconds 50 seconds 22 seconds

Demo (5.55M)

Appeon Code 1 minutes 3 seconds | 12 minutes 37 1 minutes 12 seconds

Example Demo seconds

(20.5M)

ACF Demo (21.5M) |2 minutes 5 seconds |24 minutes 46 2 minutes 12 seconds
seconds

Asagenera rule of thumb, each additional megabyte of PBLs will add approximately 8
seconds to the full deployment process. For example, it would take 4 minutes to deploy
a30MB PFC application. Thiswould only apply for theinitia or full deployment. All
subsequent deployments should take no more than few minutes or even possibly aslittleas a
few seconds.

This rule of thumb applies to hardware configurations that meet the minimum Developer PC
requirements stated in the Appeon Installation Guide. Machines with a slower clock-speed
will take longer to perform the deployment.

6.1.2 Deployment duration for full deployments

Remember the following main points regarding the deployment time:

* The processisvery CPU and memory intensive.

» The size and complexity of the application affect the deployment time.

The following is an example of how long it takes to deploy an application with 3.69 MB in
PBLs and images using full deployment:

Table 6.2: Deployment duration

Deployment Task Elapsed Time

Task 1: Application Source Code Export 8 seconds
Task 2: Application File Generation 27 seconds
Task 3: Web or Mobile Deployment 15 seconds (for alocal deployment)

Test environment: asingle CPU Intel P4 1.8 GHz with 256 MB RAM and 60 GB IDE hard
drive

All of the generated application files deployed to the server are acombined 1.25 MB in size.

6.1.3 Deployment duration for incremental deployments

Sincetheinitia full deployment can be time-consuming, Appeon provides an Incremental
Deployment for maintaining or upgrading an already-deployed application. This feature
only re-deploys the incremental changes that have been made in the application. Appeon can
detect whether an object has been modified and re-deploy only the changed objects.
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6.2 Deployment process

6.2.1 Preparing the PowerBuilder application

Appeon recommends that you perform a build and PBL optimization on the PowerBuilder
application before performing an Appeon Application Deployment. The following table
shows you which type of build options you should select for the application.

Table 6.3: Build options

Build Option What It Does When To Perform
Incremental build Refreshes the objects that have been | Before afull or
changed. incremental deployment.
Full build Refreshes all objects. Not recommended.
Optimize PBLs Removes unused spaceinthe PBLs | After building the
as stored on disk, and reduces object | application but prior to
fragmentation. deployment.

Performing an incremental build in PowerBuilder is necessary because when modifications
are made to a parent class, the child class does not reflect the changes unless one of three
things occurs:

1. Thechild classis opened and saved.

2. Anincremental build is performed.

3. A full build is performed.

6.2.2 Specifying the deployment settings

Click the Deploy button (&) in the Appeon Developer toolbar. The Appeon Deployment
Wizard is displayed.

Appeon Developer User Guide Page 79



Deploying PowerBuilder Applications Appeon for PowerBuilder 2013

Figure 6.1: Appeon Deployment Wizard
r‘ﬁ Appeon Deployment Wizard - sales El [=] @-‘

The Application Deployment Wizard will quide vou through the automated conversion process.
Fleaze ensure that the corect PowerB uilder application and deployment settings have been
zelected and press Mest to continue.

PowerBuilder Applicatian

Application to be deployed: | allen - |
Deplopment profile: | Local Deploprent = |
Deployment mode: | Full &pplication Deplayment - |
V| Unattended Deployment Adwanced...

Feporting Options

| Generate Unzupported Features Analyzis Report

[ Mext » ] | Cancel |

The following table describes how to specify the deployment settings for an application:
Table 6.4: Appeon Deployment Wizard settings

Setting Description

Application to be | Select an application to be deployed.

deployed list box | 10 gefauit application is listed by default. The application chosen
for deployment will become the default application under Application
Profilesin Appeon Developer Configuration.

Deployment Select a deployment profile to be used in the Web or mobile deployment.

Profile list box The selected deployment profile determines which Appeon Server(s) and

Web Server(s) the application will be deployed to. Y ou must make sure
the Appeon Server(s) and Web Server(s) are started before you perform

the deployment.
Deployment Select one of the three available deployment modes:
Mode list box

 Full Application Deployment

* Incremental Application Deployment

» Deploy Already Generated Application
Unattended Specify whether the whole deployment process will automatically
Deployment proceed without displaying the Next button or waiting for interaction.
check box

If you want to view the messages or reports generated at each step, you
can set the unattended deployment to false; the wizard will require you to
click the Next button to start the next task until the whole conversion is
complete.
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Advanced button | Select the types of objects or files that will be uploaded to servers:
DataWindow objects, other objects, INI files, external DLL/OCX files, or
image files. By default, al objects and files will be uploaded.

This button is effective only for the Deploy Already Generated
Application option.

When use this function, verify that the target servers are the same ones
used in the application deployments.

Generate Specify whether to generate an unsupported feature analysis report during
Unsupported deployment.

;ea;lurqﬁ R Thisreport lists all unsupported PowerBuilder coding featuresin the
chnecIi/ ?acs)x eport application. Y ou can use this report to remove or work around the

unsupported features. For detailed instructions, refer to Section 5.2
“Working with UFA Report”.

6.2.2.1 Selecting the deployment mode

The following table describes the three different deployment modes and guides you in
choosing the proper deployment mode.

Table 6.5: Deployment mode

Deployment What It Does Elapsed Time When ToUse It
Mode
Full Exports all PowerBuilder Depends on 1. Thefirst time an
deployment | application objects and code, the size and application is deployed
generates the corresponding complexity of to the Web or to
filesfor the Web or mobile the PowerBuilder | mobile.
f\ppllcatlon, and deploys all files| application. 2. After making
o the server.

changesto any ESQL.

Incremental | Exports objects, re-generates Upto80%less |After making changes
deployment | and re-deploysfiles for the time than a full to an already fully-

changed objects only. deployment. deployed application's
The Deployment Wizard source code or features
in the application

continues even if it finds

unsupported features during this profile.
process.
Deploy Bypasses the object exporting | Much lesstime | When you intend to:
Already and file generation tasks and than aFull or :
1) deploy thefil
Generated only re-deploys the Web or Incremental f c))r tﬁ; (c):i/}angetlj s
Application |mobilefilesfor the changed Deployment. objects to the server

objects or for the entire

application after an Incremental

Deployment has been
cancelled during

the Web or mobile
deployment (Task 3).
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Deployment What It Does Elapsed Time When ToUse It
Mode

2) refresh the set of
fileson the server after
a Full Deployment has
been cancelled during
the Web or mobile
deployment (Task 3).
3) deploy the
application to a
different server.

Appeon Developer will automatically set the default deployment mode by detecting whether
afolder named after the application exists in the %A ppeon%\Devel oper2013\Projects\
directory on the Developer machine. If the folder is detected, the application will be regarded
as an already deployed application and incremental deployment mode is selected; otherwise,
full deployment mode is selected. This detection can mislead Developer into selecting
incremental deployment mode, because the folder will exist in the following situations:

Table 6.6: Situationswhen thefolder exists

Thefolder will exist if you have... In thiscase,
choose ...

Performed an unsupported feature analysis on the application before | Incremental

it has undergone afull deployment. The folder is created during deployment mode.

analysis.

Undeployed an Appeon deployed application from servers using the | Full deployment

Application Undeployment Wizard. The folder is preserved. mode.

Deployed the application using a previous version of Appeon Full deployment

Developer. Thefolder is preserved unless you delete it manually. mode.

This legacy folder can be detected by the new Appeon Developer.

6.2.3 Deploying the PowerBuilder application

The deployment process of an application contains three major deployment tasks. Different
deployment modes perform different tasks. The following table describes the tasks performed
during each deployment mode.

Table 6.7: Different tasks performed during each deployment mode

Deployment Task Full Incremental Deploy Already
Deploymeni Deployment Gener ated

Application
Task 1: Application Source Code Export Y Y N

Exports the source code of the original
PowerBuilder application.

Task 2: Application File Generation Y ‘Y (Partial) ‘ N
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Deployment Task Full Incremental Deploy Already

Deploymeni Deployment Gener ated
Application

Analyzes unsupported features and generates
Web or mobile application files.

Task 3: Web or Mobile Deployment Y Y (Partid) |Y

Deploys the generated Web or mobile
application files to Appeon Server.

Figure 6.2: Full application deployment

=8 Appeon Deployment Wizard - sales El [=] @

The Application Deployment Wizard will quide vou through the automated conversion process.
Fleaze ensure that the corect PowerB uilder application and deployment settings have been
zelected and press Mest to continue.

PowerBuilder Applicatian

Application to be deployed: | sales - |
Deplopment profile: | Local Deploprent = |
Deployment mode: | Full &pplication Deployment - |
| Unattended Deployment Advanced...

Feporting Options

| Generate Unzupported Features Analyzis Bepaort

M et ] | Cancel

As shown in the above figure, the application to be deployed is the sales application_demo,
and the deployment mode is Full Application Deployment.

The following are the compl ete steps in the deployment process:

Step 1: Click Next. The Appeon Deployment Wizard begins Task 1, Application Source
Code Export, as shown in the following figure.
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Figure6.3: Task 1: Application Source Code Export

= Appecn Deployment Wizard - sales

Deployment Tazk Statuz
Deployment Tazk Status
Task 1: Application Source Code Export In Progress
Tazk 2 Appecn Application File Generation
Tazk 3 Appeon Application Deplayment

Important [nformation
Pleaze do not modify the application PEL: during task 1.

Time

Time
133627
13:36:27
133627
133627
133627

17328230

 HEEELE

Run Information

Exporting object Mwindow] twpe [w_set_filker_cust_order].
Exparting object Mwindow] tupe [w_zet_filker].

Exporting object MWindow] tupe [w_rpt_order_tppe],

Exporting object PAindow] type [w_rpt_order_date_surmary].
Exparting object Pwindow] type [w_rpt_arder_custamer_summany].

Furnrhimn ahiact Bfindoia] ina Tea eab - Ankbicess]

11

m

10%

Cancel

After Task 1 iscompleted, Task 2, Application File Generation, will automatically start (as
shown in the following figure) if the Unattended Deployment option is selected, otherwise,
you must click Next at the bottom of the Appeon Deployment Wizard to begin Task 2.
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Figure 6.4: Task 2: Application File Generation

= Appecn Deployment Wizard - sales E [=] @

Deployment Tazk Statuz

Deployment Tazk Status Time
Taszk 1: Application Source Code Expart Completed < 1 Minutes
Tazk 2: Appeon Application File Generation In Progress

Tazk 3 Appeon Application Deplayment

Ayailable Reports

Unzupported Feature Analysis report available: Analvsis Report...
Time Run Information i

@ 133641 Generating Appeon application files for Menu m_report_ordertype.
@ 1336: 41 Generating Appeoh application files for Stucture st_general.
@ 1336:41  Generating Appeoh application files for Structure ztr_pt_options.
@ 133641 Generating Appeoh application files for Stucture str_iptparm.
@ 1336:42  Generating other files.
4 1 | 3

82%

After Task 2 is completed, Task 3, Web or Mobile Deployment, will automatically start
(as shown in the following figure), or click Next at the bottom of the Appeon Deployment
Wizard to begin Task 3 if the Unattended Deployment option is not selected.

Confirm that the Web Server and Appeon Server have been started and correctly configured
in Appeon Developer Configuration; otherwise, deployment will fail. If deployment fails,
aRetry button appears so you can retry Task 3 without running through a full deployment

again.
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Figure6.5: Task 3 Web or M obile Deployment

= Appecn Deployment Wizard - sales E [=] @

Deployment Tazk Statuz

Deployment Tazk Status Time
Taszk 1: Application Source Code Expart Completed < 1 Minutes
Tazk 2 Appecn Application File Generation Completed < 1 Minutes
Tazk 3: Appeon Application Deployment In Progress

Deployment Information

Appeon Deplopment Wizard deploys all required files to the Appeon Server(z] and *Web Server(s]. “ou can run the deployed
application once the deplayment iz finizhed.

Time Run Information

@ 13:36:45  Connecting to Appeon Server: localhost
@ 13:36:45  Deploving application name to Appeon Server localhost.

0%

Click the Cancel button or press the Esc key to terminate Task 3. If you cancel Task 3 during
a Full Deployment, only some of the application files will have been uploaded to the server
and the application will not run correctly. To correct this, select Incremental Deployment or
Deploy Already Generated Application as the deployment mode the next time you attempt to
deploy the application.

Step 2: After Task 3 has been completed, click the Next button at the bottom of the Appeon
Deployment Wizard to display the deployment report page, as shown in the following figure.
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Figure 6.6: Appeon Deployment Wizard

&= Appecn Deployment Wizard - sales E [=] @
Deployment Information
Application deployed: zales
Deployment mode: Full &pplication Deplayment
Deployment profile uzed: Local Deployment

Deployment Task Summary

Tazk Status Time

Tazk 1: Application Source Code Export Completed <1 Minutes
Tazk 2 Appeon Application File Generation Completed <1 Minutes
Tazk 3 Appeon Application Deployment Completed < 1 Minutes
Tatal Time Elapzed for Automatic Corversion < 3 Minutes

Log Informatian

Warnings and Emors Surmmary: Errarz: O ; W arnings: 0 iew Log...
Reportz
Features Analysis report available: | Analpziz Report...
Finizh Finizh and D ebug Finizh and Bun. ..

Table 6.8: Deployment report page

Element Description

Deployment Displays the name of the application deployed, the deployment mode
Information used, and the deployment profile used.

Deployment Task Displays the status and time of each of the three deployment tasks,
Summary aswell asthetotal time for the entire PowerBuilder-to-Web or

PowerBuilder-to-mobile conversion process.

Log Information Displays the number of errors and warnings that occurred during the
deployment process.

Click the View L og button to view the errors and warnings
generated during the deployment process. The log file can be
managed in the Information Manager. For detailed instructions, refer
to Chapter 10, Using Information Manager .

Available Reports Displays the reports (Analysis Report) generated during the
deployment process (mainly Task 2).

» Analysis Report button: Thisreport isavailable if the Generate
Unsupported Feature Analysis Report option on the Appeon
Deployment Wizard is selected before deployment. After you
click this button, the UFA Report Window will be displayed. For
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Description

detailed instructions, refer to Section 5.2, “Working with UFA
Report”.

Step 3: Click the Finish button to close the Appeon Deployment Wizard, or click Finish and
Debug to close the Appeon Deployment Wizard and open Appeon Debugger to debug the
application, or click the Finish and Run button to close the Appeon Deployment Wizard,
and then select a project loader from the dialog box that appears to automatically launch the
newly deployed application.

Note: When you click Finish and Debug or Finish and Run to run the application, please
make sure the database connection from Appeon Server to the database server has been
properly configured. For detailed instructions, refer to the Server Configuration Guide.

Figure6.7: Project Loader

Select Project Loader

Froject Loader: | |E Browser -

Orientatior: Landscape

[ aF. ] | LCancel
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7 Debugging Appeon Web Applications

Sometimes a deployed application may not behave well although the original application
does. In these situations, you can examine the execution results of the JavaScript code in the
deployed application using Appeon Debugger.

The usage of Appeon Debugger is similar to that of PowerBuilder Debugger. Y ou set
breakpoints or watch variables in the PowerBuilder source code, same as in PowerBuilder
Debugger. The main difference is that Appeon Debugger runs the generated JavaScript code
but not the PowerBuilder source code, and shows the execution results of the JavaScript code.

This chapter assumes that you are familiar with the functions of PowerBuilder Debugger;
therefore it does not provide descriptions of common debugging features, but focuses on
introducing the specialties of Appeon Debugger. For common debugging features, refer to the
Debugging an application section in the PowerBuilder User's Guide.

Note:

1) The Appeon Debugger only works with IE 9.0 or older versions in this version (of Appeon
for PowerBuilder 2013), but will support to work on I1E 10.0 in the next version. However,
this only affacts the debugger. |E 10.0 and Windows 8 is natively supported for running
Appeon Web applications.

2) Appeon Mabile 1.0 provides no debug tool, but you can still take advantage of Appeon
Debugger to debug the business logic of the mobile application.

7.1 Important Requirements
To start and use Appeon Debugger successfully, be aware of the following important
prerequisites and note:

1. Microsoft script debugger must have been correctly installed and registered on the same
machine and script debugging is enabled in Internet Explorer. Otherwise, you may
encounter problemsin starting and using Appeon Debugger.

* Modify the Window registration table (this step isrequired for IE 8 only): In order to
make sure that the Appeon Debugger work correctly, you need to modify the Windows
registration table after the installation of the Microsoft script debugger.

For 64-bit machines, follow the steps below:

1) Goto HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\I nternet
Explorer\Main\

2) Add one DWORD vaue: TabProcGrowth =0

For 32-bit machines, follow the steps below:

1) Goto HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Main\
2) Add one DWORD value: TabProcGrowth =0

» Enablethe script debugging option: Simply uncheck the Disable script Debugging
checkbox under the Advanced Internet Options menu.
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For detailed instructions and solutions, refer to the Appeon Debugger section in the
Appeon Troubleshooting Guide.

2. A script in the deployed application must meet all of the following requirements to be
debugged; otherwise Appeon Debugger will ssimply ignore it:

» The script is deployed in the Debug JS or Debug PS/JS mode, using the local Appeon
Developer.

If you have changed the application PBLSs, or the local application files and the remote
application files are not the same, you must re-deploy the application. Or the newly-
added code will not be selectable in Appeon Debugger.

» The origina PowerScript code of the script is supported by Appeon.

If the code is unsupported, it is marked with a ## icon in the Appeon Debugger Source
view, and cannot be set as breakpoint, nor be located with the Run To Cursor or Set
Next Statement commands in the debugger.

7.2 Introduction to the debugging procedure

Although Appeon Debugger is used for debugging the JavaScript in the deployed application,
breakpoints are not set in the JavaScript, but directly in the PowerBuilder code loaded in

the Appeon Debugger Source view. The generated JavaScript is invisible throughout the
entire process, however the results shown in the Watch view are the execution results of the
JavaScript.

The debugger procedure with Appeon Debugger is the typical 5-step procedure as with
PowerBuilder Debugger:

Step 1: Start the debugger.
Step 2: Set breakpoints.
Step 3: Run the application in debug mode.

Step 4: Examine the application at the breakpoints by watching variables and expressions,
and monitoring the call stack. Y ou may also step through the application after a breakpoint to
closely examine the effects of each code.

Step 5: Fix the code.

The actions performed in each step are not very different from those required in
PowerBuilder Debugger. However, there are some specia requirements related with the
actions, and the action results are from the running of JavaScript. Continue reading the
following sections for detailed descriptions of these debugging steps.

7.3 Starting Appeon Debugger

To start Appeon Debugger:

Step 1: Close the other Appeon Developer tools.

Step 2: Start Appeon Server and the Web server that host the Web application.

Step 3: Click Appeon Debugger (™) on the Appeon Developer toolbar.
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The "Select atarget" window is displayed.

Figure 7.1: Select an application

Select the target to debug locally:

<My Select a target @

zalez_application_demo
' appeon_code_examples
' appeon_act_demo
' pet_wiorld
' appeantest

[ OF. ][ Cancel ]

Step 4: Select an application from the list and click OK.

Appeon Debugger starts and the selected application is loaded in the Appeon Debugger.

The menu bar of the debugger provides three ssmple menus: File, View and Help. The toolbar
isamost the same as that in PowerBuilder Debugger, except that the " Start Remote” button is

currently unavailable.

Figure 7.2: Appeon Debugger

E Debugger -
File  Wieww

/7 Arguments:

£/ Wodify History:
1| 1

ica lil:lr'l_le!I'l'

I string commandline
-
// Returns: (none)
-
/# Author: laihaichun Date: 28083/12/30

- ------———————————

F=3 |EOR =5

E Wik d s
E hdenus
-4 User Objects
Functions

1 |P | Source Browser A4  Source History

A » [ Local A Global % Instance 4]+ [ Call Stack A Breakpoints % ‘watch
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7.3.1 Views in Appeon Debugger

Appeon Debugger contains all the views provided by PowerBuilder Debugger except for
Instances View and Objectsin Memory view. Each Appeon Debugger view shows almost
the same information as its counterpart in PowerBuilder Debugger. The following table
summarizes the general differences between the two.

Table 7.1: Comparing the viewsin Appeon Debugger and Power Builder Debugger

Uniqueto Appeon Debugger
(Unavailable in Power Builder

Debugger)

Uniqueto Power Builder Debugger
(Unavailablein Appeon Debugger)

Source Identifies Appeon unsupported | ¢ Ancestor Script popup menu item
features with theicon (#%) _ _
» Descendant Script popup menu item
Source None List of system events, or the events
Browser and functions defined in parent classes,
or some special events (such as Menu
OnCreate event)
Source None None
History
Variables The values of variables » Parent and Shared views
unsupported by Appeon are .
marked as "unsupported". * Parent popup menu item
global variables used in the
application, while PowerBuilder |« Break on changes popup menu item
Debugger only displays
instantiated global variables.
Cadll Stack None None
Breakpoints | None » Setting special breakpoints
 Setting occasional or conditional
breakpoints
» Setting a breakpoint when avariable
changes
Watch Appeon Debugger handles some | Break on changes popup menu item
expressionsin a unigue way.

Although the views of Appeon Debugger and PowerBuilder Debugger ook similar, they
cannot be used together. For example, the breakpoints set in Appeon Debugger cannot be
recognized by PowerBuilder Debugger, and vice versa.

7.4 Setting breakpoints

7.4.1 Code lines that can be set as breakpoints
Pay attention to the following do's and don'ts before setting breakpoints:
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1. Do set breakpoints to the code lines supported by Appeon.

2. Do set simple breakpoints to script, don't set specia breakpoints, such as breakpoints
triggered when a statement has been executed a specified number of times (an occasional
breakpoint), when a specified expression is true (a conditional breakpoint), or when the
value of avariable changes.

3. To set a SQL statement that spans multiple lines as a breakpoint, do set the breakpoint at
thefirst line, don't set breakpoints at the other lines. If you try to set a breakpoint at the
other lines, the breakpoint will be set to the line that follows the SQL statement.

4. To set a PowerScript non-SQL statement, which spans multiple lines with continuation
characters (&) as a breakpoint, do set the breakpoint at the last line of the statement, and if
it is set at the other lines, the breakpoint icon is still added to the last line.

Note: you can set a breakpoint to the FOR statement, but the application will be suspended
for only once when this statement is executed.

7.4.2 Methods for setting breakpoints

Y ou can set breakpoints in the Source, Breakpoints, Variables, or Watch view, before or after
the application starts to run in debug mode.

Method #1: Setting a breakpoint in the Source view
Step 1: Select the script to display in the Source View.

Select afunction or event in the Source Browser view to display its script in the Source View,
or right click on the Source view and select Select Script from the popup menu to select the
script to be displayed.

Step 2: Right click alinein the Source view and select I nsert Breakpoints from the popup
menul.

Once a breakpoint is set, ared circle displays at the beginning of the line.
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Figure 7.3: Breakpointsare set

B Debugaer- [F=1 | FoE5)

Eile  iew

& openl sting commandline | retum long for sales_application_demo of sales_application_demEq i Application
A « ||| E-H Windows
/# Modify History: E henus
;; _______________________________________________________ ‘5 User Objects
/7 CopyRight 2883----777?%7 appeon Inc. - [B] Functions
ff=======================================================

®3(QLCA.DBMS = “ODDBC
SOLCA-AutoCommit = False
SQLCA.DBParm = “Connect3tring="'DSH=AppeonSample;UID=dba;P
COMMECT ;

®If SQLCA.S5QLCode <> A Then =
MessageBox{'fAlert’ ,”"Connection to database failed.")
Halt CLOSE
Return
End If

®0PEH{w_logon)
If Message.StringParm <> *1' Then
// messagebox{’'Alert’,”Connection to database failed.™
Halt CLOSE -

4 T 3 1] » i Source Browser 4 Source History

1 |P | Local ,( Global 3 Instance bl | L4 | Call Stack ;( Breakpoints % ‘watch

Method #2: Setting a breakpoint in the Breakpoints, Variables, or Watch view
Step 1: Right click the Breakpoints, Variables, or Watch view;

Step 2: Select Breakpoints from the popup menu to add a breakpoint using the Edit
Breakpoints dialog.

Method #3: Removing or adding a breakpoint at runtime

When the application is aready running in debug mode, you can still change the way the
debug works by removing or adding breakpoints at runtime:

Double-click alinein the Source view, or select Insert Breakpoint from the popup menuin
the Source view.

7.5 Running the application in debug mode

Click Start (i') on the Appeon Debugger toolbar. The application starts to run in the
Internet Explorer. It works normally until it reaches a statement containing a breakpoint. At
this point it stops so that you can examine the application in the Appeon Debugger.
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Figure 7.4: Application running in debugger mode

B Debugger - [F=1 [EoH F5)

File  Wiew

# @R R iEE(DE B B A X

E Windowws
£/ Event: open(} E Merus
‘5 User Objects
1 e R —— Functions
£/ Arguments:

£ string commandline

Ff Returns: (none)

#/ Author: laihaichun Date: 20883/12/30
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7.6 Examining an application at a breakpoint

Appeon Debugger provides a Quick Watch function, and the Variables, Watch and Call
Stack views that work the same as PowerBuilder Debugger for examining the state of the
application. It does not provide Break on Changes and TipWatch functions, nor the Object in
Memory view.

7.6.1 Special variable and expression handlings

Appeon Debugger watches the variable and expression results out of JavaScript code but not
PowerBuilder code. Thisisthe main difference with PowerBuilder Debugger. Despite the
difference, the results shall be mostly the same as in PowerBuilder Debugger. If the results
are different, there are two possible reasons:

1. The deployment of the application contains an error. In this case, determine the cause of
the error and correct the problem.

2. Appeon Debugger handles some variables and expressions differently from PowerBuilder
Debugger. Such differences are introduced below. Be aware of them, so not be false
alarmed and conduct unnecessary complex examination work.

Appeon Debugger does NOT support the following when examining variables:

» Expanding the values of ClassDefinition, PowerObject, and Any variables,
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» Expanding the runtime values of System variables. Instead, it just expands the inherent
properties of such variables.

For example, with aWindow type variable w_1, PowerBuilder Debugger shows all the
values of al the controls and variables contained in w_1, while Appeon Debugger only
shows the values of the Window properties of for w_1.

Appeon Debugger gives different results when evaluating the following expressions:
* It reports errors for expressions that contain unsupported code;

* If the same expression is added multiple times -- in different context -- into the
Watch,Appeon Debugger regards it as one expression, and evaluates its value according to
the context of the breakpoint;

» Appeon Debugger does not validate expressions. Therefore, if an expression does not pass
validation in PowerBuilder, PowerBuilder Debugger does not give evaluation results,
however Appeon Debugger may give aresult, sometimes even an incomprehensible result,
such as "[object]+3" for the expression "this + 3".

* If two expressions are interconnected, because the evaluation results of the expressions are
dependent on the orders they are executed, and the ordering may follow different rulesin
PowerBuilder Debugger and Appeon Debugger, Appeon Debugger may produce different
results from PowerBuilder Debugger.

7.6.2 Adding variables or expressions to Watch view
Method #1: Adding variables or expressionsto Watch with the Quick Watch

Step 1: Select avariable or expression or place the cursor to avariable or expression in the
Source view, right click and select Quick Watch from the popup menu or press Shift+F9.

The variable or the expression will be added to the Expression box on the Quick Watch
dialog.

Step 2: Click the Add Watch button to add the variable or expression to the Watch view.
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Figure 7.5: Quick Watch
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Method #2: Adding variables or expressions directly in the Watch
Step 1: Right click the Watch view and select I nsert from the popup menu.

Step 2: Type valid PowerScript expression in the New Expression dialog box, and click OK
to add it to the Watch view.

7.6.3 Changing the value of a variable or expression
To change the value of a variable in the Watch view:

Step 1: Double click avariable or right click avariable and select Edit Variable. The Modify
Value dialog box will be displayed.

Step 2: In the Modify Vaue dialog box, type anew value for the variable in the New Value
box, click OK to close the Modify Value dialog box and continue debugging the application
with the variable set to the new value.

Figure 7.6: Modify value
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To modify an expression in the Watch view:

Step 1: Double-click an expression or right click an expression and select Edit Expression.
The Modify Expression dialog box will be displayed.
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Step 2: In the Modify Expression dialog box, type the new expression in the New Value box
and click OK.

Notice that it is unsupported to select the Null check box in the Modify Vaue or Modify
Expression dialog to set the value of the variable or expression to null.

7.6.4 Evaluating an expression

To evaluate an expression in the Quick Watch dialog box and add it to the Watch view:
Step 1: Change the variable or expression in the Expression box.

Step 2: Click Reevaluate to display the new value in the tree view.

Step 3: (Optional) Click Add Watch to add the expression to the Watch view.

7.6.5 Examining context in Call Stack view
Y ou can examine the context of the application by clicking the code linesin the call stack.

To show adifferent context from the Call Stack view:
» Double-click aline or right click aline and select Set Context

Once afunction is selected in the Call Stack view, the Variable views, the Source view, and
the Watch view will al be updated.

7.6.6 Stepping through the application

Y ou can use the Step In, Step Over, Step Out, Run To Cursor, and Set Next Statement
commands to step through an application. Using these commands in Appeon Debugger is no
different from using them in PowerBuilder Debugger.

7.7 Fixing the code/stopping the debug procedure

Once you locate the cause of the erroneous execution results, you can stop the debugging
procedure, return to the PowerBuilder application to fix the code, and re-deploy the
application to verify that the error has been corrected.

To stop the debugging process: close Internet Explorer where the application is running, or
select Stop on the toolbar. The breakpoints you set to the application will be saved when
Appeon Debugger is closed, and will be available when Appeon Debugger is re-opened.

When fixing the code, you must return to the PowerBuilder IDE and make code changesin
the original PowerBuilder application. Redeploy the application and run the application in
Internet Explorer to verify if the problem has been corrected. If the problem still exists and
you need to return to Appeon Debugger to redeploy the application. Otherwise, the latest
code changes will not be reflected in Appeon Debugger.
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8 Running Appeon Applications

Appeon Web applications are accessed via Microsoft Internet Explorer and Appeon Mobile
applications are accessed via Appeon Workspace.

Confirm that the Web Server(s) and Appeon Server(s) hosting the Web or mobile
applications are running, and verify that the Web browser meets the necessary requirements
outlined in the Appeon Installation Guide.

8.1 Requirements

8.1.1 Windows account privileges
Note: Thisisrequired for the Web application only.

When you run an Appeon Web application for the first time, the Xcelerator plug-in (ActiveX
controls for improving the runtime performance of Web applications) must be downloaded to
the client.

Different Internet Explorer versions require different privileges for installing the ActiveX
control. For example, if using |E 8.0 or 9.0 on Windows Vista/7/2008, you do not need
administrative privileges to download and register the ActiveX control. You can log into the
machine as a normal user. However, if using IE 8.0 or 9.0 on Windows XP/2003, or if using
IE 7.0 or earlier, you must log in as a member of the Administrator group so you have the
permissions to successfully download and register the ActiveX contral.

If you are using IE 8.0 or 9.0 on Windows XP/2003, or if using |IE 7.0 or earlier, ask your
administrator to assign the current login account to the Administrators group, so that it
can successfully download and register the Xcelerator plug-in. After that, you can use any
account to log into Windows and run the application.

8.1.2 Internet Explorer settings
Note: Thisisrequired for the Web application only.

Settings in Internet Explorer can affect the deployed Web application. Sometimes outdated
filesthat are cached in the browser can interfere with how a Web application functions and
can cause errors when they are re-deployed many times. Internet Explorer's settings may also
block proxy connections or ActiveX control downloads when the Web application is opened.
Therefore, you need to make sure you configure Internet Explorer's settings accordingly.
Note that you may need to have the administrator rights to modify certain settings.

8.1.2.1 Settings for temporary Internet files

Sometimes cached filesin Internet Explorer can cause problems when accessing the
converted Web application after deployment. In order to avoid the risk of providing stale
data, it isimperative that Internet Explorer has the cache options set to Automatically and
that there is sufficient disk space on the Client to enable the Web files to be cached.

To set the cache options:

Step 1: Open Internet Explorer and select Tools > I nternet Options, as shown in the
following figure.
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Figure 8.1: Internet Optionsin Internet Explorer
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Step 2: Click the Settings button in the Temporary Internet Files group box.

Step 3: Select the Automatically radio button to check for newer versions of stored pages, as
shown in the figure below.
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Figure 8.2: Temporary Internet File Settings
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Step 4: Verify that the Disk spaceto use scroll box is set to at least 200 MB. Click OK inthe
Settings window.

8.1.2.2 Advanced settings for temporary Internet Explorer files folder

During development, the Temporary Internet Files folder should be set to automatically
empty each time Internet Explorer is closed. Thiswill force Internet Explorer to re-download
the entire application every time it is opened, to ensure the latest version of the applicationis
present, and to prevent interference from outdated cached files.

Here are the necessary steps required to configure Internet Explorer to flush its temporary
files each time the browser is closed:

Step 1: Click the Advanced tab in the I nter net Options window, as shown in the following
figure.

Step 2: Check the Empty Temporary Internet filesfolder when browser isclosed check
box under the Security section, as shown in the following figure.
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Figure 8.3: Empty Temporary Internet Filesfolder when browser is closed
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Step 3: Click Apply in the Advanced tab and then OK in the I nter net Options window to
allow the settings to take effect.

Allowing the temporary Internet files folder to be emptied each time the browser is closed,
is recommended only during the development stage. Once your Web application is ready
for production deployment, and frequent changes are not being made to the application,
this setting can be disabled once again (unchecked). This setting should be reset once
development is complete so the Web application can be cached in each Client PC for better
Client-side performance. Using this set of guidelines, caching files should be enabled when
they are needed for performance improvement, and disabled during the development and
debugging stages.

8.1.2.3 Advanced settings for proxy server

If the Client visits the Web application through a proxy server, you need to select the Use
HTTP 1.1 through proxy connections option under the HTTP 1.1 settings section, as shown in
the following figure.

The following steps detail the configuration needed in Internet Explorer:

Step 1: Click the Advanced tab in the I nter net Options window, as shown in the following
figure.
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Step 2: Check the Use HT TP 1.1 through proxy connections check box under the HTTP
1.1 settings section, as shown in the following figure.

Figure 8.4: Proxy connection settings
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Step 3: Click Apply in the Advanced tab and then OK in the I nter net Options window to
allow the settings to take effect.

8.1.2.4 Security settings for ActiveX controls and Appeon Xcelerator plug-in download

If the Web application calls OLE objects, DLL files, or runs executable programs on the
Client, then when the Web application is run for the first time on the Client the user will
need to download an ActiveX control (for executing functions that involve client-side
integration) and the Appeon Xcelerator plug-in (for improving the runtime performance of
Web applications) from the Web Server. To ensure that Internet Explorer will not block the
download, configure Internet Explorer's settings, using the following steps:

Step 1: Open Internet Explorer and navigate to Tools > Internet Options > Security.

Step 2: Verify that you selected an appropriate Web content zone. Appeon recommends you
select the Trusted sites zone and add the Web application URL to the Trusted sites.
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Figure 8.5: Select a Web content zone
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Step 3: Click the Custom L evel button in the Security tab. The Security Settings pageis
displayed, as shown in the following figure.
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Figure 8.6: Security Settings page
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Step 4: Check the Enable or the Prompt (recommended) radio button for the following
options:

Download signed ActiveX controls and plug-ins (and Download unsigned ActiveX
controls in Windows XP)

Initialize and script ActiveX controls not marked as safe
Run ActiveX controls and plug-ins

Script ActiveX controls marked safe for scripting

File download

Active scripting

Allow active content to run in files on My Computer (If the version of Internet Explorer is
6.0 SP2)

If Enableis selected, the ActiveX control will download automatically without prompting. If
Prompt is selected, your approval will be required before downloading takes place.

Note: If running the Appeon Web application for the first time in Internet Explorer 8 on
Windows XP, be sure to set "Download signed ActiveX control” to Enable (Do not set to
Prompt or Disable), otherwise, Internet Explorer will crash.
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8.1.3 Language setting requirements
Note: Thisisrequired for the Web application only.

The language of the data in the database used by the application should match the Windows
operating system language settings on the machine where Appeon Server isinstalled. If the
language settings conflict, problems will occur when the Web application is run.

Verify that the language of the data in the database used by the Appeon-deployed Web
application matches the language settings of the client operating system:

Step 1: Select Windows Start > Settings > Control Panel.
Step 2: Click Regional Options, as shown in the following figure.

Figure 8.7: Regional Options
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Step 3: Verify that the language selected in the Your locale (location) list box and the
language checked as default in the L anguage settings for the system settings are the same.
The language can be from different regions as long as it is the same language.

This configuration is not required for English language applications.
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8.1.4 Disabling anti pop-up software
Note: Thisisrequired for the Web application only.

If anti-popup software (example: Popup Stopper by Panicware) isinstalled and is active on
the Client machine, it will not allow any browser pop-ups to occur. This can cause certain
operations to become disabled in the converted Web applications such as the enhanced Web
features detailed below, or other operations that automatically load an Internet Explorer
window or popup. To prevent any problems, it is recommended that users disable any anti-
popup software while using the converted Web applications.

8.2 Accessing Appeon applications

8.2.1 URLs for Appeon applications

A typical URL for amobile application is similar to the following:

* http://192.0.0.80:8080/appeondemo/

A typical URL for aWeb application is similar to one of the following:
* http://192.0.0.80:8080/appeondemo/x32_index.htm

* http://192.0.0.80:8080/appeondemo/x64_index.htm

A complete application URL consists of five parts:

Table 8.1: Application URL

Application Description
URL

Protocol Uses "http://" typically. If your Web Server is configured as an SSL Web
Server, use "https://".

IPaddress | Usesthe IP address or domain name of the Web Server. Using localhost

or domain | listenersin aproduction environment is not recommended, although the
name Appeon installation program has created an HTTP listener (localhost: 9988)
for EAServer\Appeon Server.

HTTP port |(Optional) Specifiesthe port number that your Web Server accepts for HTTP
connections. If it is not specified, the default port is 80.

If several Web Servers are running on the same machine, make sure that the
port specified is a port of the Appeon Web Server.

Application | Specifies the application name. It is the name that you input in the Application
name URL field in Application Profiles.

Entry file | For Web applications only. Specifies the name of the entry page:
x32_index.htm for 32-bit system, or x64_index.htm for 64-bit system,
for example, "appeondemo/x32_index.htm" (x32_index.htm can be
omitted), "appeondemo/" (/ cannot be omitted), or "appeondemo/
x64_index.htm" (x64_index.htm cannot be omitted).
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8.2.2 Running Appeon applications

There are more than one method to run the Web application and the mobile application.
Web applications will be run in Internet Explorer. Y ou can use the following two methods to
run a Web application in Internet Explorer:

» Typing the URL of the Web application in Internet Explorer addressbar: You can
always use this method to access the application, on the condition that the computer meets
Section 8.1, “Requirements”.

» Launching the deployed Web application from the Appeon Developer Run button

(éﬁ): Run is ashortcut to Web applications that are deployed to the default Appeon Server
and Web Server.

Mobile applications will be run in the Appeon Workspace. Y ou can use the following two
methods to run a Mobile application in Appeon Workspace:

» Accessing the mobile application in Appeon Workspace: Y ou can always run the
Appeon Workspace and run a deployed mobile application there. For detailed instructions,
refer to Appeon Workspace User Guide.

L aunching the mobile application from the Appeon Developer Run button (£): Run
is a shortcut to mobile applications that are deployed to the default Appeon Server and
Web Server.

Asyou can see from the above, both the Web application and the mobile application can be
run from the Appeon Developer Run button. This section talks about this method in details.

8.2.2.1 Launching applications from the Run button

Y ou can launch the application by clicking the Run button in the Appeon Developer toolbar.
Appeon Developer automatically remembers the URLSs of the applications that are deployed
to the default Appeon Server and Web Server.

To run an application from the Appeon Devel oper toolbar:

Step 1: Verify that the default Appeon Server and Web Server in the Server Profiles settings
have been started.

Step 2: Click the Run button (£%) on the Appeon Developer toolbar.

If more than one application is deployed, the Run Application window is displayed as
shown in the following figure, prompting you to select which application to run.
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Figure 8.8: Run Application window
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Only applications deployed to the Default Appeon Server and Default Web Server are listed
in the Run Application window.

If you have deployed an application to several different folders on the same Web Server,
Appeon Developer will only remember the URL used in the last deployment, although the
URL s to access the other folders used in the previous deployments will also be valid.

Step 3: Select an application from the application list.

Step 4: Select a project loader for the application from the Project Loader dropdown list
box.

» For Web applications, | E Browser isthe only selectable project loader and is
automatically selected by default; the Orientation dropdown list box is automatically
disabled.

» For mobile applications, Appeon Emulators (either for iPad or for iPhone) are the only
selectable project loaders and the Appeon Emulator -- iPad is automatically selected
by default; you also need to select an orientation for the application in the Orientation
dropdown list box. By default, if you have selected Appeon Emulator -- iPad as the
project loader, the landscape orientation is automatically selected; and if you have
selected the Appeon Emulator -- iPhone as the project loader, the portrait orientation is
automatically selected.

Step 5: Click Run.
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» For Web applications, it will be automatically loaded in the |E browser.

» For mobile applications, it will be automatically loaded in the Appeon Workspace
Emulator, which is Appeon Workspace running on the Windows platform.

8.2.2.2 Selecting a run mode
Note: Thisisfor the Web application only.

When you run a Web application for the first time, a run mode selection page will be
displayed, if you have enabled the Allow user to select run mode option in AEM (see
Appeon Server Configuration Guide for details).

This page alows you to select from the following run modes (as shown in the following
figure):

* Run Now: The application runs immediately and files will be downloaded only when used.
This mode is recommended for high speed network.

* Run After Download: Files will be downloaded before the application runs. Thismodeis
recommended for low speed network.

Y ou can also set arun mode to be the default mode in AEM (see Appeon Server
Configuration Guide for details).

Figure 8.9: Run Mode window
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8.3 Appeon DataWindow menu
Note: This section isfor Web applications only.

Appeon provides a Web enhancement, the Appeon DataWindow menu, for all Datawindows
deployed to the Web. When right-clicking on a deployed Datawindow, you can access the
Appeon Datawindow popup menus: Find, Find Next, Find Previous, Sort, Filter, Print, and
Save As File (Obsolete), as shown in the following figure.

Figure 8.10: Appeon DataWindow popup menu
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8.3.1 Enabling Appeon DataWindow menu

To use the Appeon DatawWindow menu, you must enable it by using the following two
functions. appeonextfuncs.of popmenu and appeonextfuncs.of popmenuon that are defined

in the Appeon Workarounds PBL. For detailed instructions on how to use these functionsin a
Datawindow, refer to AppeonExtFuncs object in the Workarounds & API Guide.

8.3.2 Using Appeon DataWindow Menu

Appeon DataWindows menu have the following features: Find, Find Next, Find Previous,
Sort, Filter, Print, and Save As File (Obsolete). Perform the following steps to use the menu
in the Web Datawindows.

8.3.2.1 Find
The user can search for data using the Find, Find Next and Find Previous functions.

Step 1: Right-click the Web DataWindow and select Find from the popup menu, as shownin
the following figure.
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Figure8.11: Find
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Step 2: Select the column and search scope and input criteria for the search.

Use the Find function to find all rows where the orders count column is equal to 2, as shown
in the following figure.

Figure8.12: Find
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Step 3: Thefirst row that matches the search criteriawill be highlighted.

Step 4: Right-click and select Find Previous or Find Next to highlight the rows (one at a
time) that match the criteria.

8.3.2.2 Sort and filter

The user can sort data by the column in ascending or descending order, or filter datausing a
number of functions.

To sort data:

Step 1: Right-click the Web DataWindow and select Sort from the popup menu, as shown in
the following figure.
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Figure 8.13: Sort
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Step 2: Specify the column used to sort the data in the Datawindow by clicking on the
column name in the left list box. The column name appears on the right, as shown in the

following figure.

Figure 8.14: Specify sort column
Specify Sort Columns ==
11D0rag and Drop items.
21 Double click column to edit.
Source D ata Columniiz Azcending Lancel I
department_dept_name employes_emp_id

iemployee_emp_id
employes_emp_Iname
emploves_emp_fhame
emploves_zalary
employes_state

Step 3: Check the Ascending check box to sort the data in ascending order or uncheck the
Ascending check box to sort the datain descending order. Click OK to accept the changes.
The Datawindow automatically refreshes and the data is sorted.

If you want to edit the selected column, double click it to open the "Modify Expression”
dialog, as shown in the following figure.
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Figure 8.15: Modify Expression dialog

Modify Expression
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Tofilter data:

Step 1: Right-click the Web DatawWindow and select Filter from the popup menu, as shown
in the following figure.

Figure 8.16: Filter

D atatwindow
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1 i I

Step 2: Specify thefilter by selecting the functions and columns. Click Verify to test whether
thefilter expressionisvalid. Click OK to accept the filter, as shown in the following figure.
The Datawindow automatically refreshes and the datais filtered.
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Figure8.17:

Specify Filter
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8.3.2.3 DataWindow printing
The Print menu provides user ability to print Datawindows directly on printers connected to

the Client.

Step 1: Right-click the Datawindow and select Print from the popup menu, as shown in the
following figure.

Figure 8.18: Print filewith physical printers
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Step 2: Specify the printer settings and paper settings in the Print Setup window, as shown
in the following figure. Click OK.
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The Datawindow will be printed directly to the local printer.

Figure 8.19: Print setup window

[l
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o) (oo

8.3.2.4 SaveAs (Obsolete)
Thisfeatureisobsolete since Appeon Web 6.6.

The user can save the contents of a DataWindow in different file formats.
Step 1: Right-click the Datawindow and select Save As File from the popup menu, as shown

in the following figure.

Figure 8.20: Save AsFile
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Step 2: Specify thefile location, file name and file type in the Save As window, as shownin
the following figure.

Figure 8.21: Save Aswindow

O Sawve &3 [Em)
Savein | B IR ZI &= ¥ B
“Jarne Size Type Date modified il
= =
r:_1 | Administratar 1
Public

-

File name: | Save

Save as bwpe: |Te:-:t with headers [° ket | - | | Cancel |

Note:

If the DataWindow without any datais saved asthe HTML file or the XML file, on the Web
the DataWindow header will not be saved, whereasit will be saved on PB.

8.3.2.5 Additional Enhanced Features

In addition to the popup menu (Find, Find Next, Find Previous, Sort, Filter, Print, Save As
File), Appeon offers more features for users to manage DatawWindows on the Web. Users
can place DataWindow columns in a different order by dragging and dropping them to new
positions. When navigating an editable DataWindow, users can use the popup menu to
quickly edit the contents. These features are always available and require no extra coding to
be enabled. The following steps show you how to access them:

Step 1: Select a column header in the Web DataWindow and the selected location is
highlighted, as shown in the following figure.

Step 2: Drag and drop it to the desired location, and the location to be dropped is highlighted
aswell.
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Figure 8.22: Select a column header
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Step 3: Right click on an item in an editable HTML Datawindow and a menu pops up, as
shown in the following figure.

The user can select the following menu items from the popup menu to perform quick editing:
Undo, Cut, Copy, Paste, Delete, Select All.

Figure 8.23: Popup menu for quick edition
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9 Launching Appeon Workspace Emulator

Appeon provides a shortcut of the mobile device emulator, which is the Appeon Workspace
emulating various mobile devices, on the Windows platform to conveniently run your
Appeon deployed mobile applications.

There are three ways to launch the Appeon Workspace Emulator:

1. Launch Appeon Workspace Emulator from the Appeon Developer Run button (5/4*).
If the application is deployed to the Mobile, then when you click Run in the Run
Application window, Appeon Workspace Emulator will be launched and the application
will be automatically run in Appeon Workspace Emulator. For details, please refer to
Section 8.2.2.1, “Launching applications from the Run button”.

2. Launch Appeon Workspace Emulator from the Appeon Developer Appeon Workspace

Emulator button (ﬁ'). On the click of the Appeon Workspace Emulator icon on the
Appeon Developer Toolbar, you directly open the Appeon Workspace Emulator as
shown in the following figure (Appeon Workspace Emulator for iPad). Y ou will need to
add the application in Appeon Workspace first before you can run it.

3. Launch Appeon Workspace Emulator from Windows Start > All Programs > Appeon
for PowerBuilder 2013 > Appeon Developer > Appeon Wor kspace Emulator.
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Figure 9.1: Appeon Workspace Emulator

™ ——
|

R

{ Appecn Workspace Emulator

Easy. Fast. Cross-OS

Mobilize your enterprise apps at your fingertips.

LEARN MORE >>

After you have launched the Appeon Workspace Emulator, you can select a device that

the Appeon Workspace Emulator emulates, select a scale percentage from the percentage
dropdown list box , change the view orientation by 90° CW or by 90° CCW, or exit the
Appeon Workspace Emulator from the Appeon Workspace Emulator toolbar, as shown in the
following figure.

Figure 9.2: Appeon Workspace Emulator Toolbar

Emulator Toolbar

iPad - || 100% q | Rotate Left | |Hntate Hight| | Exit |

For detailed instructions on using Appeon Workspace, please refer to the Appeon Workspace
User Guide.
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10 Using Information Manager

Information Manager provides easy access to al the available reports or log files generated
during the application migration process, including debug, development, and deployment.
The reports are categorized as follows: Analysis. Thelog files are categorized as follows:
Deploy Log and Analysis Log.

The following table provides a brief description of al the reports generated during the Web
or mobile migration process and the report types they are associated with.

Table 10.1: Report Description

Report Description

Type
Analysis Analysis Report is generated during a feature analysis or application
deployment, and records the unsupported features in the application.

After you click this button, the UFA Report Window will be displayed. For
detailed instructions, refer to Section 5.2, “Working with UFA Report”.

The following table provides a brief description of all the log files generated during the Web
or mobile migration process, and the log types they are associated with.

Table 10.2: Log Type Description

Log Type Description

Deploy Log | Deploy Log is generated during application deployment, and records the
deployment process status.

All log files are named according to the following format:

Log Type (i.e. DeployWizardLog, or FeatureAnalysisLog) + time when the
log file is generated (yyyy/mm/dd/hh/mm/ss) + xml.

For example, DeployWizardLog 20050220101918.xml.

AnaysisLog |AnalysisLog isgenerated during the feature analysis process, and records
the analyzing status.

10.1 Viewing the reports and logs

Step 1: Click the Infor mation button () on the Appeon Developer toolbar and the
Information Manager is displayed, as shown in the following figure.
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Figure 10.1: Information Manager
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-8 &ppeon Developer
% Deplay Log Analyziz Beport

C:A%Program FileshdppeontDevelopers. 24Project\zales_application...\UFA_Report.«ml

Cloge

Step 2: Select the application in the top dropdown listbox.

Step 3: Select areport type or log type in the left box and the corresponding report button or
log files are displayed in the right box.

If there is more than one log file generated, the log files are listed in order according to the
date and time of generation; the latest log will be listed at the top.

Y ou can open onelog at atime, or open several logs at one time: select a continuous range of
log files by holding down Shift and click log files, or select a disconnected range of log files
by holding down Ctrl and clicking log files. Then click View to open the selected log files.

The View and Delete buttons will be disabled if no log files were generated.

Note: For Deploy Log, you can click View All to view all information such as errors,
warnings, and process description, or click View Warning to view warnings only, or click
View Errorsto view errorsonly.

Step 4: Click the report button or log file to view the report or log.

Y ou can continue with other operations while the Information Manager opens. For example,
you can perform feature analysis, deploy the application, or run the Web or mobile
application. If any new reports or logs are generated when the Information Manager is still
open, the new reports or logs are not reflected in the Information Manager immediately. Y ou
need to refresh Information Manager in either of the following ways:

* Closethe Information Manager and open it again, or
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» Select adifferent application and then select the original application again in the
Information Manager.
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11 Packaging Applications

The Appeon Application Package Wizard helps PowerBuilder developersto

» Generate portable deployment packages for Web and/or mobile applications, so the
user can directly deploy the Web and/or mobile application to servers without installing
Appeon Developer and using it to do Web or mobile deployments. The PowerBuilder
developers do not need to provide the source PowerBuilder application to the user; this
protects the author's intellectual property rights. Refer to Packaging a deployment project.

» Generate Xcode projects for native mobile applications, so the user can compile the Xcode
project to an IPA file and distribute it to iOS App Store or for Ad-Hoc deployment. Refer
to Packaging a native mobile project.

» Customize Appeon Workspace and generate the X code project for Appeon Workspace.
Refer to Customizing and packaging A ppeon Workspace.

Before using the Appeon Application Package Wizard, verify that

1. Thetarget PowerBuilder application has been deployed as required:

Y ou must have performed a full deployment on the target PowerBuilder application

on the same Developer machine where you will use the packaging wizard to pack this
application later, thiswill generate a complete set of files on the local Developer machine
where the package wizard will be able to obtain and pack files.

2. The deployed application can run correctly.
11.1 Packaging a deployment project

11.1.1 What can be packaged?

The package wizard allows you to pack the following files and settings into an executable
deployment project:

» Mandatory Web or mobile application files

Include al application files, DatawWindow syntax, INI files, imagefiles, DLL/OCX files
etc.

» Mandatory application profile, Appeon Server profile, and Web server profile settings

Include the profile name, Application URL, PowerBuilder version, file encryption,
performance settings, server type, Appeon Server version, Appeon Server and Web
server connection settings, AEM, data sources, etc. All these settings will be saved to the
configuration filesin the INI folder of the generated package. Of these configuration files,
you can modify the config.xml file using the config.exe tool. For detailed information,
refer to Section 11.1.3, “Modifying the deploy-config file”.

» Optional EAServer components

When the Appeon Server is of type EAServer, you can package the local or remote
EA Server components used by the application. Note that EAServer components work with
EAServer application server only.
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11.1.2 Packaging instructions

To package an executable deployment project and the related settings, take the following
steps:

Step 1: Start the servers, as the package wizard will pack settings of Appeon Server, AEM,
and NV Os (if any).

Step 2: Click the Package (&) button on the Appeon Developer toolbar to open the Appeon
Application Package Wizard.

Step 3: Select or create a profile from the dropdown list box and click Next to proceed.

A profileisa configuration file containing configurations that you specify when packaging
the application. Y ou can select an existing profile or create one by entering aname in the
text field. The profile will be automatically saved and listed for selection next time when you
launch the Appeon Application Package Wizard again.

Figure 11.1: Welcome page

i:’ﬂ Appeon Application Package Wizard @

Welcome to the Appeon Application Package
Welcome Wizard

B Select Package Type
B Select Application Pleaze select an exizting profile or create a new one.

B Select Appeon Server

B Configure EAServer Profile

B Select NVOs

B Select AEM Settings
B Specify Destination Folder
B Packaging Process

B Finish

< Back [ Mext » J[ Cancel Finizh

Step 4: Select the Package a Deployment Project radio button.

To package an Xcode project for a native mobile app, follow detailed instructionsin
Packaging a native maobile project.

To customize Appeon Workspace and then package Appeon Workspace to an X code project,
follow detailed instructions in Customizing and packaging Appeon Workspace.
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Figure 11.2: Select packagetype

] Appeon Application Package Wizard @

Welcome Please select a package type.

Select Package Type

B Select Application

@ Package a Deployment Project

B Select Appeon Server

(71 Package a Mative Mobile Project

B Configure EAServer Profile

(") Customize and Package Appeon Waorkspace

B Select NVOs
B Select AEM Setfings

B Specify Destination Folder

B Packaging Process

N Finish

[ < Back ][ M et ][ Cancel ] Einizh

Step 5: Select the profile of the application that you want to package and click Next.

Only applications that have been deployed will be listed here for selection. If the application
you intend to package is not listed here, you would need to deploy the target application
using the Appeon Deployment Wizard first (See Chapter 6, Deploying PowerBuilder

Applications).
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Figure 11.3: Select an application
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The following table gives a brief introduction of the columns:

Table 11.1: Application Package Wizard

Column Description

Selected Identical to the default application profile selected in the Appeon Developer
Configuration window.

Profile Name | Identical to the application profiles configured in the Appeon Developer
Configuration window.

Mode Identical to the current mode the application profile is set to in the Appeon
Developer Configuration window.

It is recommended that the packaged applications should be available in
Release mode, as this mode prevents most forms of reverse engineering, and
like application packaging, it protects the author's intellectual property.

Step 6: Select the Appeon Server whose settings will be packaged and click Next.

The Appeon Server settings, such as the server type and the Appeon Server version, will be
saved to the config.xml filein the INI folder of the generated package. If necessary, modify
thisfile using the config.exe tool after the packaging is complete (refer to Section 11.1.3,
“Modifying the deploy-config file”).
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All the configured Appeon Servers selected into the default deployment profile in the Appeon
Developer Configuration window are listed, as shown in the following figure.

The selected Appeon Server determines that its AEM settings will be packaged and that the
packaged application can only be installed to Appeon Servers of the same version, such as
2013, but not necessarily the same type.

Figure 11.4: Select an Appeon Server

] Appecn Application Package Wizard

Please select an Appeon Server from the following
Welcome list.

Select Package Type
Mote: To package EASerer NWO s, you must zelect an Appeon Server of
twpe EAServer. Otherwize, the steps for zelecting EASerer prafile and

Select Application MY 0 components will be skipped.

Select Appeon Server ]
Selected Appean Server Profile Mame

“ Local Appeon Server

B Configure EAServer Profile
B Select NVOs

B Select AEM Settings

B Specify Destination Folder

B Packaging Process

N Finish

[ < Back “ MHext > ][ Cancel ] Einizh

Step 7: If the selected Appeon Server is of type EAServer, select whether to package
EAServer components.
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Figure 11.5: Configure EAServer profiles

-

& Appeon Application Package Wizard
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Select Package Type

i Select Application

Select Appeon Senver

Flease select whether to package EAServer

components.
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["|iPackage EAServer Components

Configure EAServer Profile Profile M arme Server Mame Part Murnber
Select NVOs
Select AEM Settings
Specify Destination Folder
B Packaagi 55
Raihsm—— Edit.. Add... Delste
W Finish
< Back ][ Ment > J [ Canicel Einizh

If EAServer components are used in the application, select the Package EA Server
Components option and then create connection profiles for EAServers which host the
components. Follow instructions below to create EA Server profiles:

Click Add to create an EAServer profile.

name, host name or IP address, port number, user name, and password.

Click Test to ensure that the connection is successful.

Click OK to save the new EAServer profile.

In the Edit EAServer Profile dialog box, input the following connection parameters: profile

Appeon Developer User Guide

Page 129



Packaging Applications

Appeon for PowerBuilder 2013

Figure 11.6: Edit EAServer profile

——

rEdit EAServer Profile

l Profile: Narne: |
Server Mame:

Part Humber:
Login Marme:

Pazsward:
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[
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Step 8: If the Package EA Server Components option is selected in the previous step, select
which components to package and click Next.

The selected NV Os will be packaged as ComponentName.jar and saved under the /NV O/
server profile name/package folder.

Figure 11.7: Select NVOs

H Appeon Application Package Wizard

S

Welcome

Select Package Type

Select Application

Select Appeon Senver

Configure EASenver Profile

Select NVOs

B Finish

Please select EAServer components to package:

< Back ][ MHext ] [ Cancel Einizh
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Step 9: Select whether AEM settings and data sources for the current application will be
packaged and click Next.

The AEM settings will be saved in the AEM .xml file and data sources will be saved in the
config.xml file.

Figure 11.8: Select AEM settings and data sour ce

3] Appeon Application Package Wizard @

You can select to package the AEM settings and
Welcome the application server data source settings for the
current Appeon application.

Select Package Type

Fleasze select whether to package AEM zettings and data source settings.

Select Application Fleaze note that these zettings can only apply to Appeon Server of the
zame tppe [from JZEE to JZEE, or from MET to MET].

Select Appeon Server CBEH g

Configure EAServer Profile [] Data Source Settings [for EAServer or 115 only)

Select NVOs

Select AEM Settings

B Specify Destination Folder

B Packaging Process

N Finish

[ < Back ][ MHext > ][ Cancel ] Einizh

Step 10: Specify the storage location for the generated package and click Next.

The generated package will be stored under afolder named " Application Profile
Name_install" under the specified location.
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Figure 11.9: Specify destination location for the package

] Appecn Application Package Wizard

The packaging tool will create a folder named
Welcome "Application Profile Name_install® to store the
packaged application.

Select Package Type

Where do pou want to place the folder?

Select Application

Application Prafile MWame: zales

Select Appeon Server ] ; ] o
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Configure EAServer Profile

Sefect NVOs
Select AEM Settings
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B Packaging Process

B Finish

[ ¢ Back “ MHest » ][ Cancel Einizh

Step 11: Wait while the wizard is packing files and settings.
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Figure 11.10: Application packaging status window

3] Appecn Application Package Wizard

Welcome

Select Package Type
Select Application

Select Appeon Server
Configure EAServer Profile
Sefect NVOs

Select AEM Settings

Specify Destination Folder

Packaging Process

B Finish

Flease wait while the packaging tool performs the
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Time Run Information
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[l i [

¢ Back
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Step 12: Once the operation is complete, click Finish to exit the package wizard.

To view the log information generated during the packaging process, select the View
Package L og box and then click Finish. Thelog file will be displayed.
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Figure 11.11: Application packaging finished

3] Appeon Application Package Wizard @
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Welcome

Select Package Type
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After the application is successfully packaged, all the necessary application files will be
packaged into an executable deployment project under the " Application Profile Name_install"
folder under the specified location. Y ou can copy the deployment project to other computers
and deploy the application to any Appeon Servers and Web Servers by following instructions
in Section 11.1.4, “Installing and uninstalling an Appeon application”.

11.1.3 Modifying the deploy-config file

The deploy-config file (config.xml) is created during the packaging process and includes the
default settings of the application: application profile, Appeon Server profile, Web server
profile, EAServer profile, EAServer components, and data sources. Y ou can modify the
config.xml file using the config.exe tool to have identical settings of the target environment,
so that the user can run the installation very conveniently without needing to specify them.

When you run the config.exe file in the generated package, an XML File Configuration
dialog is displayed and loads the Application URL setting, Appeon Server settings, and Web
server settings from the config.xml file. Y ou can modify these settings on the corresponding
tab pages and then click OK to save them to the config.xml file. The instructions to modify
these settings are the same as to modify in the Appeon Developer Configuration window (see
Section 4.2, “Using Configure Tool” for detailed instructions).

Important Note: If using JEUS as the target Web server, be sure to use the default
Application Profile Name and Application URL. Changing the default Application Profile
Name and Application URL will cause the application files unaccessible.
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Figure 11.12: Configuring the XML file
{32 ¥ML File Configuration ==

App URL | Appeon Server | 'web Server
App URL Setking

LT T s RS e code examples

[ Ok ]| Cancel |

11.1.4 Installing and uninstalling an Appeon application

11.1.4.1 Points to note before installation

Be aware of the following points before you run the deployment project to install an Appeon
application:

» The Setup program of the generated deployment project runs on the Windows platform
only. Toinstall applications to servers running on Unix\Linux, you must run the Setup
program on the Windows platform and then install the application to remote servers
running on Unix\Linux.

* Thetarget Web servers must have the Appeon Server Web Component correctly installed.

» The packaged EA Server components, if any, can only be installed to EA Server application
server.

11.1.4.2 Installing an application

The generated deployment project runs on the Windows platform only. Therefore, you will
need to copy the deployment project to a computer running Windows and then install the
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application to any number of Appeon Servers and Web servers located in the same network
area. Installing an application using the deployment project is the same as deploying an
application using the Appeon Deployment Wizard.

Step 1: Start the target Appeon Server(s) and Web server(s) where you want to install the
application.

Verify that the target Web servers already have Appeon Server Web Component installed.
Step 2: Run the Setup.exe file in the generated deployment project.
The Appeon Application Deployment wizard is displayed. Click Next to proceed.

Figure 11.13: Welcome page

Ei@.&ppeun Application Deployrment @

Welcome to the Appeon Deployment Wizard!

Thiz wizard will inztall the packaged Appean application an
YOUr cormputer.

To continue, click Mest. Ta et the wizard, chck Cancel,

< Back Mt = | I Cancel I

Step 3: Select the deploy-config file (config.xml) to ease your configuration of the
installation wizard. The installation wizard will use the settings in the config.xml file.

If you do not want to use the deploy-config file, simply skip this option and click Next to
configure the settings step by step.
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Figure 11.14: Select the configuration file

ﬁ.&ppeun Spplication Deployment (5]

Select an Existing Deploy-config File

Fleaze select an exizting deploy-config file for quick configuration.

The wizard automatically loads the configuration file for the current package and uses the settings
it thiz file as the default gettings for the subsequent steps. You can modify the settings in thiz file or
gelect another configuration file.

Maote: 'ou can clear the configuration file path in the Destination File bow and click Mext to
configure the settings manually.

Destination File

MAppecntiy ebfppPackagebappeon code examples installsinioonfio.sm Browse...

[ < Back ][ Hest » ] [ Cancel ]

Step 4: Input the Application Profile Name and the Application URL for the application
and click Next.

The Application Profile Name is used as the application name to identify an application.

If you want to install multiple instances of the same application on the same server, you can
run the setup package repeatedly and specify different Application Profile Name here. For
example, input appeon_code_examples_test as the Application Profile Namein the first
installation, and input appeon_code_examples_production as the Application Profile Name
in the second installation. The Application Profile Name will be used as the application
name to distinguish the multiple application instances on the same server, so they can be run
independently from each other.

Important Note: If using JEUS as the target Web server, be sure to use the default
Application Profile Name and Application URL. Changing the default Application Profile
Name and Application URL will cause the application files unaccessible.
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Figure 11.15: Specify Application Profile Name and Application URL

Eﬁ.&ppeun Spplication Deployment @

Specify Deployment Settings
Fleaze specify the profile name and the URL for the application,

Fleasze specify the URL for the application.

Application Profile Mame: s EREEITEES

Application LRL

http:/fweb server:port/ appeon_code_exarnples

l < Back |[ Hest » ]l Cancel |

Step 5: Configure and select profiles for the Appeon Server(s) and the Web server(s) where

the application will be installed.

To install the application to more than one Appeon Servers, please make sure the Appeon
Servers are of the same version (such as 2013) as the Appeon Server selected for packaging.

Toinstall the application to an Appeon Server cluster, please create an Appeon Server profile
for each Appeon Server in the cluster. For detailed instructions on how to create the Appeon
Server profile and Web server profile, refer to Section 4.2.3, “Managing server profiles’.
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Figure 11.16: Specify server settings

i Sppeon Spplication Deployment

Server Settings

Fleaze select the Appeon Server and the *Web Server.

Appeon Servers

Selected  Profile Name Semer Type Edit...

[ F [ 192.0.1.56 EAServer

a4 | i | » Delete

YWwieb Servers

Selected  Prafile Mame Edit...
[#1 192.0.1.56_EAServer

&dd

Delete

e B

[ < Back ]E Hest » ] [ Cancel

Step 6: Select whether to deploy EAServer components.

After NVO components are deployed, you must generate stub/skeleton in EA Server.
Detailed instructions are provided in Generating Sub/Skeleton in EAServer in the Migration
Guidelines for Appeon Web.
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Figure 11.17: Specify EAServer settings

i Sppeon &pplication Deployment

EAServer Settings

Fleaze select whether to deploy EAServer components.

Pleasze select whether to deploy EAServer components. To deploy components, pleaze specify
the EAServer configuration settings.

Maote: if the EAServer Components option is not selected, the step for zelecting NYO components

will be skipped.
[T EAServer Components
Profile: M arme Server Mame Part Nurnber Login Edit...
&dd..
Delete
Ll IFR 3
| < Back |[ Mext » ]| Cancel |

If EAServer components are used in the application, select the EAServer Components option
and then create connection profiles for EAServers where you want to deploy the components.
Follow instructions below to create EAServer profiles:

» Click Add to open the Edit EAServer Profile dialog box.

* Input the connection parameters: profile name, host name or I1P address, port number, user
name and password.

* Click Test to verify the connection and the click OK to finish the creation.

Figure 11.18: Edit EAServer Profile

f Edit EAServer Profile ==

Profile Hame:; |

Server Mame:
Part Murnber:
Login Marne:

Pazzward:

Mate: Input the real IP address in the Server Mame field. For example,
192.0.0.1.

] ] [ Cancel
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Step 7: If the EAServer Components option is selected in the previous step, select the
EAServer profile from the list and the components to deploy. Click Next to proceed.

Figure 11.19: Deploy NVOs

i Sppeon Spplication Deployment

Deploy NYDsz

Fleaze select which EASerer components to deploy.

Pleasze select which EAServer components will be deploped to the specified EAS erver.

EaServer List: 192.0.1.56

#-[]J4§ Component List

[ < Back ][ Hest » J [ Cancel ]

Step 8: Select whether to install AEM settings and data sources for the current application
and click Next.
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Figure 11.20: Deploy AEM settings

i Sppeon Spplication Deployment

Deploy AEM Settings
Fleaze specify how to deploy the AEM zettings.

Pleasze zelect whether to deploy the AEM zettings and data source zettings ta the specified
Appeon Semver.

[7] Data Source

If a data source with the same name already exiztz in the Appeon Server, then

i@ Owvenrite it Do nat ovvenarite it

[ < Back ][ Hest » J [ Cancel ]

Step 9: Specify the destination folder for the undeployment tool and the log file and click
Next.

Figure 11.21: Specify location for the Appeon Undeployment T ool

ﬂ Appean Application Deployment

Install the Appeon Undeployment Tool

Pleasze zelect the folder where the Appeon Undeployment Ta

Please zpeciy where the Appeon Undeployment Tool will reside. The deploy-config file and the
deploy log will alzo be stared in this folder.

Destination Folder

:%Program FileshdppeontJndeplovsappeon_code examples Browse...

< Back ][ Mest » J [ Cancel
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Step 10: Specify the destination file and source file that you want to replace for the Appeon
application package, and click Next.

Files (also called "destination file") under the "wcode" folder of Appeon application package
can be replaced by files of the same type (also called "sourcefile"), so that the sourcefile
will be installed instead of the destination file. When you click the Add button, the File
Replacement dialog box is opened. To select the destination file, click Browse to display the
Open file dialog which will automatically open the "wcode" folder of Appeon application
package, so you can conveniently select afile from the "wcode" folder or from its subfolder.
To select the source file, click Browse to navigate to the folder where the sourcefileis stored.

Figure 11.22: Specify filesto replace for the application package

ﬁ Appeon Application Deployment @
Replace Files
Pleaze specify the files that you want to replace for the applicati

Mo,  Destination File Source File Edit...
Add...
Delete

4 1 3

<Back || Net> | | Cancel

Step 11: Wait while the wizard isinstalling files and settings.
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Figure 11.23: Deploying the application

! minutes.

i Sppeon Spplication Deployment

Deploying the Application

The deployment wizard is performing the requested operations.

[Ld| Flease wait while the deployment wizard is deplaying the application. This may take several

Time
18:13:23
18:19:24
18:19:24
18:19:24
13:19:25
13:19:25
13:19:25

seceeoe | Gh

Run Infarmation

Deploving application name to Appeon Server...
Dreploving [M] file(z] to Appeon Server...

Deploving D atavwindow SOL to Appeon Server...
Committing changes to Appeon Server...

Deplaving embedded SOL to Appeon Server...
Committing changes to Appeon Server...

Deploying D atatwindow Spntax bo Appeon Server...

A

I

< Back

Het »

Cancel

Step 12: Once the operation is complete, click Finish to exit the install ation wizard.

To run the application immediately, select the Run Application Now option and click Finish.
Or you can run the application later from the Windows Start | Programs | Appeon Web
Application | ApplicationName.

To view the log information generated during the installation process, select the View Log

box and then click Finish. The log file will be displayed.
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Figure 11.24: Deployment complete

E;»@.&ppeun Spplication Deployment [5]

Finizhed deploying the Appeon application.

The deployment wizard has finished installing the application and
the related zettings to the computer.

[ Bun Application Mo

[] Wiew Log

Click. Finizh bo exit the wizard.

| T ST TR I R T T T TR

< Back Cancel

11.1.4.3 Uninstalling an application

Step 1: Start the Appeon Server(s) and/or Web server(s) where you intend to uninstall the
application.

Step 2: Select Windows Start > All Programs > Appeon Application > Undeploy
ApplicationName.

The Appeon Application Undeployment Wizard is displayed. Click Next to proceed.
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Figure 11.25: Appeon Application Undeployment wizard

ﬁ.&ppeun Spplication Undeployment

Welcome to the Appeon Undeployment Wizard!

Thiz wizard will remove the Appeon application from the specified
compuker.

Mate: before undeplaving an application, ety that it iz not in
LIzE.

To continue, click Mext. To exit the wizard, click Cancel,

< Back. { I Cancel I

Step 3: Select an existing deploy-config file to automatically use the configuration previously
used for the deployment wizard.

Figure 11.26: Select the configuration file

ﬁ.&ppeun Application Undeployrment

Select an Existing Deploy-config File

Pleaze zelect an exizting deploy-config file far

The wizard automatically loads the configuration file for the curent package and uses the settingz
in thiz file az the default settings for the subzequent stepz. You can modify the settings in thiz file or
zelect another canfiguration file.

Mate: “ou can clear the configuration file path in the Dezstination File box and click Mest to
configure the zettings manually.

Destination File

o ppeon W ebtppPackagehappeon code examples installhiniconfio.sm

< Back ][ Mest » J [ Cancel

Appeon Developer User Guide Page 146



Packaging Applications Appeon for PowerBuilder 2013

Step 4: Specify the Application URL.

Figure 11.27: Specify Application URL

ﬁ Sppeon Spplication Undeployrment

Specify Undeployment Settings

Fleaze input the undeployment zettings.

Pleasze specify the URL for the application to undeplay.

Application Prafile Warme: appeon_cade_examples

Application LRL

hittp: A fvaeh server: port) sl e s =R e =

[ < Back ][ Hest » J [ Cancel ]

Step 5: Select the Appeon Server(s) and Web server(s) where application will be undeployed.

To create the Appeon Server profile and Web server profile, refer to Section 4.2.3
“Managing server profiles’.

Appeon Developer User Guide

Page 147



Packaging Applications Appeon for PowerBuilder 2013

Figure 11.28: Specify server settings

‘ﬁ Sppean Spplication Undeployrment

Server Settings

Fleaze zelect the Appeon Server and the

Appeon Servers

N
[ Edt. |

Selected  Profile Mame Server Type Edit...
[ [192.0.1.56 EAServer

Add...

4 1 | » Delete

YWeb Servers
Selected  Profile Mame Edit...
[+ 192.0.1.56_EAServer

&dd

Delete

il

[ < Back ]E Mest » ] [ Cancel

Step 6: Select whether to undeploy EAServer components.

Figure 11.29: Undeploy EAServer components

ﬁ Appeon Application Undeployment ﬁ

EAServer Settings

Flease select whether to undeploy EAServe :

Pleaze select whether to undeploy EAServer companents. To undeploy components, please
gpecify the EAS erver configuration zettings.
Mate: if the EAServer Compaonents option iz not selected, the step far selecting MY0 components
will be zkipped.
[TlEAServer Components
Prafile Mare Server Mame Part Mumber Lagin Edit..
Add..
Delete
<Back | Ned> | | Cancel
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Select the EAServer Components option and then create connection profiles for EAServers
where you want to undeploy the components. Follow instructions below to create EA Server
profiles:

» Click Add to open the EAServer Connection dialog box.

* Input the connection parameters: profile name, host name or I1P address, port number, user
name and password.

» Click Test to verify the connection and the click OK to finish the creation.

Figure 11.30: Edit EAServer profile

-

i) Edit EAServer Profile (3]

Profile Mame: |
Server Mame:

Part Humber:

Login Marme:

Pazsword:

Mote: Input the real IP addresz in the Server Hame field. For example,
192.0.01.

| Test | [ k. ]| Cancel |

Step 7: If the EAServer Components option is selected in the previous step, select the
EAServer profile from the list and the components to undeploy. Click Next to proceed.
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Figure 11.31: Select EAServer components

‘ﬁ.&ppeun Spplication Undeployment

EAServer Components

Fleaze select which EAServer components

Pleaze zelect which EAServer components will be undeploved from EAS erver.

EaServer List:

#-[]J4§ Component List

[ < Back ][ Hest » J [ Cancel

Step 8: Wait while the wizard is removing files and settings.

Step 9: Once the operation is complete, click Finish to exit the undeployment wizard.

To view the log information generated during the uninstall process, select the View L og box

and then click Finish. Thelog file will be displayed.
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Figure 11.32: Undeployment complete

ﬁ.ﬂ.ppenn Spplication Undeployment ==

Finizhed undeploying the Appeon application.

The undeplopment wizard has finizhed removing the application
and the related settings from the computer.

.......................

Click. Finigh bo exit the wizard.

< Back Cancel

11.2 Packaging a native mobile project

11.2.1 Points to check before packaging

Apple follows some guidelines to review the app before it approves and posts the app to
the iOS App Store. To get the app approved, you may need to carefully read the App Store
Review Guidelines and verify the app isin compliance with these guidelines.

The following lists the most common areas and reasons we have found so far that will cause
the app to be rejected by Apple.

1. Check that if your app includes Ul controls for quitting the app. For example, a button
labeling "Quit", "Exit", etc. Y ou'd better remove any mechanism for quitting the app, as
thisis not in compliance with the iOS Human Interface Guidelines, as required by the App
Store Review Guidelines.

2. Check that if you app appearsto be for demonstration or trial purposes only. For example,
"demo", "tria", "test” or "beta" is displayed on the app Ul, app description or release
notes. Y ou'd better remove any these references and complete or fully configure any
partially implemented features.

11.2.2 Packaging instructions

To package an Xcode project for native mobile apps to be distributed on iOS, follow steps
below:
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Step 1: Click the Package (&) button on the Appeon Developer toolbar to open the Appeon
Application Package Wizard.

Step 2: Select or create a profile from the dropdown list box and click Next to proceed.

A profileisa configuration file containing the settings that you specify when packaging the
application. You can select an existing profile or create one by entering a name in the text
field. The profile will be automatically saved and listed for selection next time when you
launch the Appeon Application Package Wizard again.

Figure 11.33: Welcome page

3] Appeon Application Package Wizard @

Welcome to the Appeon Application Package
Welcome Wizard

B Select Package Type

B Select Application Please select an exrizting profile or create a new one.
B Select Appeon Server

B Configure EAServer Profile

B Select NVOs

B Select AEM Settings

B Specify Destination Folder
B Packaging Process

N Finish

< Back [ Mewt » ][ Cancel Firiizh

Step 3: Select the Package a Native M abile Project radio button.

To package a deployment project that can install the application to servers, follow detailed
instructions in Packaging a deployment project.

To customize Appeon Workspace and then package Appeon Workspace to an Xcode project,
follow detailed instructions in Customizing and packaging Appeon Workspace.
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Figure 11.34: Select packagetype

-

3] Appeon Application Package Wizard @

Pl Flease select a package type.

Select Package Type
(") Package a Deployment Project

B Select Application

@ Package a Native Mobile Project

B Configure App Settings (7 Customize and Package Appeon Work space

B Specify Destination Folder

B Packaging Process

N Finish

[ ¢ Back ][ MHest » J[ Cancel ] Einizh

Step 4: Select the profile of the application that you want to package and click Next.

Only applications that have been deployed will be listed here for selection. If the application
you intend to package is not listed here, you would need to deploy the target application
using the Appeon Deployment Wizard first (See Chapter 6, Deploying PowerBuilder

Applications).
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Figure 11.35: Select app to be packaged

-

3] Appeon Application Package Wizard @

Please select an application to package. Only
application that have been deployed will be listed
Welcome below for selection.

Select Package Type Selected App Mame Fode Device Tupe
Select Application @ ack Debugls  Both

B Configure App Settings

B Specify Destination Folder

B Packaging Process

N Finish

[ ¢ Back ][ MHext = ][ Cancel Einizh

The following table gives a brief introduction of the columns:

Table 11.2: Application Package Wizard

Column Description

Selected Identical to the default application profile selected in the Appeon Developer
Configuration window.

Profile Name | Identical to the application profiles configured in the Appeon Developer
Configuration window.

Mode Identical to the current mode the application profileis set to in the Appeon
Developer Configuration window.

It is recommended that the packaged applications should be available in
Release mode, as this mode prevents most forms of reverse engineering, and
like application packaging, it protects the author's intellectual property.

Device Type |ldentical to the current device type settingsin the Appeon Developer
Configuration window.

Step 5: Specify the parameters for the app and then click Next.
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Figure 11.36: Configure app parameters

"

H Appecn Application Package Wizard

Please specify the app settings.
Welcome

Mame Value

S Gerers

- Titlebar icons

Select Package Type

Select Application 5
P [+- Xcode
- 108
Configure App Seftings
B Specify Destination Folder
B Packaging Process - =

B Finish

¢ Back |[ Mewt » ]| Caniel

See the following table for details on each parameter.

Table 11.3: App parameters
Group Value Description

Genera | App Name (*) Specify the name of your app that will appear on the
App Store. For the name to display completely, it should
be about 12 letters but it depends on the width of each
individual letter, for example, w takes more room than i.

The App Name will also be used as name of the
generated package.

App Description Provide the description of your app that will appear in
the screen under 10S Settings -> App Name after the app
isinstalled on the iOS-based device.
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Group Value Description
App URL (*) Specify the app URL. The URL supports both HTTP
and HTTPs formats, for example, https://192.0.0.201/
sales. The URL can be changed in the screen under iOS
Settings -> App Name after the app isinstalled on the
i0S-based device.
Startup Orientation | Set the initial interface orientation when the app starts.
SSL Verify Peer Enable or disable the SSL peer verification.
SSL Verify Host Enable or disable the SSL hostname verification.
Connection Timeout | Specify the timeout seconds for your app connecting to
(seconds) the server.
Record Logs Option to record app logs.
Titlebar | Full Screen by Set whether to display your app in full screen by default.
Icon Default
Xcode App Mgor Version | Specify the version number for your app.
App Build No. Specify the build number for your app.
I0S iPhone App Icon Specify the app icon for the standard display on iPhone
(Standard Display) (57 x 57 pixels).
iPhone App Icon Specify the app icon for the retina display on iPhone
(Retina Display) (114 x 114 pixels).
iPhone Launch Image | Specify the launch image for the standard display on
(Standard Display) iPhone (320 x 480 pixels).

iPhone Launch Image
(Retina Display)

Specify the launch image for the retina display on iPhone
(640 x 960 pixels).

iPhone 5 Launch
Image

Specify the launch image for the retina display on iPhone
5 (640 x 1136 pixels).

iPad App Icon Specify the app icon for the standard display on iPad (72
(Standard Display) | x 72 pixels).
iPad App Icon Specify the app icon for the retina display on iPad (144 x
(Retina Display) 144 pixels).

iPad Launch Image
(Standard Display in
L andscape)

Specify the launch image for the standard display in
landscape on iPad (768 x 1004 pixels).

iPad Launch Image
(Standard Display in
Portrait)

Specify the launch image for the standard display in
portrait on iPad (1024 x 768 pixels).

iPad Launch Image
(Retina Display in
Landscape)

Specify the launch image for the retinadisplay in
landscape on iPad (1536 x 2008 pixels).
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Value Description

iPad Launch Image | Specify the launch image for the retina display in portrait
(Retina Display in on iPad (2048 x 1496 pixels).
Portrait)

Step 6: Specify the storage location for the package and click Next.

The generated package will be stored under afolder named "App Name_install” under the
specified location.

Figure 11.37: Specify directory

-

H Appeon Application Package Wizard @

The package tool will create a folder named "App

Name_install® to store the packaged application.
Welcome

Select Package Type
App Mame: zales

Select Application

Specify the directory where the install folder will rezide:

. C:4Program Filesh4ppeontappPackage® B
Configure App Settings [OWEE

Specify Destination Folder

B Packaging Process

W Finish

[ ¢ Back ][ Mext = ][ Cancel ] Einizh

Step 7: Wait until the package process is complete. Click Next when the package processis
complete.
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Figure 11.38: Package process

3] Appecn Application Package Wizard

Welcome
Select Package Type
Select Application

Configure App Seftings

Speciy Destination Folder

Packaging Process

B Finish

Flease wait while the packaging tool performs the
requested operation. This may take several
minutes.

Time Fun Information

<Back HNext > Finish

Step 8: Click Finish.
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Figure 11.39: Package complete

IH Appeon Application Package Wizard @

Finished packaging the application.

Welcome

Sefect Package Type [V]iewm Package Lu:ué

Select Application

The package wizard has finizhed packaging the application.

Configure App Settings Click Firizh to exit the wizard,

Specify Destination Folder To compile the package into an IPA file and
distribute it to others. please follow instructions in

Packaging Frocess ] . . .
Tutorial 4: Package Distribute Mative Mobile Apps.

Finish

Step 9: Go to the folder "App Name_install" under the specified location, you will find the
following two zip files. Copy them to the Mac machine.

» App Name.zip: the application file package
» AppeonMobile.framework.zip: the mobile client libraries

Then follow the instructions in Package & Distribute Native M obile Appsin Appeon
Mobile Tutorials to compile them into an I PA file.

11.3 Customizing and packaging Appeon Workspace

To customize Appeon Workspace and package it as an X code project, follow steps below:

Step 1: Click the Package (&) button on the Appeon Developer toolbar to open the Appeon
Application Package Wizard.

Step 2: Select or create a profile from the dropdown list box and click Next to proceed.

A profileisa configuration file containing the settings that you specify when packaging the
application. You can select an existing profile or create one by entering a name in the text
field. The profile will be automatically saved and listed for selection next time when you
launch the Appeon Application Package Wizard again.
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Figure 11.40: Welcome page

-

3] Appecn Application Package Wizard @

Welcome to the Appeon Application Package
Welcome Wizard

Select Package Type

Select Application Pleasze select an existing profile or create a new ane,
Select Appeon Server

Configure EAServer Profile

Select NVOs

Select AEM Settings

Specify Destination Folder

B Packaging Process

B Finish

¢ Back [ MHewt = ][ Cancel ] Einizh

Step 3: Select the Customize and Package Appeon Wor kspace radio button and click Next.

To package a deployment project that can install the app to servers, follow detailed
instructions in Packaging a deployment project.

To package an Xcode project for a native mobile app, follow detailed instructions in
Packaging a native mobile project.
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Figure 11.41: Select packagetype

] Appeon Application Package Wizard

Pl Flease select a package type.

Select Package Type

(") Package a Deployment Project

Configure Appeon Workspace )
() Package a Mative Mobile Project

Select Application (@ Customize and Package Appeon YWork space

Specify Destination Folder

B Packaging Proces

N Finish

[ ¢ Back “ MHest » ][ Cancel ] Einizh

Step 4: Customize Appeon Workspace according to your needs and then click Next.
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Figure 11.42: Workspace parameters

3] Appeon Application Package Wizard @

Flease customize the following Appeon
Welcome Workspace settings to suit your needs.

Mame Walue

- B

-- Application

Select Package Type

Configure Appeon Workspace :
g £ P [+- Language

-- Xcode
B Select Application - 05
B Specify Destination Folder
B Packaging Process ‘ 1 r

N Finish

[ < Back ][ Mewt = ][ Cancel Einizh

See the following table for details.

Table 11.4: Workspace settings
Group Parameter Description

General | Display Name (*) Specify the name of your workspace that will appear in
App Store. For the name to display completely, it should
be about 12 letters but it depends on the width of each
individual letter, for example, w takes more room thanii.

The Display Name will also be used as name of the

generated package.
Workspace Banner | Whether to display the Workspace Banner in your
workspace.
Workspace Banner | Specify the URL to your own banner. The default page
Package of your own banner must be "index.html", and the URL

must point to "index.html".

Refer to Replacing the Workspace Banner [164] for

details.
SSL Verify Peer Enable or disable the SSL peer verification.
SSL Verify Host Enable or disable the SSL hostname V erification.
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Group

Parameter

Connection Timeout
(seconds)

Description

Specify the timeout seconds for your app connecting to
the server.

Record Logs

Option to record app logs.

Help Path

Specify the path of your help file. The startup page of
your help must be index.html.

ApplicationEnable Edit App

Enable or disable the Add App and Delete App
functions.

Default App Specify the default app. The deployed apps are listed.
Full Screen by Whether to display the app in full screen by default when
Default it is opened.

L anguage

Default Language

Select the languages to package and specify the default
language of your workspace Ul. The workspace Ul can
be displayed in English, French, Simplified Chinese,
Traditional Chinese, Japanese, Korean, Italian, and
Spanish. Y ou can select to package which languages.

To display the workspace Ul in other languages, refer
to Adding and customizing Ul languages [164] for
details.

Xcode

App Mgor Version

The version number of your workspace.

App Build Version

The build number of your workspace.

10S

iPhone App Icon
(Standard Display)

Specify the app icon for the standard display on iPhone
(57 x 57 pixels).

iPhone App Icon
(Retina Display)

Specify the app icon for the retina display on iPhone
(114 x 114 pixels).

iPhone Launch Image
(Standard Display)

Specify the launch image for the standard display on
iPhone (320 x 480 pixels).

iPhone Launch Image
(Retina Display)

Specify the launch image for the retina display on iPhone
(640 x 960 pixels).

iPhone 5 Launch
Image

Specify the launch image for the retina display on iPhone
5 (640 x 1136 pixels).

iPad App Icon Specify the app icon for the standard display on iPad (72
(Standard Display) | x 72 pixels).
iPad App Icon Specify the app icon for the retina display on iPad (144 x
(Retina Display) 144 pixels).

iPad Launch Image
(Standard Display in
L andscape)

Specify the launch image for the standard display in
landscape on iPad (768 x 1004 pixels).

iPad Launch Image
(Standard Display in
Portrait)

Specify the launch image for the standard display in
portrait on iPad (1024 x 768 pixels).

Appeon Developer User Guide

Page 163



Packaging Applications Appeon for PowerBuilder 2013

Group Parameter Description

iPad Launch Image | Specify the launch image for the retina display in
(Retina Display in landscape on iPad (1536 x 2008 pixels).
Landscape)
iPad Launch Image | Specify the launch image for the retina display in portrait
(Retina Display in on iPad (2048 x 1496 pixels).

Portrait)

Replacing the Workspace Banner:

The banner in the Appeon Workspaceisan HTML Web app. Y ou can design your own
workspace banner and replace the Appeon Workspace Banner.

* Replace the banner: Click the Workspace Banner to select your own HTML Web app.
Make sure that the app contains an index.html file under the root directory of the app. The
index.html file is the default file that the Workspace Banner loads.

» Banner size: the height is 248 pixels for iPad (including iPad 2, 3, 4, and mini), and 124
pixels for iPhone (including iPhone 4, 4S and 5); the width is subject to the device (usually
the same width as the device screen). For iPad 2, 3, 4, and mini, the width in Portrait view
is 768 pixels, and the width in Landscape view is 1024 pixels. For iPhone 4, 4S and 5, the
width in Portrait view is 320 pixels, and the width in Landscape view for iPhone 4/4Sis
480, and for iPhone 5 is 568 pixels.

e |Important Notes:

1) Keep the banner height as 248 pixels for iPad, and 124 pixels for iPhone; and the width
same as the device screen.

2) There are different widths for portrait and for landscape on a device if your workspace
supports both orientations.

3) Pay attention to the compatibilities of the related JavaScript.

Adding and customizing Ul language packages:

The workspace Ul can be displayed in English, French, Simplified Chinese, Traditional
Chinese, Japanese, Korean, Italian, and Spanish. To add the other language packages to
Appeon Workspace:

1. Navigateto ...\Appeon\Developer2013\AppTemplate\i OS\A ppeonW S.bundle\config\Aws
\ under the Appeon Developer installation directory, and open the languages.xml filein a
text editor and uncomment the line of script that corresponds to the language you want to
add. It isrecommended that you back up thisfile before modifying it.

For example, to add the support for German, find the corresponding line of script (or add it
if it isnot pre-defined), and then remove the comment as shown below:

<l ang code="de" nanme="Deutsch" c="##"/>

The value of code must be used as the name of the language file in the next step. The
value of name will be displayed in the L anguage tool of Appeon Workspace.
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2. Make acopy of an existing language file under ...\Appeon\Devel oper2013\AppTemplate
\iOS\A ppeonW S.bundle\config\Aws\lang, put the copy under the same directory, and
name the copy after the value of code. Take German for example, the language file must
be named as de.xml. Then open the file, and trand ate the content into the language you
want to add.

3. Inthe Packagetool, click the button in the Default L anguage field. The language you

added will be displayed for selection. Make sure the Selected check box of the language is
checked.

Figure 11.43: Language

3] Appecn Application Package Wizard 23

Please customize the following Appeon

Welcome e = e needs.
- Yalue
Select Package Ty REEE=C IR e Language
@ English
. : Espariol
Configure Appeon
g AP Frangais
ttaliano en
B Select Application BE:E
ey
[oijE b
e ctinati
pecify Destination | gramh o
B Packaging Process b
| ok | | Cancel
B Finish

[ < Back ][ Mext = ][ Cancel ] Finizh

In addition, you can customize the Ul text by editing the language file under ..\Appeon
\Developer2013\A ppTemplate\i OS\A ppeonW S.bundle\config\Aws\lang. For example,

you can open en.xml and change the text (id="1") from "Appeon Workspace" to "ABC
Workspace", so "ABC Workspace" will display in the center of workspace titlebar instead of
"Appeon Workspace".

Step 5 (Optional): Select the apps you want to package into the workspace and specify the
corresponding URLSs. The apps deployed in Appeon Developer are listed by default, and
multiple apps can be selected.
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Figure 11.44: Select appsto be packaged with your Workspace

3] Appecn Application Package Wizard
Please select the application(s) to package.
Only applications that have been deployed
Welcome will be listed below for selection.
Select Package Type Selected &pp Mame URL
i sales
Configure Appeon Workspace 0 codeexamples
O ack
O zapteched
Select Application F arder
B Specify Destination Folder
B Packaging Process
B Finish
[ ¢ Back ][ Mext = ] [ Cancel ] Einizh

Step 6: Specify the storage location for the generated package and click Next.

The generated package will be stored under afolder named "Display Name install” under the

specified location.
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Figure 11.45: Specify the directory

] Appecn Application Package Wizard

The package tool will create a folder named
"Display Name_install® to store the packaged
Welcome application.

Select Package Type

Dizplay Mame: zales

Configure Appeon Workspace Specify the directory where the inzstall folder will reside;

C:\Program Files\&ppeontappPackage, B
Select Application [owise

Speciy Destination Folder

B Packaging Process

B Finish

[ ¢ Back ][ MHewt = ][ Cancel ] Einizh

Step 7: Wait until the package process is complete. Click Next when the package processis
complete.
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Figure 11.46: Packaging process

] Appecn Application Package Wizard

Flease wait while the packaging tool performs the
requested operation. This may take several
Wefcome minutes.

Select Package Type Time Fun Information

Configure Appeon Workspace

Select Application

Speciy Destination Folder

Packaging Process

B Finish

Step 8: Click Finish.
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Figure 11.47: Package complete

H Appeon Application Package Wizard @

-

Finished packaging the application.

Welcome

Select Fackage Type [¥]3iew Package Log

Configure Appeon Workspace

The package wizard hasz finished packaging the application.

Select Application Click Firish to exit the wizard.

Specity Destination Folder To compile the package into an IPA file and
distribute it to others, please follow instructions in

Packaging Process ] o ] ]
- Tutonal 4: Package Distribute Hative Mobile Apps.

Firish

Step 9: Go to the folder "Display Name _install” under the specified location, you will find the
following two zip files. Copy them to the Mac machine.

» Display Name.zip: the zip package of the workspace
» AppeonMobile.framework.zip: the mobile client library

Then follow the instructions in Package & Distribute Native M obile Appsin Appeon
Mobile Tutorials to compile them into an I PA file.
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12 Undeploying Appeon Applications

The Application Undeployment Wizard removes a deployed application from the associated
Appeon Server(s) and Web Server(s), including al Datawindows from the Appeon Server(s),
al the Web or mobile application files from the Web Server(s), and all the Transaction
Object mappings from AEM. Thisisthe only way that an Appeon deployed application
should be removed. Any other method may not fully remove the application, and may cause
errors.

12.1 Undeploying instructions

Step 1: Verify that the Appeon Server and the Web Server(s) hosting the Appeon application
to be undeployed are running before you proceed with undeployment.

Step 2: Click the Undeploy button (%) in the Appeon Developer toolbar. The Application
Undeployment Wizard is displayed, as shown in the following figure.

Figure 12.1: Application Undeployment Wizard

= Application Undeploytnent Wizard @

Thiz wizard helps you undeploy an application from an Appeon Server.

Click Meuxt to proceed.

< Back et = |[ Cancel ]

Step 3: Click Next to continue. The Specify Undeployment M ode window is displayed, as
shown in the following figure, prompting you to select an undeployment mode.
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Figure 12.2: Specify Undeployment M ode window

b Application Undeployrment Wizard @
Specify Undeployment Mode

Y'ou can undeploy an application deployed using a specific deployment
profile by choozing Deployment Profile mode. |f vou are unsure of the
application name, uze Appeon Server mode ta lizt all applications
deployed to a specific Appeon Semver.

|Indeployrment tode;

@ Deplayment Profile

Err P Ot e

() Appeon Server

[ < Back ][ Mest » ][ Cancel

The following table shows when and how to use each mode.

Table 12.1: Undeployment modes

When To Use It How ToUselt

Deployment | If you clearly know which Select an application to be undeployed and
Profile mode | application you want to delete its associated deployment profile.

from which server. For detailed instructions, refer to

Section 12.1.1, “Undeploying with the
Deployment Profile mode”.

Appeon When you are uncertain of Specify an Appeon Server by selecting
Server mode | the name of the application an Appeon Server profile. The selected
you want to undeploy, or an Appeon Server will refer to all the Web
application profile does not exist | or mobile applications that are deployed.
for the application you want Then you can choose one Web or mobile
to undeploy, but you clearly application for undeployment.

know the Appeon Server hosting For detailed instructions, refer to

.thte V\ézg ‘f’r mozi'elapp' ica:ion Section 12.1.2, * Undeploying with the
inten orun ep Oymen ! ADDeon Server mOde”.

12.1.1 Undeploying with the Deployment Profile mode

Step 1: Select the Deployment Profile radio button in the Specify Undeployment M ode
window, and click Next to continue.
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Step 2: Select aWeb or mobile application from the Application list box, as shown in the
following figure.

The Application list box lists all the application profile names. Be sure to choose one that has
been deployed and is intended for undeployment. The application and the deployment profile
used in the last deployment will be selected by default.

Step 3: Select the deployment profile that is used to deploy the Web or mobile application
from the Deployment Profile list box, as shown in the following figure. Click Next to
continue.

Figure 12.3: Deployment Profile M ode window

¥ Application Undeployment Wizard (3w

Deployment Profile Mode

To undeploy an application from the servers, select the Application that
wou want to undeploy and the Deployment Profile containing the zervers
where the application haz been deploped.

|Indeplay a Specified Application

gpplicatinn: :E:EI'EEE!_EIFIFI“I::EIHI:IFI_IjEFI'II:I

Deplopment Profile: |L|:u:a| D eployment | - |

[ < Back ][ MHewt > ][ Cancel ]

Step 4: Select the Appeon Server(s) or Web Server(s) that are intended for undeployment,
as shown in the following figure. The Appeon Server(s) and Web Server(s) defined in the
deployment profile selected in the previous step are listed. Click Next to continue.
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Figure 12.4: Confirm Appeon Serversand Web Servers

¥ Application Undeployment Wizard

Confirm Appeon Servers and Web Servers

Application: zales_application_dema

Canfirm Appeon Server for Undeployment

Undeploy  Appeon Server

¥ Lozal Appeon Server
7]

' i | b

Canfirm \eb Server for Undeploprent

Undeploy  'Web Server
[l Local 'Web Server

' il | b

[ < Back ][ Hest = ][ Cancel ]

Step 5: Click Undeploy to confirm the undeployment settings and start the undeployment
process, as shown in the following figure.

Figure 12.5: Confirm undeployment settings
¥ Application Undeployment \Wizard

Ready to Undeploy Application

Click Undeploy to begin undeploving the application. [F you want to
review ar change any settings, click Back.

Current Sethings:

Undeplopment Mode: : |3
kD eployrnent Prafile
w0 eployment Prafile
b pplication:
zales_application_demo
LD eployrnent Profile:
Local Deployrment
Appeon Servers and ‘Web Servers
Appeon Server _
PR | ﬂ

Local Aooeon S erver
Q| 1 | »

[ ¢ Back ][ Undeploy ] [ Cancel ]

The undeployment process begins, as shown in the following figure.
Step 6: Click Finish to close the dialog box.
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Figure 12.6: Undeployment in Progress

x Spplication Undeployrment Wizard

Undeployment Status Information

Undeployrent Status

Time  Run Information
16:55:09  Undeploying application from Appeon Server...
16:55:09  Connecting to Appean Server: localhost
16:55:10  Deleting application files from Appeon Server,
16:55:11  Deleted application filez from Appeon Server succ
16:5%:11  Connecting to 'W'eb serverLocal ‘Web Server
16:55:11  Deleting application files from ‘Web server.
16:55:11  Deleted application files from Web server success

SCECESICECICEC)

ey

1} [ 3

100%
¢ Back, Cancel

12.1.2 Undeploying with the Appeon Server mode

Step 1: Select the Appeon Server radio button in the Specify Undeployment M ode window
as shown in the following figure, and click Next to continue.

Figure 12.7: Specify Undeployment M ode window

> Application Undeployment \Wizard
Specify Undeployment Mode

You can undeploy an application deployed uzing a zpecific deployment
profile by choosing Deplovment Prafile mode. IF pou are unsure of the
application name, uze Appeon Server mode to list all applications
deploved to a specific Appeon Server.

IIndeployment kode:

") Deployment Profile

¢ Back ][ Mewt > J[ Canicel
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Step 2: Select the Appeon Server that contains the Web or mobile application to be
undeployed from the Appeon Server list box, as shown in the following figure.

The Appeon Server list box lists al the Appeon Server profile names. Make sure the selected
Appeon Server is running.

Step 3: Select the application to be undeployed from the Application list box and click Next,
as shown in the following figure.

The Application list box lists al the Web or mobile applications deployed to the selected
Appeon Server.

Figure 12.8: Appeon Server Mode window

= Application Undeployrent Wizard @I
Deployment Profile Mode
To undeplay the specified application from an Appeon Server, select

the Appeon Server that pour application iz deployed to and the
application you want to undeploy.

Application: | pet_warld | = |

[ < Back ][ Mest » ][ Cancel ]

Step 4: Select the Appeon Server(s) or Web Server(s) that are intended for undeployment,
as shown in the following figure. The Appeon Server(s) and Web Server(s) defined in the
default deployment profile are listed. Click Next to continue.
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Figure 12.9: Ready to Undeploy Application window

¥ Application Undeployrment \iizard

Confirm Appeon Servers and Web Servers

Application;

Confirm Appeon Server for Undeployment
Undeploy  Appeon Server
Local Appecn Server

' 1 | P

Confirm %'eb Server for Undeployment

Indeploy  ‘web Server
Local Web Server

' m | b

[ < Back ][ Mest » ][ Cancel ]

Step 5: Click Undeploy to confirm the undeployment settings and start the undeployment
process, as shown in the following figure.

Figure 12.10: Undeployment settings

¥ Application Undeployment \Wizard

Ready to Undeploy Application

Click Undeploy to begin undeploying the application. IF you want bo
review or change any settings, click Back.

Current Settings:

Undeployrnent Mode: :
fhppeon Server
tdAppean Serer
Alppeon Server
Local Appeon Server
Appltacation:
pet_warld
Appeon Servers and Web Servers
Appeon Server

Local Aooeon Server h
4| 1 | »

| »

m

[ ¢ Back ][ Undeploy ] [ Cancel ]

The undeployment process begins, as shown in the following figure.
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Figure 12.11: Appeon Application Undeployment

= Application Undeploytnent Wizard

Undeployment Status Information

Undeployment Status

L i e e

Time
16:58:26
16:58:26
16:58:26
16:58:26
16:58:26
16:58:26
16:58:26

UL

Run Infarmation

|Indeploying application from Appeon Server...
Connecting to Appeon Server: localhost

Deleting application files fram Appeon Server.
Deleted application files from Appeon Server succ
Connecting to ‘web server:Local \web Server
Deleting application files from 'Web serer.
Deleted application files from ‘wWeb server success

1002

< Back Cancel

Step 6: Click Finish to close the dialog box, as shown in the above figure.
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13 Developing with Code Insight

Code Insight is atool designed to help you write Appeon-supported PowerScript code more
quickly by providing alookup and paste service inside the PowerBuilder Script view. You
can use it to develop PowerBuilder applications that are free of Appeon unsupported features
and tailored to Web or mobile migration.

The usage of Code Insight is similar to that of PowerBuilder AutoScript. The following table
describes the differences between the PowerBuilder AutoScript and Appeon Code Insight.

Table 13.1: Comparison between AutoScript and Code Insight

Power Builder AutoScript Appeon Code I nsight

Effective | Functions, events, variables, properties, and Itemsreferred in dot
for templates for PowerBuilder DO, FOR, IF, and notations
CHOOQSE statements.

What pops| A list of properties, variables, methods, or 1) A list of properties,

up statements. variables, or methods.
2) The Appeon unsupported
properties, variables or
methods that are marked
with ared icon left to them.

Waysto | Two ways to use AutoScript: Only one way to use Code

useit Insight:

» Turn automatic popup on to pop up alist

automatically when you pause while typing, or | XeP 1: Activate Code

Insight;
* Invoke AutoScript only once when you need it | Step 2: Configure the

by selecting the menu items. default PBT file;
Step 3: Enable Code
Insight.

Refer to the following
sections for detailed
instructions.

Priority | When Code Insight is activated, AutoScript will be automatically turned off.

13.1 Activating Code Insight

Click the Code I nsight button ( in the Appeon Developer toolbar to launch Code Insight.
At the click of the Code Insight button, an icon will appear in the status area of the task bar.
Code Insight has five status icons:

Table 13.2: Status of Code Insight

Icon Status Description

Disabled | Code Insight is disabled.

3 |Loading | Code Insight isanalyzing the default PBT and generating the supported and
unsupported feature list based on the analysis result.
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Icon Status Description
@ |Off Code Insight is enabled but ineffective.

@ |On Code Insight is enabled and effective in the current application.

() |Gray Thisicon appears anytime the PowerBuilder IDE losesfocus, even if Code
Insight is disabled.

13.1.1 Configuring Code Insight

Before you can enable Code Insight for a PowerBuilder application, you need to configure
the PBT file of the desired application as the default PBT file. Y ou can also specify the
Appeon feature sets and the feature types for which feature list will be displayed.

Step 1: Click on theicon of Code Insight, and the status-area-icon menu pops up with three
items. Enable (or Disable), Config, and Quit, as shown in the following figure.

Figure 13.1: The status-ar ea-icon menu

Enahle

Config
Selected Ll

—“ Quit I
Step 2: Click Config to open the Code I nsight Configuration window, as shown in the

following figure.

Figure 13.2: Code Insight Configuration window - PBT Filestab
Code Insight Configuration ==

FET Files | System

Add the PBT files ta the list:

PET File Mame FET File Path
sales_application_demo  C:\Program Filesh\appeontDevelopert. 2happe:

Pl 11 I

sdd || Delete

(] ] I Cancel

Appeon Developer User Guide Page 179



Developing with Code Insight

Appeon for PowerBuilder 2013

Figure 13.3: Code Insight Configuration window - System tab

Code Insight Configuration

At List
| Funchions | Controls
| Events | Wariables

Feature Type

@ Both Types Supparted

[
| Properties
Unsupported
s ] | Cancel |

The Code Insight Configuration window contains two tab pages where you can manage the
PBT files and specify what displaysin thelist.

Table 13.3: Code Insight Configuration window

Select this | Todothis
tab

PBT File |AddthePBT files.
tab page

Detailed Steps

1. Click Add.

2. Search and select the PBT filein the common
dialog box.

3. Click Open in the common dialog box.

4. Click OK.

Delete the PBT files.

1. Select the PBT file you want to delete.
2. Click Delete to delete the selected PBT file.
3. Click OK.

NOTE: The default PBT file cannot be deleted.

Set the default PBT file.

1. Select the check box in front of a PBT file.

2. Click OK.
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Select this Todothis

tab

Detailed Steps

NOTE: 1) only one PBT file can be set to the
default PBT.

2) Code Insight can only be effective to the default
PBT.

page

System tab | Specify what to display

inthelist.

1. Inthe Auto List group box, opt to automatically
display functions, events, properties, controls
and/or variablesin the list.

2. Inthe Application Type group box, opt to
display only the unsupported features and/or the
supported features for Web applications or/and
Mobile applications.

3. Inthe Feature Type group box, opt to display
only the unsupported features and/or the
supported featuresin the list.

4. Click OK.

13.1.2 Enabling Code Insight

After you complete the configuration, you can enable Code Insight and use it to develop the
PowerBuilder application.

Click on theicon of Code Insight and select Enable from the status-area-icon menu, as
shown in the following figure.

Figure 13.4: Enable Code I nsight

ielected

Enable
Config
Quit [

L

The Code Insight icon appears in one of the following statuses:

Table 13.4: Enable Code I nsight
Status Detailed Steps

Code Insight remains disabled.
This happens when the PBT Filelist in the Code Insight Configuration window is
empty. Make sure you have added the PBT fileto thelist.

@ Code Insight is enabled but ineffective in the current application. To make it

effective, make sure you have

1. Configured the PBT file of the current application as the default PBT filein the
Code Insight Configuration window.
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Status Detailed Steps

2. Opened an object of the current application in a painter (not in the Source editor)
by double-clicking it in the Workspace or selecting Edit from the popup menu.

After taking the above steps, Code Insight becomes effective (@).
D Code Insight is enabled and effective.

Y ou can develop an application with the assistance of Code Insight.

13.2 Coding with Code Insight

When Code Insight is enabled and effective (@) for an application, you can start editing the
objects of the application using Code Insight. For example, take the following stepsto add a
new control and use Code Insight to edit it:

Step 1: Add a button to the current object in the painter.
Step 2: Save the object by clicking the Save button on the PowerBar.

Note: Saving the object enables Code Insight to generate the supported and unsupported
feature list for the new content. Code Insight cannot detect the new content unless the object
is saved.

Step 3: Double click the button to open the Script view and pause for afew seconds after
typing an identifier followed by adot (for example, pause after This.).

If there is more than one property, variable, method, or statement that could be inserted, the
Code Insight feature list pops up for you to select a supported property, variable or method,
as shown in the following figure.

Figure 13.5: Develop an application with Code Insight

@ AppeonDemo - PonerBulder [== ==

File Edit View Insert Format Desion Run  Tools Window Help
ShcEHlEe o dPnal e aam eGP Btk H4 RGO @ Do |EE|x
B D@ ENEN X W @R

P | B | @ -  Arial ~12 -~ B U=
- | = w_logon * (seles_epplication_demo) (C:\Users\Public\ Documents\ AppeonDeveloper6 5 D Demosales_main.pbl} inherited from window - W...[-=-|[-=-|[=5]

L L
[ Script - apen for w_logen retums long O] x| [[o Properties - w_logon inherited from window ol x|
w_logon ¥ | open{) returns long [pbm_oper] - Q| General | seroll | Toolbar | Other

s #colsvulEle

EF activate()
{E3animationtime
[ heets( ]
{3 backeolor
E3border
S bringtotop
EBeb 1
EBeb_2

Elrenter
«

Layouthopen {Event ListyFunction ListyDedare Instance Variables, | Ixproperties {Control Liston-Visual Object List

Ready =0001:0006 Nothing Selected
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The unsupported properties, variables or methods in the popup list will haveared iconin
front, as shown in the following figure. Avoid using the unsupported features.

Figure 13.6: Appeon unsupported features displayed in popup window

0 Center ::.I
ClassDefinition
ClientEdge =i

ColumnsPerPage
ContexiHelp

-7 Control

1 ControlMenu

-1 Enabled

7 Height

e B [ B | | o =
| | 3

Step 4: Select a supported property, variable or method from the popup list.

Y ou can use Code Insight to help develop an application free of unsupported features and
suitable for migration.
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14 Launching Appeon Enterprise Manager

Appeon Enterprise Manager (AEM) is a Web-based application that manages the converted
Web or mobile applications and Appeon Server over the Internet, an intranet or an extranet.
It includes a comprehensive set of easy-to-use tools for system configuration, system
maintenance, performance optimization, and application security.

AEM isincluded when Appeon Server isinstalled.

AEM is accessible from any Client's Web browser or it is possible to access AEM through
the AEM button that resides on the Appeon Developer toolbar. Clicking the AEM button
will automatically open a Web browser window and load the AEM entry page.

14.1 Requirements
Before launching AEM, verify that:

1. The Appeon Server hosting AEM has been started.

2. You have correctly specified the host name and port of the Appeon Server in the Appeon
Server Profile Configuration page.

14.2 Launching Appeon Enterprise Manager

Step 1: Click the AEM button (‘) on the Appeon Developer toolbar.

If more than one Appeon Server profileis configured, the Select an AEM URL to run page
isdisplayed, as shown in the following figure. All Appeon Server profiles and corresponding
AEM URLsare listed. The Appeon Server configured as the default server is highlighted and
selected.

If only one Appeon Server profile is configured, the entry page of AEM is displayed.

Figure 14.1: Select an AEM URL torun

W Select an AEM URL to run @
Appeon Server Praofile Mame AER URL
192.0.1.56 http:/4192.0.1.56: 8080/ AE M

Local Appeon Server http: A dlocalhost: FOOT AAE M

Bur... ] l Lancel
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Step 2: Select an AEM URL and click Run, as shown in the following figure.

The entry page of AEM isloaded in an Internet Explorer page, as shown in the following
figure.

Figure 14.2: Appeon Enterprise Manager entry page

@ Appeon Enterprise Manager (AEM] - Windows Internet Explorer EI@
@@ = ‘@‘ http://localhost/AEM v| 2] |€,. ‘ b4 | | )C Bing ¥el v|

¢ Favorites (& Appeon Enterprise Manager (AEM) ﬁ - > 3 @A v Page~v Gafety~ Tools~w @' -

Welcome to use Appeon Enterprise Manager

User Name: admin

Password:

The AEM URL isautomatically entered into the Internet Explorer address bar when you click
the Run button. Y ou can configure AEM's URL and connection method (https or http) in the
Appeon Server Profile Configuration page.

The default username is admin and the default password is admin. The username and
password settings for AEM can be modified in Security settingsin AEM. Refer to Security in
the Appeon Server Configuration Guide for more information.
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15 Converting screen size between dots and
PBUs

The Size Calculator (frr) tool in the Appeon Developer toolbar is used to conveniently
convert the display size between dots and PBUs. Aswe al know, PowerBuilder uses
PowerBuilder units to measure the size while Appeon uses dots as the measurement unit,
which is the same with the popular mobile OS providers, such as Apple (i0S), Google
(Android), and Microsoft (Windows Phone). When you design the Ul in PowerBuilder,
you may want to know what the size would be in iOS, Android, or Windows Phone, or you
may already determine the sizein iOS, Android, or Windows Phone and want to know how
to design the size correspondingly in PowerBuilder. In either case, you can use the Size
Calculator tool to convert the size from PBU to Dot or from Dot to PBU.

Figure 15.1: Size Calculator

i~ |

rer' .
fre Size Calculator @

Dot

5 0 i 0

DR |96 Language: | English -
FE Lt

o | LA

DOT-»FEU | |  PBU-DOT

Dot isreferred as point in iOS (Both Point and Dot are used interchangeably in both Appeon
documentation and product Ul). For details, please refer to the Devel opment Guidelines for
Appeon Mobile.

To utilize the tool to convert the size, do the following:

rert
Step 1: Click the size calculator icon (F77) in the Appeon Developer toolbar.

Step 2: Input the size, then select alanguage, and then click one of the conversion buttons
according to your needs.

» The DPI standsfor Dot Per Inch. Thisisfixed (96) for simplicity.

» Language indicates the language of the operating system of the mobile device. Currently
only English and Japanese are supported.

For Dot to PBU:
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Input the size in the corresponding text boxes under the DOT group box, and then select a
preferred language from the L anguage dropdown list box.

On the click of the DOT to PBU ([ LOT - FEU ]) button, the results appear in the

corresponding text boxes under the PB Unit group box.
For PBU to Dot:

Input the size in the corresponding text boxes under the PB Unit group box, and then select a
preferred language from the L anguage dropdown list box.

On the click of the PBU to DOT ([ FBU > DOT ]) button, the results appear in the

corresponding text boxes under the DOT group box.
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16 Appeon for PowerBuilder Help

Appeon provides a comprehensive HTML help system that contains:
* Introduction to Appeon

* New Features Guide

» Appeon Mobile Tutorials

* |Installation Guide for Appeon Mobile

* Installation Guide for Appeon Web

* Installation Guide for Cloud Platform

» Development Guidelines for Appeon Mobile
» Migration Guidelines for Appeon Web

» Features Help for Appeon Mobile

» Features Help for Appeon Web

» Appeon Developer User Guide

» Workarounds & API Guide

» Appeon Workspace User Guide

» Appeon Server Configuration Guide for .NET
» Appeon Server Configuration Guide for J2EE
* Web Server Configuration Guide
 Troubleshooting

* Appeon Performance Tuning Guide

» Testing Appeon Web Applications with QTP

Appeon for PowerBuilder Help isin compiled HTML format, so that you can search by index
or by typing keywords, navigate back and forth, or print a specified page.

To access Appeon HTML Help:

Step 1: Click the Help button (@) in the Appeon Developer toolbar.

Step 2: Click the corresponding help book to access the detailed help information, as shown
in the following figure.
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Figure 16.1: Appeon for PowerBuilder Help
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17 Extended Toolkit

Appeon provides extended tools to ease your PowerBuilder-to-Web or PowerBuilder-to-
mobile process. These tools include:

» DLL/OCX Files Package Tool: It is designed as a solution for packaging and installing
large-sized DLL/OCX files.
Note: Thistool is effective for the Web application only.

» Appeon Silent Installer: Installs EAServer, Appeon Server, Appeon Server EBF
(Emergency Bug Fix), and Appeon Web applications in the silent mode.
Note: Thistool is effective for the Web application only.

» Appeon Developer Toolbar Register Tool: Enables you to register (or unregister) one

Appeon Developer version to more than one PowerBuilder version or different Appeon
Developer versionsto different PowerBuilder versions.

17.1 DLL/OCX Files Package Tool
Note: Thistool is effective for the Web application only.

DLL and OCX files are frequently used in PowerBuilder client/server application. Appeon
offers you two ways to distribute DLL/OCX files.

Table 17.1: Twowaysto distribute DLL/OCX files

When to use Which tool to use...

Deploy DLL/OCX filesto There are only afew DLL/ In the Additional Filestab

the server and then download | OCX files or thefiles are of the Application Profiles

them to the client at runtime. |small. Configuration window. Refer
to Deploy External Filesfor
details.

Package DLL/OCX files Therearemany DLL/OCX  |Usethe DLL/OCX file
and install them to the client |files or the files are large; and | packaging wizard. Refer to
before the applicationisrun |the client machineisfixed. |thefollowing sectionsfor
for thefirst time. detailed information.

17.1.1 Packaging DLL/OCX files

Step 1: Run the EonDLLOCX .exe file under the \Toolkit\DLL& OCX Package folder in the
Appeon Developer installation directory.

The DLL/OCX File Packaging Wizard starts, as shown in the following figure. Click Next to
proceed.
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Figure17.1: DLL/OCX File Packaging Wizard

= DLL/OCK File Packaging Wizard

Thiz wizard will help pou package DLLAOCH files for diztibution,

Click Mest to proceed.

< Back Mest> | [ Cancel

Step 2: Select an application and click Next.

Only application profilesthat are aready configured with DLL/OCX fileswill be listed. For
configuring DLL/OCX files for an application profile, refer to Deploy External Files. When
Next is clicked, the pre-configured DLL/OCX files will be automatically added for you.

Or, skip the selection and click Next to manually add the DLL/OCX files.
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Figure 17.2: Select an application
£ DLL/OCX File Packaging Wizard ==

Specify Application

Select the application of which DLLAOC files need to be packaged.

Maote: the application must be configured to deplay with DLLAOC filez
in Appeon Developer Configuration.

Maote: you can skip thiz step and go to the nest step directy.

[ ¢ Back ][ MHest » ][ Cancel ]

Step 3: Click Add to add the DLL/OCX files, select the Register box to automatically
register the file when installed, and click Next to proceed.

The DLL/OCX fileswill be automatically added if you select the application of which files
are aready configured in the previous step.

Figure 17.3: Add DLL/OCX files
£ DLL/OCX File Packaging Wizard

Specify DLL/OCXK Files

Add DLLAOCK files for packing and select files that need to be
regiztered.

Fegizter  File Mame

R E:HWlndDws'xsystem'xavlca.u:III

ddd. | | Delete |

[ ¢ Back ][ MHest » ][ Cancel
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Step 4: Specify the location where the package will be created. A folder named Package will
be created under this location.

Figure 17.4: Specify the package location

3 DLL/OCX File Packaging Wizard [E3m]

Specify Package Location

Specify the directary where the DLLAOCE package will rezide.

Specify Package Location

C:“Program Files\Appeon'.appeontesy H Browse... ]

[ ¢ Back “ MHest » ][ Cancel ]

Step 5: Review the settings and click Next to generate the package.

Figure 17.5: Review settings

3 DLL/OCX File Packaging Wizard [E3m]

Review Settings

Click Mest to beqin packaaging files. [F you want b review ar change any
zettings, click Back.

Current Settings:

Applcation Mame:

pet_warld
Package Location:

C:%Program Files\tppeon'.appeontesth,
DLLADOCH Information:

Regizter DLLADC files
Mo C:Wwfindowsapstemtavifile. dil
Mo C:Awindowsheypstemtavicap. dll

< Back ]EMH.EHt> i[ Cancel
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Step 6: Wait until the file packaging process is complete.
Step 7: When packaging is complete, click Finish to close the wizard.

To view the log information generated during the process, select the View L og box and then
click Finish. Thelog file will be automatically opened. Y ou can a'so manually open the
DLLOCX.log file in the generated package.

Figure 17.6: Packaging complete

< DLL/OCX File Packaging Wizard ==

Review Settings

Click Mest to begin packaging files. IF you want to review or change any
zettings, click Back.

Current Settings:

Application Mame:

pet_warld
Package Location:

C:%Program Files\dppeontappeontesth,
DLLADOCE Information:

Fegizter DLLADC files
Mo C:wwfindowsapstembavifile. dll
Mo C:Wwfindows\apsterntavicap. di
[ < Back ] { [ Cancel

17.1.2 Installing and uninstalling DLL/OCX files

Y ou will use the same setup program (Setup.exe file) in the generated package for installing
and uninstalling DLL/OCX files:

 If the DLL/OCX files are not installed on the client, when you run the setup program, you
will be guided to install the files. Refer to Section 17.1.2.1, “Installing DLL/OCX files” for
detailed instructions.

» |f the DLL/OCX files are already installed on the client, when you run the setup program,
you will be guided to reinstall or uninstall the files. If you select to reinstall the files, you
will run through the same process as a new installation, as described in Section 17.1.2.1,
“Installing DLL/OCX files’. If you select to uninstall the files, refer to Section 17.1.2.2,
“Uninstalling DLL/OCX files’ for detailed instruction.

17.1.2.1 Installing DLL/OCX files
Step 1: On aclient machine, run the Setup.exe file in the generated package.

The DLL/OCX File Installation Wizard starts, as shown in the following figure. Click Next
to proceed.
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Figure17.7: DLL/OCX Filelnstallation Wizard

£ DLL/OCX File Installation Wizard

Thiz wizard will help pou zetup DLLAOCH files for diztibution,

Click Mest to proceed.

< Back

Cancel |

Step 2: Specify the location where the DLL/OCX fileswill be installed. Click Next to start
the installation process.

The default installation location is %SystemRoot%\system32\A ppeonPlugin (%SystemRoot
% indicates the folder where Windows isinstalled, typically C:\Windows); if you specify a
custom location in AEM (see Appeon Server Configuration Guide for details), then specify
the same location here.
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Figure 17.8: Specify the installation location

£ DLL/OCX File Installation Wizard

Specify Installation Location

Specify the directony where the DLLADCx fles will be installed.

Specify [netallation Location

C:Awindowshaesternd2\appeonPlugint, Browse. .. |

< Back

Cancel |

Step 3: Wait until the installation is compl ete.

During the installation process, the DLL/OCX fileswill first be copied to the specified
location and then registered if they have been selected for auto-registration during the
packaging process.

Step 4: When the installation is complete, select the L et wizard restart the system now
option and click Finish to close the installation wizard and restart your machine.

To view the log information generated during the process, select the View L og box and
click Finish. The log file will be automatically opened. Y ou can also manually open the
DLLOCX.log filein the generated package.
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Figure 17.9: Installation complete

= DLL/OCK File Installation Wizard

Fimizhed DLL/OCK File Installation Whzard

Setup has finizhed inztalling DLLA0Cx package on pour computer.

Click Finizh bo exit,

¥ Let wizard restart the system now

Recommended: Restart the spstem to enzure that the DLLAOC files wall
wiark, correcty.

Select whether o let wizard restart the system now or restart the system
later by yourself.

< Back I Finizh I Cancel

17.1.2.2 Uninstalling DLL/OCX files

Step 1: On aclient machine, run the Setup.exe file in the generated package.
The DLL/OCX File Installation Wizard starts, as shown in the following figure. Click Next

to proceed.
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Figure 17.10: DLL/OCX FilelInstallation Wizard
= DLL/OCK File Installation Wizard ==

Thiz wizard will help pou setup DLLAOCH files for distribution.

Click Mest to procesd.

< Back

Step 2: Select Uninstall and click Next to proceed.

If you select to reinstall the files, you will run through the same process as a new installation,
as described in Section 17.1.2.1, “Installing DLL/OCX files’.

Figure 17.11: Reinstall or uninstall
= DLLAOCK File Installation Wizard [5]

Maintenance Mode

Fleaze select one of the following ophions:

£ Uninstal

¢ Back I MHest » I Cancel

Step 3: Click Yesto confirm the uninstall.
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Figure 17.12: Uninstall confirmation

Question £3

{9} Aire you sure you want to uninstall DLLAOCK Package?

........................................

Step 4: Wait until the uninstall is compl ete.
Step 5: When uninstall is complete, click OK to exit.
Figure 17.13: Uninstall complete
DLLAOCH File Uninstall 5]

[0} DLLADCH File weas successfully rermoved from wour cormputer,

17.2 Appeon Silent Installer (Windows EAServer only)

Notes: 1) Thistool is effective for the Web application only. 2) Thistool does not work
in .NET, JBoss, JEUS, WebL ogic and WebSphere versions.

To help ISVs create an easy-to-use Appeon installation package for the end users, Appeon
specially provides asilent installer which can be customized to install EAServer, Appeon
Server, Appeon Server EBF (Emergency Bug Fix), and Appeon applications in the silent
mode.

This guide provides some useful instructions for I1SVson:
* Creating folder structure of Silent Installer

» Copying installation program of EAServer, Appeon Server, Appeon Server EBF or Web
applications

» Customizing configuration file
* Burning installation CDs
Additional instructions are also provided for end userson:

* Running Appeon Silent Installer (for End Users)

17.2.1 Creating folder structure of Silent Installer

The installation program files of EAServer, Appeon Server, Appeon Server EBF, and Web
application must be placed in the required folder structure, so that Appeon Silent Installer can
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run them. For your convenience, Appeon provides a compressed folder structure which can
be decompressed under any directory. To decompress and create the folder structure and the
required files, take the following steps:

Step 1: Run Silentinstall.exe in the "\Toolkit\Silent Install" under the Appeon Devel oper
installation directory, for example, C:\Program Files\A ppeon\Devel oper2013\T ool kit\Silent

Install.

Step 2: Select where to create the folder structure. Click OK.

Figure 17.14: Specify thelocation

=¥ Silent Install

Create khe Folder struckure For silent install under the Fallawing directary, Ta
change the directary, click Browse,

CProgram Files! AppeoniSilent Install

Browse, .,

Cancel |

=S

After the creation, afolder named "Setup” is created with the following sub-folders and files:

Figure 17.15: Folder structure
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The following is a brief introduction to each folder in the Appeon Silent Installer:

Setup: The root directory of the Silent Installer. It contains the "Appeon” folder, the
Setup.exe, Uninstall.exe, Silentinstall.txt, and msvcp60.dil files.
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» Appeon: It containsthe"AS', "AS EBF", "EAServer", and "WebApp" directory.
* AS: It storesthe installation program of Appeon Server.
* ASEBF: It stores the installation program of Appeon Server EBF.
* EAServer: It stores the installation program of EAServer.

» WebApp: It stores the Web application files packaged by the Appeon application
packaging tool.

» Setup.exe: The setup program for launching the silent installation.
» SilentInstall.txt: The configuration file which can be modified to customize the installation.

» Uninstall.exe: The uninstall program for silently removing what has been installed with
Appeon Silent Installer.

» msvcp60.dil: The DLL file for Appeon Silent Installer.

17.2.2 Copying installation program of EAServer, Appeon Server, Appeon
Server EBF or Appeon applications

After the required folders and files are generated, you can start copying the installation
program files of Appeon Server, EAServer and Appeon applications to the corresponding
folder.

To copy the EAServer installation program to Appeon Silent Installer:

Copy dl files and folders from the directory where setup.exe file resides to the "EA Server"
folder of Appeon Silent Installer.

To copy the Appeon Server installation program to Appeon Silent Installer:

Copy al filesfrom the "ASP" folder on the Appeon installation CD to the"AS' folder of
Appeon Silent Installer.

To copy the Appeon Server EBF installation program to Appeon Silent Installer:

Copy dl files from the "asebf" folder on the Appeon installation CD to the "AS EBF" folder
of Appeon Silent Installer.

To copy Web application packages to Appeon Silent Installer:

Step 1: Verify that the Web application packages have already been generated using the
Appeon application packaging tool. If no package is generated, follow stepsin Section 11.1
“Packaging a deployment project” in the Packaging a deployment project chapter.

Step 2: Copy the generated packages to the "WebApp" folder of Appeon Silent Installer.

17.2.3 Customizing configuration file

With Appeon Silent Installer, you can customize the installation program using the
configuration file (SilentInstall.txt). The following is a detailed description of each parameter
in the SilentInstall.txt file. Each parameter contains no default value.
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17.2.3.1 Installation Types
Specify whether to install EAServer, Appeon Server and Appeon applications.

Table 17.2: Parameter for installing EAServer
Parameter EAServer

Description Specifies whether to install EAServer.

If you do not want to install EAServer using this setup program, make
sure that a supported EA Server was installed already.

Accepted Values | Yes-- Install EAServer.

No -- Not to install EAServer, instead use an existing EAServer.
Default Value | None

Example EAServer ="yes'

Table 17.3: Parameter for installing Appeon Server

Parameter AppeonServer
Description Specifies whether to install Appeon Server.
Accepted Values | Yes
No
Default Value None
Example Appeon Server="yes'

Table 17.4: Parameter for installing Appeon Server EBF

Parameter AppeonServerEBF
Description Specifies whether to apply Appeon Server EBF.
Accepted Values | Yes
No
Default Value None
Example Appeon Server EBF="yes"
Table 17.5: Parameter for installing Web Application
Parameter WebApplication
Description Specifies whether to install Web applications.
Accepted Values | Yes
No
Default Value | None
Example WebApplication="yes"

17.2.3.2 EAServer and ASA Path

Specify the path of EAServer and ASA. ASA isrequired because Appeon Server has an ASA
database for storing the sensitive system data.
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Table 17.6: Parameter for EAServer path
Parameter EAServerPath

Description If the EAServer parameter is set to "No", this specifies the path of an
existing EAServer. The specified path will be validated.

If the EAServer parameter isset to "Yes', thisindicates where EA Server
will beinstalled.

Accepted Values | A valid path
Default Value None
Example EA ServerPath="C:\Program Files\Sybase\EA Server"

Table 17.7: Parameter for ASA path

Parameter ASAPath

Description Specifies the ASA installation path. The specified path will be validated.
Accepted Values | A valid path

Default Value None

Example ASAPath="C:\Program Files\Sybase\Shared\A SA802"

17.2.3.3 EAServer Host Name, Port, Username and Password

Specify the EAServer host name, port number, user name and password.

Table 17.8: Parameter for EAServer name

Parameter EAServerName

Description Specifies the IP address of EA Server.
Accepted Values | A valid I P address

Default Value None

Example EAServerName="local host"

Table 17.9: Parameter for EAServer port

Parameter EAServerPort

Description Specifies the port number of EAServer.
Accepted Values | A valid port

Default Value | None

Example EA ServerPort="9000"

Table 17.10: Parameter for EAServer username

Parameter EAServerUserName

Description Specifies the user name to connect to EAServer.

Accepted Values | A valid user name on EA Server.
Default Value None
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Example

EAServerUserName="jagadmin"

Table 17.11: Parameter for EAServer password

Parameter EAServerPassWord

Description Specifies the password to connect to EAServer.
Accepted Values | A valid password for the current user name.
Default Value None

Example EA ServerPassWord=""

17.2.3.4 Appeon Server Port, Username and Password

Specify the Appeon Server port number, user name and password.

Table 17.12: Parameter for Appeon Server port

Parameter AppeonServerPort

Description Specifiesthe HTTP port number of Appeon Server.

Accepted Values | A valid port
If both EAServer and AppeonServer parameters are set to "Yes', port
"9988" isthe only available port that can be used.

Default Value | None

Example AppeonServerPort="9988"

Table 17.13: Parameter for Appeon Server username

Parameter AppeonServerUserName

Description Specifies the user name for deploying an application to Appeon Server.
This deployment user name can be created using the Security tool in
AEM.

Accepted Values | A valid deployment user name on Appeon Server.

Default Value None

Example AppeonServerUserName=""

Table 17.14; Parameter for Appeon Server password

Parameter AppeonServerPassWord

Description Specifies the password for deploying an application to Appeon Server.
Accepted Values | A valid deployment password for the current user name.

Default Value None

Example AppeonServerPassWord=""

17.2.3.5 Web Server Path
Specify the Web root of the Web server.
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Table 17.15: Parameter for Web server Web root

Parameter WebServerRootPath

Description Specifies the document root of the Web server.
If the WebApplication parameter is set to "No", this parameter will not
take effect.
If the WebApplication parameter is set to "Yes', the specified document
root will be validated.

Accepted Values | A valid path

Default Value | None

Example WebServerRootPath="C:\Program Files\Sybase\EA Server\html"

17.2.3.6 Setup Log Path
Specify the log file path.

Table 17.16: Parameter for log file path

Parameter LogPath

Description Specifies the path for the setup log file (APBLog.txt).
Accepted Values | A valid path

Default Value | None

Example LogPath="c:\log"

17.2.3.7 Web Applications
Specify the number of Web applications, application name, data source, transaction object

and database type.

Table 17.17: Parameter for number of the Web applications

Parameter WebA pplications

Description Specifies the number of Web applications that you want to install.
Accepted Vaues | Any number greater than zero

Default Value | None

Example WebA pplications="2"

If more than one application will be installed, create the following parameters through
incrementing by "1", for example, "WebApplication2", "EA ServerNV 02", "ConnectCache2"
and "AEMZ2" for the second application, "WebApplication3", "EAServerNV 03",
"ConnectCache3" and "TAEM3" for the third application etc.

Table 17.18: Parameter for the Web application 1

Parameter

WebApplicationl

Description

Specifies the actual name of the first Web application.
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Accepted Vaues | An aphanumeric string
Default Value None
Example Examplesfor the first application:

WebApplicationl = "appeon_sales application_demo"
Examples for the second application:

WebApplication2 = "appeon_code_examples'

Table 17.19: Parameter for EAServer NVO 1

Parameter EAServerNVO1
Description Specifies whether to install NV O components.
Accepted Values | Yes
No
Default Value | None
Example EAServerNVO1="Y es'

To make data sources work on the target Appeon Server, be sure to install the required
database drivers to the target Appeon Server. For more information on database drivers, refer
to Database Connection Setup in the Appeon Server Configuration Guide.

Table 17.20: Parameter for data source 1

Parameter ConnectCachel

Description Specifies whether to install data sources.
Accepted Values | 0 -- Not to install data sources.

1 -- Install and overwrite existing data sources.

2 -- Install but not to overwrite existing data sources.
Default Value None
Example ConnectCachel="1"

Table 17.21: Parameter for AEM 1

Parameter AEM1
Description Specifies whether to install AEM settings.
Accepted Values | Yes
No
Default Value None
Example AEM1="Yes"

17.2.3.8 Web Application Uninstall Program Path

Specify the directory for the Web application uninstall program. A shortcut for the uninstall
program will be created in Windows Start menu.
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Table 17.22: Parameter for the uninstall program path

Parameter UninstallWebA ppPath

Description Specifies where the uninstall program for Web applications will reside.
Accepted Values | A valid path.

Default Value | None

Example UninstallWebA ppPath="C:\uninstallwebapp"

17.2.3.9 Resource Language

Specify the language of the messages displayed during the installation or uninstallation
process.

Table 17.23: Parameter for the resource language

Parameter Language
Description Specifies the language of Ul messages.
Accepted Vaues |EN -- English
JP -- Japanese
Default Value EN
Example Language="EN"

17.2.3.10 SilentInstall.txt example

The following example shows a sample Silentinstall.txt file.

HHBHAHH B H R B H BT R A H S R R A R R R A R R R R R
# Configure installation type: Yes or No

HHBHAHH B H A R H AR S R R A R R R R A R R R R R
EAServer ="Yes"

Appeon Server ="Yes"

Appeon Server EBF="Yes"

WebAppl i cati on="Yes"

HHBHAHH B A R H AR R S R R R R R R R A R R R AR H R
# Enter the path of the EAServer installed or you want to install.
HHBHAHH B H A R H BT R T R R R R R R A R R R R R
EASer ver Pat h="C: \ Progr am Fi | es\ Sybase\ EASer ver"

HHBHAHH B H R R H B R A H S R R R R R R A R R R R H
# Enter the ASA path

BHARHHHBHH AR H AR H R R R R AR R AR AR AR R R R R AR
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ASAPat h=""C: \ Progr am Fi | es\ Sybase\ Shar ed\ ASA802"

HHHBHBHARHBH I HH B R R R R R R R R R R AR R
# Enter the Port, Usernane, and Password of EAServer

HHHBHBHARHBH I HH BB R R A R R R R R R AR R
EASer ver Nanme="1 ocal host "

EASer ver Port =" 9000"

EASer ver User Nane="j agadmi n"

EASer ver PassWor d=""

HHHBHBHARHBH I HH BB R R R R R R R R R R R AR R
# Enter the Port, Usernane, and Password of Appeon Server
HHHBHBHARHBH I HH BB R R R R R R R R AR R
AppeonSer ver Port ="9988"

AppeonSer ver User Nane=
AppeonSer ver PassWor d=""

HHHBHBHARHBH I HH B BB R RS R R A R R R AR R
# Enter the Web root of Web server

HHHBHBHARHBH I HH B BB R R R R R R AR R
WebSer ver Root Pat h="C: \ Program Fi | es\ Sybase\ EAServer\ htm "
HHHBHBHARHBH I HH B BB R A R R R R R R AR R
# Enter the path of Setup Log: APBLog.t xt

HHHBHBHARHBH I HH B BB R RS R R A R R R AR R
LogPat h="c:\ | og"

HHHBHBHARHBH I HH B BB R A R R R AR R R AR R
# Enter the Web application nunber

HHHBHBHARHBH I HH B BB R A R R R R R R AR R
WebAppl i cati ons="1"

HHHBHBHARHBH I HH B BB R RS R R A R R R AR R
# Web Application Configuration

# Connect Cache:

# 0: not install

# 1. install, overwite if exist

# 2. install, not overwirte if exist
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# EAServer N\VO Yes or No

# AEM Yes or No

HHHBHBHARHBH I HH B BB R RS R R A R R R AR R
WebAppl i cati onl="Web Application Nanel"

EASer ver NVO1=" YES"

AEML=" YES"

Connect Cachel="1"

HHHBHBHARHBH I HH B BB R RS R R A R R R AR R
# Uninstall Path

HHHBHBHARHBH I HH BB R A RS R AR R R R AR R
Uni nst al | WebAppPat h = " C: \ uni nst al | webapp"

HHHBHBHARHBH I HH B BB R R R R AR R R AR R
# Language

#[ default] = "EN'

# "EN' English

# "JP" Japanse

HHHBHBHARHBH I HH B BB R R R R R R AR R

Language="EN'

17.2.4 Burning installation CDs

After configuration is completed, you can burn installation CDs with the customized silent
installer (the entire "setup” folder) and distribute CDsto your end users.

The Appeon Silent Installer can be provided in one, two or three CDs:

* Inone CD: Installing the Appeon Server ("AS" folder), Appeon Server EBF ("AS EBF"
folder), EAServer ("EAServer" folder) and the Appeon Web application ("WebApp"
folder).

* Intwo CDs: Onefor installing the Appeon Server ("AS' folder), Appeon Server EBF ("AS
EBF" folder), and EAServer ("EAServer" folder), and the other for installing the Appeon
application ("WebApp" folder).

* Inthree CDs. Onefor installing the Appeon Server ("AS" folder) and Appeon Server EBF
("AS EBF" folder), one for installing EAServer ("EAServer” folder), and one for installing
the Appeon application ("WebApp" folder).

Each CD must contain the following four files right under the Setup folder (that is, place the
following files in the same directory level of the"AS", "EAServer" and "WebApp" folders):

» Setup.exe
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e SilentInstall.txt
e Uninstall.exe

* msvcp60.dil

17.2.5 Running Appeon Silent Installer (for End Users)

This section provides some additional instructions for end users on using the Appeon Silent
Installer to install/uninstall EAServer, Appeon Server, Appeon Server EBF and/or Appeon
applications

17.2.5.1 Installing Appeon Server, EAServer and/or Appeon applications
Before running the Appeon Silent Installer, be aware that

1. The Setup.exe program can only be run on the Windows platform.
2. The Appeon Server and the Web server must reside on the same machine.

Start the silent installation by running the Setup.exe file on the installation CD.

By default, the configuration file in the same location of the Setup.exe file will be used
during the installation process. To use a configuration file residing in a different location,
run the Setup.exe file from the command line and append the configuration file location, for
example, Setup.exe d:/setuptmp/Slentinstall.txt.

17.2.5.2 Uninstalling Appeon Server, EAServer and/or Appeon applications

To silently uninstall EAServer, Appeon Server, Appeon Server EBF, and/or Appeon
applications:

Run Uninstall.exe on the installation CD. The uninstall program will automatically load the
Silentinstall.txt file on the same CD and remove what has been installed with Appeon Silent
Installer.

To uninstall Appeon applications from Windows Start menu:

Select Windows Start > Programs > Appeon Application > Undeploy Appeon
Web Application. Or run the uninstall program under the location specified by the
"UninstallWebA ppPath" parameter.

Y ou will go through the same process as those in Section 11.1.4.3, “Uninstalling an
application” in the "Packaging and Installing Appeon Applications® chapter.

17.2.5.3 FAQs
1. What happens if EAServer is started during the process of silent installation?
Appeon Silent Installer will shut down the EAServer and continue the installation.

2. What happensif EAServer or Appeon Server was already installed during the process of
silent installation?

Appeon Silent Installer will overwrite the existing EAServer or Appeon Server.
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3. What happens if the names of NV O packages for a Web application are duplicated?

Appeon Silent Installer will still deploy the first NV O package, but will not deploy the
second NV O package. This activity will be recorded in the log file.

17.3 Appeon Developer Toolbar Register Tool

Appeon Developer can run with PowerBuilder 8, 9, 10, 10.5, 11, 11.5, 12, and 12.5 at the
same time and multiple Appeon Developer versions can run on the same machine. The
Appeon Developer Toolbar register tool enables you to register (or unregister) one Appeon
Developer version to more than one PowerBuilder version or different Appeon Developer
versionsto different PowerBuilder versions, so that you can easily and flexibly select which
Appeon Developer version and PowerBuilder version to use.

Following are steps to use the Appeon Devel oper Toolbar register tool:

Step 1: Select Start > Programs > Appeon Maobile 1.0 for Power Builder > Appeon
Developer > Toolbar Register Tool.

Figure 17.16: Registry tool

b Appeon Developer Toolbar Registry 5]

Select Appeon Developer Wersion

Regizter Appeon Developer toolbar in different
PowerBuilder versions.

PowerBuilder Verzion  Appeon Developer Versic =

PowerBuildera.0

PowveerBuilder1 0.0

FPowerBuilder1 0.5

PowerBuilder11.0

PowerBuilder1 1.5 G.2.0023.00

m

4 il 2

The PowerBuilder versions existing on this computer will be listed.
Step 2: Select the Appeon Developer version to be registered in the PowerBuilder version.

If you want to unregister an Appeon Developer version from a PowerBuilder version, clear
the selection in the Appeon Developer Version column.
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Figure 17.17: Register toolbar to Power Builder

b Appeon Developer Toolbar Registry @

Select Appeon Developer Wersion

Reqister Appeon Developer toalbar in different
PowerBuilder versions.

FowerBuilder Yerzion  Appeon Developer Wersic =

PowerBuilder3.0 | |
PowerBuilder] 0.0 L4

PowerBuider105  [re0023.00
PowerBuilder 1.0
PowveerBuilder 1.5 6.2.0023.00 —

1| 1] 3

4

Step 3: Click OK to register (or unregister) the selected Appeon Developer version with the
PowerBuilder version.
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18 Technical Support

Y ou can get technical support by clicking the Get Support icon in the Appeon Developer
toolbar appearing in the PowerBuilder IDE or launching the Appeon Help from the Windows
start menu.

Get support for Appeon for Power Builder 2013

Please send your email to <suppor t @ppeon. con® for technical support and be
prepared to provide the following files listed in the following table to Appeon Technical
Support. Thiswill aid debugging.

Table 18.1: Filesrequired for technical support

File Type File Name

Appeon Server configuration | For EA Server\WebL ogic\WebSphere\JEUS\JBoss.
file All filesin the %appeonserverd\repository\<instancename>
\config folder.

For .NET IIS:

All filesin the %appeonserver%a\AEM\config folder.

%appeonserver% indicates the Appeon Server installation
path.

Appeon Server log file For EA Server\WebL ogic\WebSphere\JEUS\JBoss.

All filesin the %appeonserverd%\repository\<instancename>
\log folder.

For .NET IIS:
All filesin the %appeonserver%a\AEM\L og folder.

Appeon Server Repository For EAServer:
DB Y%appeonserver%\db\A ppeonServer.db

For NET IIS:

All filesin the Y%appeonserver%\AEM\db folder.

For WebL ogic\WebSphere\JEUS\JBoss:
Y%appeonserver%o\db\appeondb.script

Appeon licensefile For EA Server\WebL ogic\WebSphere\JEUS\JBoss.
Y%appeonserver%o\license.appeon

For .NET IIS:
%appeonserver%o\AEM\bin\license.appeon

Web Server configuration file| httpd.conf

Web Pagefile Web server path\application name\window name.html

Web server path\application name\window name.js

Web server path\application name\all DataWindows on
window.xml
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File Type File Name
Note: If the window named includes inheritance, then also
supply all ancestor HTML and JavaScript files.

PowerBuilder exported PowerBuilder application path\exported window name.srw
source codefile

PowerBuilder application path\exported DataWindow
names.srd

Note: Exported windows should include exported ancestor
windows and exported ancestor user objects.
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install and uninstall an Appeon application, search for UFA report items, 71
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install and uninstall DLL/OCX files, 194 select an application file generation mode, 21
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install Appeon Server, EAServer and Appeon  select External files, 18
applications, 210 select image files, 17
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package DLL/OCX files, 190 URL for appeon applications, 107
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run application in debug mode, 94 view report and log, 121
runtime settings, 39 views in Appeon Debugger, 92

S

SaveAs, 116

Appeon Developer User Guide Page 216



Index Appeon for PowerBuilder 2013

w
Web application uninstall program patch,
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